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About this manual

Welcome!
This is the manual for Steinberg’s Nuendo Expansion Kit. 
The Nuendo Expansion Kit adds a number of music com-
position functions from Steinberg’s Cubase (the “Cubase 
Music Tools”) to your Nuendo application.

These features and functions, or more precisely the in-
cluded VST Instruments, the Drum Editor (and drum map 
support) as well as the Score Editor are described in detail 
in the following chapters.

About the program versions
The documentation covers two different operating sys-
tems or “platforms”; Windows and Mac OS X. 

Some features and settings are specific to one of the plat-
forms, Windows or Mac OS X. This is clearly stated in the 
applicable cases. In other words:

If nothing else is said, all descriptions and procedures 
in the documentation are valid for both Windows and Mac 
OS X.

Key command conventions
Many of the default key commands in Nuendo use modi-
fier keys, some of which are different depending on the 
operating system. For example, the default key command 
for Undo is [Ctrl]-[Z] under Windows and [Command]-[Z] 
under Mac OS X.

When key commands with modifier keys are described in 
this manual, they are shown with the Windows modifier 
key first, in the following way:

[Win modifier key]/[Mac modifier key]-[key]

For example, [Ctrl]/[Command]-[Z] means “press [Ctrl] 
under Windows or [Command] under Mac OS X, then 
press [Z]”. 

Similarly, [Alt]/[Option]-[X] means “press [Alt] under Win-
dows or [Option] under Mac OS X, then press [X]”.

Please note that this manual often refers to right-click-
ing, e.g. to open context menus, etc. If you are using a Mac 
with a single-button mouse, hold down [Ctrl] and click.
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System requirements and installation

About this chapter
This chapter describes the requirements and installation 
procedures for the Windows version and the Mac version.

Minimum requirements
Your computer must meet the following requirements:

Windows
• Windows XP (Home/Professional with SP 2),

or Windows Vista (32-bit and 64-bit)
• Intel Pentium or AMD Athlon 2 GHz processor
• 1 GB RAM
• Windows DirectX compatible audio hardware; 

ASIO compatible audio hardware recommended for low 
latency performance.

• Display resolution of 1024x768 pixels
• Steinberg Key and USB component connector
• DVD ROM drive required for installation
• Internet connection required for license activation

Macintosh
• Mac OS X 10.4
• Power Mac G4 1 GHz or Core Solo 1.5 GHz
• 1 GB RAM
• CoreAudio compatible audio hardware
• Display resolution of 1024x768 pixels
• Steinberg Key and USB component connector
• DVD ROM drive required for installation
• Internet connection required for license activation

Installing the Nuendo Expansion Kit
The installation procedure puts all files in the right places, 
automatically.

Windows
1. Insert the Nuendo Expansion Kit DVD into the DVD 
drive of you computer.

2. Double-click the file called “Setup.exe”.

3. Follow the instructions on screen.
The installation process also includes the activation of the program li-
cense on your Steinberg Key. This is the same procedure as for Nuendo.

Macintosh
1. Insert the Nuendo Expansion Kit DVD into the DVD 
drive of you computer.

2. Double-click the file “Nuendo Expansion Kit 4.mpkg”.

3. Follow the instructions on screen.
The installation process also includes the activation of the program li-
cense on your Steinberg Key. This is the same procedure as for Nuendo.

Register your software
We encourage you to register your software! By doing so 
you are entitled to technical support and kept aware of up-
dates and other news about your product. 

There are two ways to register:

• In Nuendo, open the Help menu and select the Regis-
tration option.
This option is an Internet link that will open the Registration page of the 
Steinberg web site. To register, simply follow the instructions on screen. 
When you launch Nuendo, you will also be prompted to launch the reg-
istration process.

• Included on the installation DVD, you can find a registra-
tion form in pdf format. To register, print out the form, enter 
all required information and send it to Steinberg.
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The included VST Instruments

Introduction
This chapter contains descriptions of the included VST in-
struments and their parameters.

Most of the included instruments are compatible with 
VST3, this is indicated by an icon in front of the name (for 
further information, see the section “About VST 3” in the 
chapter “Audio Effects” in the Operation Manual).

Prologue

Prologue is modelled on subtractive synthesis, the method 
used in classic analog synthesizers. It has the following ba-
sic features:

• Multimode filter
Variable slope lowpass and hipass, plus bandpass and notch filter 
modes – see “About the filter types” on page 16.

• Three oscillators, each with 4 standard waveforms plus 
an assortment of specialized waveforms. 
See “Selecting Waveforms” on page 12.

• Frequency modulation.
See “About frequency modulation” on page 15.

• Ring Modulation.
See “Ring modulation” on page 15.

• Built-in effects.
See “Effects (EFX) page” on page 21.

• Prologue receives MIDI in Omni mode (on all MIDI 
channels).
You don’t need to select a MIDI channel to direct MIDI to the Prologue.

The signal flow of the Prologue synth is illustrated in 
the section “Diagrams” on page 43.

Sound parameters

Oscillator section

This section contains parameters affecting the 3 oscillators. 
These are located in upper half of the instrument panel. 

Selecting Waveforms

Each oscillator has a number of waveforms which are se-
lectable by clicking on the waveform name in the box lo-
cated in each oscillator section.

Selecting waveforms.

The following waveforms are available:

Waveform Description

Sawtooth This waveform contains all harmonics and produces a 
bright and rich sound.

Parabolic This could be described as a “rounded” sawtooth wave-
form, producing a softer timbre.

Square Square waveforms only contain odd number harmonics, 
which produces a distinct, hollow sound.
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• To hear the signal generated by the oscillator(s), the 
corresponding Osc dial in the oscillator sections must be 
turned clockwise to a suitable value.

OSC 1 parameters

Oscillator 1 acts as a master oscillator. It determines the 
base pitch for all three oscillators. Oscillator 1 features the 
following parameters:

Triangle The Triangle waveform generates only a few harmonics, 
spaced at odd harmonic numbers, which produces a 
slightly hollow sound.

Sine The sine wave is the simplest possible waveform, with no 
harmonics (overtones). The sine wave produces a neu-
tral, soft timbre.

Formant 1–12 Formant waveforms emphasizes certain frequency 
bands. Like the human voice, musical instruments have a 
fixed set of formants, which give it a unique, recognizable 
tonal color or timbre, regardless of pitch.

Vocal 1–7 These are also formant waveforms, but specifically vocal-
oriented. Vowel sounds (A/E/I/O/U) are among the 
waveforms found in this category.

Partial 1–7 Partials, also called harmonics or overtones, are a series 
of tones which accompany the prime tone (fundamental). 
These waveforms could be described as producing inter-
vals with two or more frequencies heard simultaneously 
with equal strength.

Reso Pulse 
1–12

This waveform category begins with a complex waveform 
(Reso Pulse 1), that emphasizes the fundamental fre-
quency (prime). For each consecutive waveform in this 
category, the next harmonic in the harmonic series is em-
phasized.

Slope 1–12 This waveform category begins with a complex waveform 
(Slope 1), with gradually decreasing harmonic complexity 
the higher the number selected. Slope 12 produces a 
sine wave (no harmonics).

Neg Slope 1–9 This category also begins with a complex waveform 
(NegSlope 1), but with gradually decreasing low fre-
quency content the higher the number selected.

Waveform Description

Parameter Value Description

Osc 1 0–100 This controls the output level of the oscil-
lator. 

Coarse +/- 48 
semitones

This determines the base pitch used by 
all oscillators.

Fine +/- 50 cent Fine tunes the oscillator pitch in cent in-
crements (100th of a semitone). This also 
affects all oscillators.

Wave Mod +/- 50 This parameter dial is only active if the 
Wave Mod button is activated beside the 
waveform selection box. Wave modula-
tion works by adding a phase-shifted 
copy of the oscillator output to itself, 
which produces waveform variations. For 
example if a sawtooth waveform is used, 
activating WM will produce a pulse wave-
form. By modulating the WM parameter 
with for example a LFO, classic PWM 
(pulse width modulation) is produced. 
Wave modulation can, however, be ap-
plied to any waveform.

Phase button On/Off When Phase synchronization is activated, 
all oscillators will restart their waveform 
cycles with every note played. With 
Phase deactivated, the oscillators gener-
ate a waveform cycle continuously, which 
produces slight variations when playing 
as each note will start from a random 
phase in the cycle, adding warmth to the 
sound. But when synthesizing bass 
sounds or drum sounds, it is usually de-
sired that the attack of every note played 
sounds the same, so for these purposes 
you should activate Phase sync. Phase 
sync also affects the noise generator.

Tracking 
button

On/Off When Tracking is activated, the oscillator 
pitch will track the notes played on the 
keyboard. If Tracking is deactivated the 
oscillator pitch remains constant, regard-
less of what note is played.

Wave Mod 
button

On/Off This switches wave modulation on or off.

Waveform 
pop-up

See “Selecting 
Waveforms” on 
page 12.

Sets the basic waveform for the oscillator.
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OSC 2 parameters

Oscillator 2 has the following parameters:

OSC 3 parameters

Oscillator 3 has the following parameters:

Parameter Value Description

Osc 2 0–100 This controls the output level of the oscil-
lator. 

Coarse +/- 48 
semitones

This determines the coarse pitch for Osc 
2. If FM is enabled, this determines fre-
quency ratio of the oscillator regarding 
Osc 1.

Fine +/- 50 cent Fine tunes the oscillator pitch in cent in-
crements (100th of a semitone). If FM is 
enabled, this determines the frequency 
ratio of the oscillator regarding Osc 1.

Wave Mod +/- 50 This parameter dial is only active if the 
Wave Mod button is activated beside the 
waveform selection box. Wave modula-
tion works by adding a phase-shifted 
copy of the oscillator output to itself, 
which produces waveform variations. For 
example if a sawtooth waveform is used, 
activating WM will produce a pulse wave-
form. By modulating the WM parameter 
with for example a LFO, classic PWM 
(pulse width modulation) is produced. 
Wave modulation can, however, be ap-
plied to any waveform.

Ratio 1–16 This parameter dial (which is only active if 
the Freq Mod button is activated) adjusts 
the amount of frequency modulation ap-
plied to oscillator 2. See “About fre-
quency modulation” on page 15. Is 
normally referred to as FM index.

Sync button On/Off When Sync is activated, Osc 2 is slaved 
to Osc 1. This means that every time Osc 
1 completes it's cycle Osc 2 is forced to 
reset (start it's cycle from the beginning). 
This produces a characteristic sound, 
suitable for lead playing. Osc 1 deter-
mines the pitch, and varying the pitch of 
Osc 2 produces changes in timbre. For 
classic sync sounds, try modulating the 
pitch of Osc 2 with an envelope or a LFO. 
The Osc 2 pitch should also be set higher 
than the pitch of Osc 1.

Tracking 
button

On/Off When Tracking is activated, the oscillator 
pitch will track the notes played on the 
keyboard. If Tracking is deactivated the 
oscillator pitch remains constant, regard-
less of what note is played.

Freq Mod 
button

On/Off This switches frequency modulation on or 
off.

Wave Mod 
button

On/Off This switches wave modulation on or off.

Waveform 
selector pop-up

See “Selecting 
Waveforms” on 
page 12.

Sets the basic waveform for the oscillator.

Parameter Value Description

Osc 3 0–100 This controls the output level of the oscil-
lator. 

Coarse +/- 48 
semitones

This determines the coarse pitch for Osc 
3. If FM is enabled, this determines the 
frequency ratio of the oscillator regarding 
Osc 1/2.

Fine +/- 50 cent Fine tunes the oscillator pitch in cent in-
crements (100th of a semitone). If FM is 
enabled, this determines the frequency 
ratio of the oscillator regarding Osc 1/2.

Ratio 1–16 This parameter dial (which is only active if 
the Freq Mod button is activated) adjusts 
the amount of frequency modulation ap-
plied to oscillator 3. See “About fre-
quency modulation” on page 15. Is 
normally referred to as FM index.

Sync button On/Off When Sync is activated, Osc 3 is slaved 
to Osc 1. This means that every time Osc 
1 completes it's cycle, Osc 3 is forced to 
reset (start it's cycle from the beginning). 
This produces a characteristic sound, 
suitable for lead playing. Osc 1 deter-
mines the pitch, and varying the pitch of 
Osc 3 produces changes in timbre. For 
classic sync sounds, try modulating the 
pitch of Osc 3 with an envelope or a LFO. 
The Osc 3 pitch should also be set higher 
than the pitch of Osc 1.

Tracking 
button

On/Off When Tracking is activated, the oscillator 
pitch will track the notes played on the 
keyboard. If Tracking is deactivated the 
oscillator pitch remains constant, regard-
less of what note is played.

Freq Mod 
button

On/Off This switches frequency modulation on or 
off.

Wave Mod 
button

On/Off This switches wave modulation on or off.

Waveform 
selector pop-up

See “Selecting 
Waveforms” on 
page 12.

Sets the basic waveform for the oscillator.
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About frequency modulation

Frequency modulation or FM means that the frequency of 
one oscillator (called the carrier) is modulated by the fre-
quency of another oscillator (called the modulator).

• In Prologue, Osc 1 is the modulator, and Osc 2 and 3 
are carriers.
Osc 2 could be said to be both carrier and modulator as if Freq Mod is 
applied to Osc 2 it is modulated by Osc 3. If Osc 2 also uses frequency 
modulation, Osc 3 will be modulated by both Osc 1 and Osc 2.

• The “pure” sound of frequency modulation is output 
through the modulator oscillator(s).
This means that you should turn off the Osc 1 output when using fre-
quency modulation.

• The Freq Mod button switches frequency modulation on 
or off.

• The Ratio parameter determines the amount of frequency 
modulation.

Portamento

This parameter makes the pitch glide between the notes 
you play. The parameter setting determines the time it 
takes for the pitch to glide from one note to the next. Turn 
the knob clockwise for longer glide time.

The “Mode” switch allows you to apply glide only when 
you play a legato note (when switch is set to Legato). Le-
gato is when you play a note without releasing the previ-
ously played note. Note that Legato mode only works with 
monophonic Parts.

Ring modulation

Ring modulators multiply two audio signals. The ring-mod-
ulated output contains added frequencies generated by 
the sum of, and the difference between, the frequencies of 
the two signals. In Prologue, Osc 1 is multiplied with Osc 
2 to produce sum and difference frequencies. Ring modu-
lation is often used to create bell-like sounds.

• To hear the ring modulation, you should turn down the 
output level for Osc 1 and 2, and turn up the “R.Mod” level 
all the way.

• If Osc 1 and 2 are tuned to the same frequency, and no 
modulation is applied to the Osc 2 pitch, nothing much 
will happen.
If you change the pitch of Osc 2, however, drastic changes in timbre can 
be heard. If the oscillators are tuned to a harmonic interval such as a fifth 
or octave, the ring modulated output will sound harmonic, other intervals 
will produce inharmonious, complex timbres.

• Oscillator Sync should be deactivated when using ring 
modulation.

Noise Generator

A noise generator generates noise (all frequencies at 
equal levels). Applications include simulating drum 
sounds and breath sounds for wind instruments.

• To hear only the sound of the noise generator, you 
should turn down the output level for the oscillators, and 
turn up the Noise parameter.

• The Noise generator level is routed to Envelope 1 by 
default. 
See “Envelope page” on page 18 for a description of the Envelope gen-
erators.
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Filter section

The circle in the middle contains the filter parameters. The 
central dial sets the filter cut off parameter and the outer 
ring the filter type:

About the filter types

You select which filter type to use using the buttons 
around the filter cut off knob. The following filter types are 
available (listed clockwise from 9 o’clock):

Master Volume and Pan

The master Volume controls the master volume (ampli-
tude) of the instrument. By default this parameter is con-
trolled by Envelope 1, to generate an amplitude envelope 
for the oscillators.

The Pan dial controls the position in the stereo spectrum 
for the instrument. You can use Pan as a modulation des-
tination.

Parameter Description

Filter type Sets the filter type to either lowpass, highpass, bandpass 
or notch. The filter types are described on “About the fil-
ter types” on page 16.

Cut off This dial controls the filter frequency or “cut off”. If a low-
pass filter is used, it could be said to control the opening 
and closing of the filter, producing the classic “sweep-
ing” synthesizer sound. How this parameter operates is 
governed by the filter type mode (see “About the filter 
types” on page 16).

Emphasis This is the resonance control for the filter. For lowpass 
and highpass filters, raising the Emphasis value will em-
phasize the frequencies around the set cutoff frequency. 
This produces a generally thinner sound, but with a 
sharper, more pronounced cutoff sweep. The higher the 
filter Emphasis value, the more resonant the sound be-
comes until it starts to ring (self-oscillate), generating a 
distinct pitch. For Bandpass or Notch filters, the Empha-
sis setting adjusts the width of the band. When you raise 
the value, the band where frequencies are let through 
(Bandpass), or cut (Notch) will become narrower.

Drive This can be used to adjust the filter input level. Levels 
above 0 dB will gradually introduce a soft distortion of the 
input signal, and a decrease of the filter resonance.

Shift Internally, each filter consists of two or more “subfilters” 
connected in series. This parameter shifts the cutoff fre-
quency of the subfilters. The result depends on the se-
lected filter type: For Lowpass and Highpass filter types it 
changes the filter slope. For Bandpass and Notch filter 
types it changes the bandwidth. The Shift parameter has 
no effect if either the 12dB LP or 12dB HP filter type is 
selected.

Tracking If this parameter is set to values over the 12 o’clock posi-
tion, the filter cutoff frequency will increase the further up 
on the keyboard you play. Negative values invert this rela-
tionship. 
If the Track parameter is set fully clockwise, the cutoff fre-
quency will track the keyboard by a semitone per key.

Type Description

12db LP This lowpass filter has a gentler slope (12 dB/Octave 
above the cutoff frequency), leaving more of the harmon-
ics in the filtered sound.

18dB LP This lowpass filter also has a cascade design, attenuating 
frequencies below the cutoff frequency with a 18dB/Oc-
tave slope, as used in the classic TB 303 synth.

24dB LP Lowpass filters lets low frequencies pass and cuts out 
the high frequencies. This filter type attenuates frequen-
cies above the cutoff frequency with a 24dB/Octave 
slope, which produces a warm and fat sound.

24dB LP II This lowpass filter has a cascade design which attenu-
ates frequencies below the cutoff frequency with a 
24dB/Octave slope, which produces a warm and dark 
sound.

12dB Band A bandpass filter cuts both high and low frequencies 
above and below the cutoff frequency with a 12dB/Oc-
tave slope, producing a nasal and thin sound.

12dB Notch A notch filter cuts off frequencies near the cutoff fre-
quency by 12dB/Octave, letting the frequencies below 
and above through. This produces a phaser-like sound.

12dB HP This highpass filter has a 12dB/Octave slope, giving a 
bright and thin sound.

24dB HP A highpass filter is the opposite of a lowpass filter, cut-
ting out the lower frequencies and letting the high fre-
quencies pass. This filter has a 24dB/Octave slope, 
giving a bright and sharp sound.
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Modulation and controllers
The lower half of the control panel displays the various 
modulation and controller assignment pages available as 
well as the effect page. You switch between these pages 
using the buttons below the Filter section.

The following pages are available:

• The LFO page has two low frequency oscillators (LFOs) 
for modulating parameters – see below.

• The Envelope page contains the four Envelope genera-
tors which can be assigned to control parameters – see 
“The Envelope page.” on page 18.

• The Event page contains the common MIDI controllers 
(Mod wheel, Aftertouch etc. and their assignments – see 
“Event page” on page 20.

• The Effect page has three separate effect types avail-
able; Distortion, Delay and Modulation – see “Effects 
(EFX) page” on page 21.

LFO page
This is opened by clicking the LFO button at the top of the 
lower half of the control panel. The page contains all pa-
rameters and the modulation and velocity destinations for 
two independent LFOs. Depending on the currently se-
lected Preset, there may already be modulation destina-
tions assigned, in which case these are listed in the “Mod 
Dest” box for each LFO – see “Assigning LFO modulation 
destinations” on page 18. A low frequency oscillator 
(LFO) is used for modulating parameters, for example the 
pitch of an oscillator (to produce vibrato), or for any pa-
rameter where cyclic modulation is desired.

The two LFOs have identical parameters:

About the sync modes

The Sync modes determine how the LFO cycle affects the 
notes you play:

About the waveforms

Most standard LFO waveforms are available for LFO modu-
lation. You use Sine and Triangle waveforms for smooth 
modulation cycles, Square and Ramp up/down for different 
types of stepped modulation cycles and Random or Sam-
ple for random modulation. The Sample waveform is differ-
ent. In this mode, one LFO actually samples and holds the 
values of the other LFO at the chosen frequency.

Parameter Description

Speed This governs the rate of the LFO. If MIDI Sync is activated 
(see below), the available rate values are selectable as 
note values, e.g. beat increments of the sequencer tempo 
in Nuendo.

Depth This controls the amount of modulation applied by the 
LFO. If set to zero, no modulation is applied.

Waveform This sets the LFO waveform. 

Sync mode 
(Part/MIDI/
Voice/Key)

This sets the sync mode for the LFO. See below for a de-
scription.

Parameter Description

Part In this mode, the LFO cycle is free running and will affect 
all the voices in sync. “Free running” means that the LFO 
cycles continuously, and doesn’t reset when a note is 
played.

MIDI In this mode the LFO rate is synced in various beat incre-
ments to MIDI clock.

Voice In this mode each voice in the Part has its own indepen-
dent LFO cycle (the LFO is polyphonic). These cycles are 
also free running – each key down starts anywhere in the 
LFO cycle phase.

Key Same as Voice except that it is not free running – for 
each key down the LFO cycle starts over.
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Assigning LFO modulation destinations

To assign a modulation destination for a LFO, proceed as 
follows:

1. Click in the “Mod Dest” box for one of the LFOs.
A pop-up appears with all possible modulation destinations are shown. 
All Sound parameters as well as most LFO and Envelope parameters are 
available as destinations.

The modulation destination pop-up.

2. Select a destination, e.g. Filter Cut Off.
The selected modulation destination is now shown in the list. Beside the 
destination, a default value (50) has been set. The value represents the 
modulation amount. 

• You can set positive and negative modulation values by 
clicking on the value in the list, typing in a new value and 
pressing the Enter key.
To enter negative values type a minus sign followed by the value.

3. Select a suitable LFO Waveform, Speed, Depth and 
Sync mode.
You should now hear the filter cut off being modulated by the LFO. 

4. Using the same basic method, you can add any num-
ber of modulation destinations for the LFO.
They will all be listed in the “Mod Dest” box.

• To remove a modulation destination click on its name in 
the list and select “Off” from the pop-up.

Assigning LFO velocity destinations

You can also assign LFO modulation that is velocity con-
trolled (i.e. governed by how hard or soft you strike a key). 
This is done as follows:

1. Click in the “Vel Dest” box for one of the LFOs.
A pop-up appears with all possible velocity destinations are shown. 

2. Select a destination. 
The selected velocity destination is now shown in the list. Beside the 
destination, a default value (50) has been set. The value represents the 
modulation amount. See below for an example of how velocity modula-
tion works.

• You can set positive and negative values by clicking on 
the value in the list, typing in a new value and pressing the 
Enter key.
To enter negative values type a minus sign followed by the value.

3. Using the same basic method, you can add any num-
ber of velocity destinations for the LFO.
They will all be listed in the “Vel Dest” box.

• To remove a modulation destination click on its name in 
the list and select “Off” from the pop-up.

LFO modulation velocity control – an example:

If you follow the steps above and select the filter cut off 
parameter as a Velocity destination, the following hap-
pens:

• The harder you strike the key, the more the filter cut off 
parameter will be modulated by the LFO.

• If you should enter a negative value for the velocity mod-
ulation amount, the opposite happens; the harder you play 
the less the filter cut off is modulated by the LFO.

Envelope page
The Envelope page is opened by clicking the ENV button at 
the top of the lower half of the control panel. The page con-
tains all parameters and the modulation and velocity desti-
nations for the four independent envelope generators. 

Envelope generators govern how a parameter value will 
change when a key is pressed, when a key is held and fi-
nally when a key is released.

The Envelope page.

On the Envelope page, the parameters for one of the four 
envelope generators is shown at a time.

Click here…

…to open the modulation 
destination pop-up.
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• You switch between the four envelopes in the section to 
the left.
Clicking on either of the four mini curve displays 1 to 4 will select it and 
display the corresponding envelope parameters to the right. The mini 
curve displays also reflect the envelope settings for each corresponding 
envelope.

• Envelope generators have four parameters; Attack, De-
cay, Sustain and Release (ADSR).
See below for a description of these.

• You can set envelope parameters in two ways; either by 
using the sliders or by click-dragging the curve in the En-
velope curve display.
You can also do this in the mini curve displays.

• By default Envelope 1 is assigned to the master volume, 
and therefore acts as an amplitude envelope. The ampli-
tude envelope is used to adjust how the volume of the 
sound should change from the time you press a key until 
the key is released.
If no amplitude envelope were assigned, there would be no output.

The Envelope parameters are as follows:

Attack

The attack phase is the time it takes from zero to the max-
imum value. How long this should take, depends on the 
Attack setting. If the Attack is set to “0”, the maximum 
value is reached instantly. If this value is raised, it will take 
time before the maximum value is reached. Range is from 
0.0 milliseconds to 91.1 seconds.

Decay

After the maximum value has been reached, the value 
starts to drop. How long this should take is governed by 
the Decay time parameter. The Decay time has no effect if 
the Sustain parameter is set to maximum. Range is from 
0.0 milliseconds to 91.1 seconds.

Sustain

The Sustain parameter determines the level the envelope 
should rest at, after the Decay phase. Note that Sustain 
represents a level, whereas the other envelope parame-
ters represent times. Range is from 0 to 100.

Release

Release determines the time it takes for the value to fall 
back to zero after releasing the key. Range is from 0.0 mil-
liseconds to 91.1 seconds.

Punch

When Punch is activated, the start of the decay phase is 
delayed by a few milliseconds (i.e. the envelope remains at 
the top level for a moment before moving on to the decay 
phase). The result is a punchier attack similar to a com-
pressor effect. This effect is more pronounced with short 
attack and decay times.

Retrigger

When Retrigger is activated, the envelope will re-trigger 
each time you play a new note. However, with certain tex-
tures/pad sounds and a limited number of voices it is rec-
ommended to leave the button deactivated, due to click 
noises that might occur, when the envelope is ended up 
abruptly. This is caused by the incoming re-trigger that 
forces the envelope to start over again.

Assigning Envelope modulation destinations

To assign a modulation destination for an Envelope, pro-
ceed as follows:

1. Click in the “Mod Dest” box for one of the Envelopes.
A pop-up appears with all possible modulation destinations are shown. 
All Sound parameters as well as most LFO and Envelope parameters are 
available as destinations.

2. Select a destination, e.g. Filter Cut Off.
The selected modulation destination is now shown in the list. Beside the 
destination, a default value (50) has been set. The value represents the 
modulation amount. 

• You can set positive and negative modulation values by 
clicking on the value in the list, typing in a new value and 
pressing the Enter key.
To enter negative values type a minus sign followed by the value.

3. Select a suitable envelope curve for the modulation.
You should now hear the filter cut off being modulated by the envelope 
as you play. 

4. Using the same basic method, you can add any num-
ber of modulation destinations for the envelope.
They will all be listed in the “Mod Dest” box.

• To remove a modulation destination click on its name in 
the list and select “Off” from the pop-up.
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Assigning Envelope velocity destinations

You can also assign Envelope modulation that is velocity 
controlled (i.e. governed by how hard or soft you strike a 
key). This is done as follows:

1. Click in the “Vel Dest” box for one of the envelopes.
A pop-up appears with all possible velocity destinations are shown. 

2. Select a destination. 
The selected velocity destination is now shown in the list. Beside the 
destination, a default value (50) has been set. The value represents the 
modulation amount. See below for an example of how velocity modula-
tion works.

• You can set positive and negative values by clicking on 
the value in the list, typing in a new value and pressing the 
Enter key.
To enter negative values type a minus sign followed by the value.

3. Using the same basic method, you can add any num-
ber of velocity destinations for the Envelope.
They will all be listed in the “Vel Dest” box.

• To remove a modulation destination click on its name in 
the list and select “Off” from the pop-up.

Envelope modulation velocity control – an example:

If you follow the steps above and select the filter cut off pa-
rameter as a Velocity destination, the following happens:

• The harder you strike the key, the more the filter cut off 
parameter will be modulated by the Envelope.

• If you should enter a negative value for the velocity mod-
ulation amount, the opposite happens; the harder you play 
the less the filter cut off is modulated by the Envelope.

Event page
The Event page is opened by clicking the EVENT button 
at the top of the lower half of the control panel. This page 
contains the most common MIDI controllers and their re-
spective assignments.

The Event page.

The following controllers are available:

To assign any of these controllers to one or several pa-
rameters, proceed as follows:

1. Click in the “Mod Dest” box for one of the controllers.
A pop-up appears with all possible modulation destinations are shown. 
All Sound parameters as well as most LFO and Envelope parameters are 
available as destinations.

2. Select a destination.
The selected modulation destination is now shown in the list. Beside the 
destination, a default value (50) has been set. The value represents the 
modulation amount when the controller is at its full range. 

• You can set positive and negative modulation values by 
clicking on the value in the list, typing in a new value and 
pressing the Enter key.
To enter negative values type a minus sign followed by the value.

3. Using the same basic method, you can add any num-
ber of modulation destinations for the controllers.
They will all be listed in the “Mod Dest” box for the respective controller.

• To remove a modulation destination click on its name in 
the list and select “Off” from the pop-up.

Controller Description

Modulation 
Wheel

The modulation wheel on your keyboard can be used to 
modulate parameters.

Velocity Velocity is used to control parameters according to how 
hard or soft you play notes on your keyboard. A common 
application of velocity is to make sounds brighter and 
louder if you strike the key harder.

Aftertouch Aftertouch, or channel pressure, is MIDI data sent when 
pressure is applied to a keyboard after the key has been 
struck, and while it is being held down or sustained. Af-
tertouch is often routed to control filter cutoff, volume, 
and other parameters to add expression. Most (but not 
all) MIDI keyboards send Aftertouch.

Key Pitch 
Tracking

This can change parameter values linearly according to 
where on the keyboard you play.
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Effects (EFX) page
This page features three separate effect units: Distortion, 
Delay and Modulation (Phaser/Flanger/Chorus). The Ef-
fect page is opened by clicking the EFX button at the top 
of the lower half of the control panel.

The Effects page.

• Each separate effect section is laid out with a row of 
buttons that determine the effect type or characteristic 
and a row of sliders for making parameter settings.

• To activate an effect, click the “Active” button so that a 
dot appears.
Clicking again deactivates the effect.

Distortion

You can select between 4 basic distortion characteristics:

• Distortion provides hard clipping distortion.
• Soft Distortion provides soft clipping distortion.
• Tape Emulation produces distortion similar to magnetic tape 

saturation.
• Tube Emulation produces distortion similar to valve amplifiers.

The parameters are as follows:

Delay

You can select between 3 basic delay characteristics:

• Stereo Delay has two separate delay lines panned left 
and right.

• In Mono Delay the two delay lines are connected in series for 
monophonic dual tap delay effects.

• In Cross delay the delayed sound bounces between the ste-
reo channels.

The parameters are as follows:

Modulation

You can select between 3 basic modulation characteristics:

• The Phaser uses an 8-pole allpass filter to produce the classic 
phasing effect. 

• The Flanger is composed of two independent delay lines with 
feedback for the left and the right channel respectively. The 
delay time of both delays is modulated by one LFO with ad-
justable frequency. 

• Chorus produces a rich chorus effect with 4 delays modulated 
by four independent LFOs.

The parameters are as follows:

Parameter Description

Filter This parameter sets the crossover frequency of the dis-
tortion filter. The distortion filter consists of a lowpass fil-
ter and a highpass filter with a cutoff frequency equal to 
the crossover frequency. 

Tone This parameter controls the relative amount of lowpass 
and high-pass filtered signal. 

Drive Sets the amount of distortion by amplifying the input sig-
nal.

Level This controls the output level of the effect.

Parameter Description

Song Sync This switches tempo sync of the delay times on or off.

Delay 1 Sets the delay time ranging from 0ms to 728ms. If MIDI 
sync is activated the range is from 1/32 to 1/1; straight, 
triplet or dotted.

Delay 2 Same as Delay 1.

Feedback This controls the decay of the delays. With higher set-
tings the echoes repeat longer.

Filter A lowpass filter is built into the feedback loop of the de-
lay. This parameter controls the cutoff frequency of this 
feedback filter. Low settings result in successive echoes 
sounding darker. 

Level This controls the output level of the effect. 

Parameter Description

Song Sync This switches tempo sync of the Rate parameter on or 
off.

Rate Sets the rate of the LFOs modulating the delay time. If 
Song Sync is activated the rate will be synced to various 
beat increments.

Depth This parameter controls the depth of the delay time mod-
ulation. 

Delay This parameter sets the delay time of the four delay lines. 



22

The included VST Instruments

SR parameters

With these buttons you can change the sample rate. 
Lower sample rates basically reduces the high frequency 
content and sound quality, but the pitch isn’t altered. This 
is a great way to emulate the “lo-fi” sounds of older digital 
synths!

• If button “F” is active, the selected Part’s program will play 
back with the sample rate set in the host application.

• If button “1/2” is active, the selected Part’s program will play 
back with half the original sample rate.

• If button “1/4” is active, the selected Part’s program will play 
back with a quarter of the original sample rate.

• A bonus effect of using lower sample rates is that it re-
duces the load on the computer CPU, allowing more si-
multaneous voices to be played etc.

Spector

The synthesis in this synthesizer is based around a “spec-
trum filter”, which allows you to specify the frequency re-
sponse by drawing a filter contour in the spectrum display. 
Slightly simplified, the signal path is the following:

• The starting point is the sound generated by up to 6 os-
cillators.
You can choose between different numbers of oscillators in different 
configurations (in octaves, in unison, etc.). The oscillators can also be 
detuned for fat sounds or extreme special effects.

• Each oscillator produces two basic waveforms, labelled 
A and B.
You can choose between six different waveforms, independently se-
lected for A and B.

• The two waveforms pass through separate spectrum fil-
ters (A and B).
You can draw different spectrum contours for the two filters, or select a 
contour from the included presets.

• The Cut 1 & 2 parameters allow you to shift the fre-
quency range of the spectrum filter.
This makes it easy to create unique-sounding filter sweeps.

• Finally, a Morph control lets you mix the output of spec-
trum filters A and B.
Since this can be controlled with envelopes, LFOs etc. you can create 
morphing effects.

• You also have controllers and modulation parameters 
(two LFOs, four envelopes and three effects). See “Modu-
lation and controllers” on page 24.

The signal flow of the Spector synth is illustrated in the 
section “Diagrams” on page 43.

Feedback The feedback parameter controls the amount of positive 
or negative feedback for all four delay lines. The adjust-
able range is from -1 to 1.

Level This controls the output level of the effect. 

Parameter Description
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Sound parameters

Oscillator section

A/B waveform pop-ups

This is where you select basic waveforms for the A and B 
output of the oscillators. The options are especially suited 
for use with the spectrum filter.

Coarse and Fine

These parameters provide overall transposition and tuning 
of the oscillators (common for all oscillators, A and B 
waveforms).

Oscillator pop-up

This pop-up menu is opened by clicking on the text below 
the centrally placed section (which illustrates the currently 
selected oscillator configuration). 

Click here to open the Oscillator pop-up.

The pop-up has the following oscillator configurations to 
chose between:

Detune

Detunes the oscillators (in all oscillator modes except 
“1Osc”). Low values will give gentle chorus-like detuning; 
raising the control will detune the oscillators by several 
semitones for clangorous special effects.

Raster

This parameter reduces the number of harmonics present 
in the oscillator waveforms in the following manner:

Portamento

This parameter makes the pitch glide between the notes 
you play. The parameter setting determines the time it 
takes for the pitch to glide from one note to the next. Turn 
the knob clockwise for longer glide time.

The “Mode” switch allows you to apply glide only when 
you play a legato note (when switch is set to Legato). Le-
gato is when you play a note without releasing the previ-
ously played note. Note that Legato mode only works with 
monophonic Parts.

Option Description

6 Osc 6 oscillators with the same pitch.

6 Osc 1:2 3 oscillators with base pitch and 3 pitched one octave down.

6 Osc 1:2:3 Three groups of two oscillators with the pitch ratio 1:2:3 (2 
oscillators with base pitch, 2 oscillators at half the frequency 
of the base pitch and 2 oscillators at a third of the frequency).

6 Osc 
1:2:3:4:5:6

6 oscillators tuned with the pitch ratio 1:2:3:4:5:6 (known as 
the “subharmonic series”).

4 Osc 1:2 2 oscillators with base pitch and 2 pitched one octave down.

3 Osc 3 oscillators with the same pitch.

2 Osc 2 oscillators with the same pitch.

2 Osc 1:2 One oscillator with base pitch and one pitched one octave 
down.

1 Osc A single oscillator. In this mode, the Detune and Cut II pa-
rameters are not active.

Setting Description

0 All harmonics present.

1 Only every second harmonic present.

2 Only every third harmonic present.

... ...and so on.
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Spectrum filter section

This is where you create the contours (frequency re-
sponse characteristics) for the two 128 pole resonant 
spectrum filters “A” and “B”.

• You can use the Preset pop-up menu to select a preset 
contour if you like.

• To change the contour, click and “draw” with the mouse.
Once you change the selected contour, it will be labeled as “Custom” in 
the Preset field above the display, indicating that you’re no longer using 
one of the presets.

• If you want to random calculate a spectrum filter curve, 
you can choose the Randomize function from the Preset 
pop-up.
Each time you choose this function, a new randomized spectrum will ap-
pear.

Cut I and II

These work much like cutoff frequency controls on a con-
ventional filter: With the Cut controls at the maximum set-
ting, the full frequency range will be used for the spectrum 
filter; lowering the Cut controls will gradually move the en-
tire contour down in frequency, “closing” the filter. Note:

• If a 2 oscillator configuration is used, you can set differ-
ent “cutoffs” for the two oscillators with Cut I and Cut II, 
respectively. Similarly, if more than two oscillators are 
used, they are internally divided in two groups, for which 
you can set independent “cutoffs” with Cut I and II. 
For example, in the “6 Osc” modes Cut I affects the sound of oscillators 
1, 3 and 5 while Cut II affects the sound of oscillators 2, 4 and 6. In the 
“1 Osc” mode, the Cut II control is not used.

• If the Spectrum Sync (link symbol) button between the 
Cut controls is activated, the two knobs are synced and 
will follow each other and be set to the same value.

Morph

This controls the mix between the sound of spectrum fil-
ters A and B. When the Morph knob is turned fully left, 
only the “A” sound will be heard; when it’s turned right 
only the “B” sound will be heard. This allows you to seam-
lessly morph (manually or using an LFO or an envelope) 
between two totally different sounds.

Master Volume and Pan

The master Volume controls the master volume (ampli-
tude) of the instrument. By default this parameter is con-
trolled by Envelope 1, to generate an amplitude envelope 
for the oscillators.

The Pan dial controls the position in the stereo spectrum 
for the instrument. You can use Pan as a modulation des-
tination.

Modulation and controllers
The lower half of the control panel displays the various 
modulation and controller assignment pages available as 
well as the effect page. You switch between these pages 
using the buttons below the Morph section.

The following pages are available:

• The LFO page has two low frequency oscillators (LFOs) 
for modulating parameters – see below.

• The Envelope page contains the four Envelope genera-
tors which can be assigned to control parameters – see 
“Envelope page” on page 26.

• The Event page contains the common MIDI controllers 
(Mod wheel, Aftertouch etc. and their assignments – see 
“The Event page.” on page 28.

• The Effect page has three separate effect types avail-
able; Distortion, Delay and Modulation – see “Effects 
(EFX) page” on page 28.
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LFO page
This is opened by clicking the LFO button at the top of the 
lower half of the control panel. The page contains all pa-
rameters and the modulation and velocity destinations for 
two independent LFOs. Depending on the currently se-
lected Preset, there may already be modulation destina-
tions assigned, in which case these are listed in the “Mod 
Dest” box for each LFO – see “Assigning LFO modulation 
destinations” on page 25. A low frequency oscillator 
(LFO) is used for modulating parameters, for example the 
pitch of an oscillator (to produce vibrato), or for any pa-
rameter where cyclic modulation is desired.

The two LFOs have identical parameters:

About the sync modes

The Sync modes determine how the LFO cycle affects the 
notes you play:

About the waveforms

Most standard LFO waveforms are available for LFO mod-
ulation. You use Sine and Triangle waveforms for smooth 
modulation cycles, Square and Ramp up/down for differ-
ent types of stepped modulation cycles and Random or 
Sample for random modulation. The Sample waveform is 
different:

• In this mode, the LFO actually makes use of the other 
LFO as well. 
For example, if LFO 2 is set to use Sample the resulting effect will also 
depend on the speed and waveform of LFO 1.

Assigning LFO modulation destinations

To assign a modulation destination for a LFO, proceed as 
follows:

1. Click in the “Mod Dest” box for one of the LFOs.
A pop-up appears with all possible modulation destinations are shown. 
All Sound parameters as well as most LFO and Envelope parameters are 
available as destinations.

The modulation destination pop-up.

2. Select a destination, e.g. Cut.
The selected modulation destination is now shown in the list. Beside the 
destination, a default value (50) has been set. The value represents the 
modulation amount. 

Parameter Description

Speed This governs the rate of the LFO. If MIDI Sync is activated 
(see below), the available rate values are selectable as 
note values, so the rate will synced to the sequencer 
tempo in Nuendo in various beat increments.

Depth This controls the amount of modulation applied by the 
LFO. If set to zero, no modulation is applied.

Waveform This sets the LFO waveform. 

Sync mode 
(Part/MIDI/
Voice/Key)

This sets the sync mode for the LFO. See below for a de-
scription.

Parameter Description

Part In this mode, the LFO cycle is free running and will affect 
all the voices in sync. “Free running” means that the LFO 
cycles continuously, and doesn’t reset when a note is 
played.

MIDI In this mode the LFO rate is synced in various beat incre-
ments to MIDI clock.

Voice In this mode each voice in the Part has its own indepen-
dent LFO cycle (the LFO is polyphonic). These cycles are 
also free running – each key down starts anywhere in the 
LFO cycle phase.

Key Same as Voice except that it is not free running – for 
each key down the LFO cycle starts over.
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• You can set positive and negative modulation values by 
clicking on the value in the list, typing in a new value and 
pressing the Enter key.
To enter negative values type a minus sign followed by the value.

3. Select a suitable LFO Waveform, Speed, Depth and 
Sync mode.
You should now hear the Cut parameter being modulated by the LFO. 

4. Using the same basic method, you can add any num-
ber of modulation destinations for the LFO.
They will all be listed in the “Mod Dest” box.

• To remove a modulation destination click on its name in 
the list and select “Off” from the pop-up.

Assigning LFO velocity destinations

You can also assign LFO modulation that is velocity con-
trolled (i.e. governed by how hard or soft you strike a key). 
This is done as follows:

1. Click in the “Vel Dest” box for one of the LFOs.
A pop-up appears with all possible velocity destinations are shown. 

2. Select a destination. 
The selected velocity destination is now shown in the list. Beside the 
destination, a default value (50) has been set. The value represents the 
modulation amount. See below for an example of how velocity modula-
tion works.

• You can set positive and negative values by clicking on 
the value in the list, typing in a new value and pressing the 
Enter key.
To enter negative values type a minus sign followed by the value.

3. Using the same basic method, you can add any num-
ber of velocity destinations for the LFO.
They will all be listed in the “Vel Dest” box.

• To remove a modulation destination click on its name in 
the list and select “Off” from the pop-up.

LFO modulation velocity control – an example:

If you follow the steps above and select the Cut parameter 
as a Velocity destination, the following happens:

• The harder you strike the key, the more the Cut parame-
ter will be modulated by the LFO.

• If you should enter a negative value for the velocity mod-
ulation amount, the opposite happens; the harder you play 
the less the Cut parameter is modulated by the LFO.

Envelope page
The Envelope page is opened by clicking the ENV button 
at the top of the lower half of the control panel. The page 
contains all parameters and the modulation and velocity 
destinations for the four independent envelope genera-
tors. 

Envelope generators govern how a parameter value will 
change when a key is pressed, when a key is held and fi-
nally when a key is released.

The Envelope page.

On the Envelope page, the parameters for one of the four 
envelope generators is shown at a time.

• You switch between the four envelopes in the section to 
the left.
Clicking on either of the four mini curve displays 1 to 4 will select it and 
display the corresponding envelope parameters to the right. The mini 
curve displays also reflect the envelope settings for each corresponding 
envelope.

• Envelope generators have four parameters; Attack, De-
cay, Sustain and Release (ADSR).
See below for a description of these.

• You can set envelope parameters in two ways; either by 
using the sliders or by click-dragging the curve in the En-
velope curve display.
You can also do this in the mini curve displays.

• By default Envelope 1 is assigned to the master volume, 
and therefore acts as an amplitude envelope. The ampli-
tude envelope is used to adjust how the volume of the 
sound should change from the time you press a key until 
the key is released.
If no amplitude envelope were assigned, there would be no output.
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The Envelope parameters are as follows:

Attack

The attack phase is the time it takes from zero to the max-
imum value. How long this should take, depends on the 
Attack setting. If the Attack is set to “0”, the maximum 
value is reached instantly. If this value is raised, it will take 
time before the maximum value is reached. Range is from 
0.0 milliseconds to 91.1 seconds.

Decay

After the maximum value has been reached, the value 
starts to drop. How long this should take is governed by 
the Decay time parameter. The Decay time has no effect if 
the Sustain parameter is set to maximum. Range is from 
0.0 milliseconds to 91.1 seconds.

Sustain

The Sustain parameter determines the level the envelope 
should rest at, after the Decay phase. Note that Sustain 
represents a level, whereas the other envelope parame-
ters represent times. Range is from 0 to 100.

Release

Release determines the time it takes for the value to fall 
back to zero after releasing the key. Range is from 0.0 mil-
liseconds to 91.1 seconds.

Punch

When Punch is activated, the start of the decay phase is 
delayed a few milliseconds (the envelope “stays” at top 
level for a moment before moving on to the decay phase). 
The result is a punchier attack similar to a compressor ef-
fect. This effect is more pronounced with short attack and 
decay times.

Retrigger

When Retrigger is activated, the envelope will re-trigger 
each time you play a new note. However, with certain tex-
tures/pad sounds and a limited number of voices it is rec-
ommended to leave the button deactivated, due to click 
noises that might occur, when the envelope is ended up 
abruptly. This is caused by the incoming re-trigger that 
forces the envelope to start over again.

Assigning Envelope modulation destinations

To assign a modulation destination for an Envelope, pro-
ceed as follows:

1. Click in the “Mod Dest” box for one of the Envelopes.
A pop-up appears with all possible modulation destinations are shown. 
All Sound parameters as well as most LFO and Envelope parameters are 
available as destinations.

2. Select a destination, e.g. Cut.
The selected modulation destination is now shown in the list. Beside the 
destination, a default value (50) has been set. The value represents the 
modulation amount. 

• You can set positive and negative modulation values by 
clicking on the value in the list, typing in a new value and 
pressing the Enter key.
To enter negative values type a minus sign followed by the value.

3. Select a suitable envelope curve for the modulation.
You should now hear the Cut parameter being modulated by the enve-
lope as you play. 

4. Using the same basic method, you can add any num-
ber of modulation destinations for the envelope.
They will all be listed in the “Mod Dest” box.

• To remove a modulation destination click on its name in 
the list and select “Off” from the pop-up.

Assigning Envelope velocity destinations

You can also assign Envelope modulation that is velocity 
controlled (i.e. governed by how hard or soft you strike a 
key). This is done as follows:

1. Click in the “Vel Dest” box for one of the envelopes.
A pop-up appears with all possible velocity destinations are shown. 

2. Select a destination. 
The selected velocity destination is now shown in the list. Beside the 
destination, a default value (50) has been set. The value represents the 
modulation amount. See below for an example of how velocity modula-
tion works.

• You can set positive and negative values by clicking on 
the value in the list, typing in a new value and pressing the 
Enter key.
To enter negative values type a minus sign followed by the value.

3. Using the same basic method, you can add any num-
ber of velocity destinations for the Envelope.
They will all be listed in the “Vel Dest” box.



28

The included VST Instruments

• To remove a modulation destination click on its name in 
the list and select “Off” from the pop-up.

Envelope modulation velocity control – an example:

If you follow the steps above and select the Cut parameter 
as a Velocity destination, the following happens:

• The harder you strike the key, the more the parameter 
will be modulated by the Envelope.

• If you should enter a negative value for the velocity mod-
ulation amount, the opposite happens; the harder you play 
the less the Cut parameter will be modulated by the Enve-
lope.

Event page
The Event page is opened by clicking the EVENT button 
at the top of the lower half of the control panel. This page 
contains the most common MIDI controllers and their re-
spective assignments.

The Event page.

The following controllers are available:

To assign any of these controllers to one or several pa-
rameters, proceed as follows:

1. Click in the “Mod Dest” box for one of the controllers.
A pop-up appears with all possible modulation destinations are shown. 
All Sound parameters as well as most LFO and Envelope parameters are 
available as destinations.

2. Select a destination.
The selected modulation destination is now shown in the list. Beside the 
destination, a default value (50) has been set. The value represents the 
modulation amount when the controller is at its full range. 

• You can set positive and negative modulation values by 
clicking on the value in the list, typing in a new value and 
pressing the Enter key.
To enter negative values type a minus sign followed by the value.

3. Using the same basic method, you can add any num-
ber of modulation destinations for the controllers.
They will all be listed in the “Mod Dest” box for the respective controller.

• To remove a modulation destination click on its name in 
the list and select “Off” from the pop-up.

Effects (EFX) page
This page features three separate effect units: Distortion, 
Delay and Modulation (Phaser/Flanger/Chorus). The Ef-
fect page is opened by clicking the EFX button at the top 
of the lower half of the control panel.

• Each separate effect section is laid out with a row of 
buttons that determine the effect type or characteristic 
and a row of sliders for making parameter settings.

• To activate an effect, click the “Active” button so that a 
dot appears.
Clicking again deactivates the effect.

Distortion

You can select between 4 basic distortion characteristics:

• Distortion provides hard clipping distortion.
• Soft Distortion provides soft clipping distortion.
• Tape Emulation produces distortion similar to magnetic tape 

saturation.
• Tube Emulation produces distortion similar to valve amplifiers.

The parameters are as follows:

Controller Description

Modulation 
Wheel

The modulation wheel on your keyboard can be used to 
modulate parameters.

Velocity Velocity is used to control parameters according to how 
hard or soft you play notes on your keyboard. A common 
application of velocity is to make sounds brighter and 
louder if you strike the key harder.

Aftertouch Aftertouch, or channel pressure, is MIDI data sent when 
pressure is applied to a keyboard after the key has been 
struck, and while it is being held down or sustained. Af-
tertouch is often routed to control filter cutoff, volume, 
and other parameters to add expression. Most (but not 
all) MIDI keyboards send Aftertouch.

Key Pitch 
Tracking

This can change parameter values linearly according to 
where on the keyboard you play.

Parameter Description

Filter This parameter sets the crossover frequency of the dis-
tortion filter. The distortion filter consists of a lowpass fil-
ter and a highpass filter with a cutoff frequency equal to 
the crossover frequency. 

Tone This parameter controls the relative amount of lowpass 
and high-pass filtered signal. 

Drive Sets the amount of distortion by amplifying the input sig-
nal.

Level This controls the output level of the effect.
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Delay

You can select between 3 basic delay characteristics:

• Stereo Delay has two separate delay lines panned left and 
right.

• In Mono Delay the two delay lines are connected in series for 
monophonic dual tap delay effects.

• In Cross delay the delayed sound bounces between the ste-
reo channels.

The parameters are as follows:

Modulation

You can select between 3 basic modulation characteris-
tics:

• The Phaser uses an 8-pole allpass filter to produce the classic 
phasing effect. 

• The Flanger is composed of two independent delay lines with 
feedback for the left and the right channel respectively. The 
delay time of both delays is modulated by one LFO with ad-
justable frequency. 

• Chorus produces a rich chorus effect with 4 delays modulated 
by four independent LFOs.

The parameters are as follows:

SR parameters

With these buttons you can change the sample rate. 
Lower sample rates basically reduces the high frequency 
content and sound quality, but the pitch isn’t altered. This 
is a great way to emulate the “lo-fi” sounds of older digital 
synths!

• If button “F” is active, the selected Part’s program will play 
back with the sample rate set in the host application.

• If button “1/2” is active, the selected Part’s program will play 
back with half the original sample rate.

• If button “1/4” is active, the selected Part’s program will play 
back with a quarter of the original sample rate.

• A bonus effect of using lower sample rates is that it re-
duces the load on the computer CPU, allowing more si-
multaneous voices to be played etc.

Parameter Description

Song Sync This switches tempo sync of the delay times on or off.

Delay 1 Sets the delay time ranging from 0ms to 728ms. If MIDI 
sync is activated the range is from 1/32 to 1/1; straight, 
triplet or dotted.

Delay 2 Same as Delay 1.

Feedback This controls the decay of the delays. With higher set-
tings the echoes repeat longer.

Filter A lowpass filter is built into the feedback loop of the de-
lay. This parameter controls the cutoff frequency of this 
feedback filter. Low settings result in successive echoes 
sounding darker. 

Level This controls the output level of the effect. 

Parameter Description

Song Sync This switches tempo sync of the Rate parameter on or 
off.

Rate Sets the rate of the LFOs modulating the delay time. If 
Song Sync is activated the rate will be synced to various 
beat increments.

Depth This parameter controls the depth of the delay time mod-
ulation. 

Delay This parameter sets the delay time of the four delay lines. 

Feedback The feedback parameter controls the amount of positive 
or negative feedback for all four delay lines. The adjust-
able range is from -1 to 1.

Level This controls the output level of the effect. 

Parameter Description
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Mystic

The synthesis method used by Mystic is based on three 
parallel comb filters with feedback. A comb filter is a filter 
with a number of “notches” in its frequency response, with 
the notch frequencies harmonically related to the fre-
quency of the fundamental (lowest) notch. 

A typical example of comb filtering occurs if you are using 
a flanger effect or a delay effect with very short delay time. 
As you probably know, raising the feedback (the amount 
of signal sent back into the delay or flanger) will cause a 
resonating tone – this tone is basically what the Mystic 
produces. As you will see, this astonishingly simple syn-
thesis method is capable of generating a wide range of 
sounds, from gentle plucked-string tones to weird, non-
harmonic timbres. 

The basic principle is the following: 

• You start with an “impulse sound”, typically with a very 
short decay.
The spectrum of the impulse sound will largely affect the tonal quality of 
the final sound. To set up an impulse sound on the Mystic you use a 
slightly simplified version of the synthesis found on the Spector synth.

• The impulse sound is fed into the three comb filters, in 
parallel. Each of these has a feedback loop.
This means the output of each comb filter is fed back into the filter. This 
will result in a resonating feedback tone.

• When the signal is fed back into the comb filter, it goes 
via a separate, variable lowpass filter.
This filter corresponds to the damping of high frequencies in a physical 
instrument – when set to a low cutoff frequency it will cause high har-
monics to decay faster than the lower harmonics (as when plucking a 
string on a guitar, for example). 

• The level of the feedback signal is governed by a feed-
back control.
This determines the decay of the feedback tone. Setting this to a nega-
tive value will simulate the traveling wave in a tube with one open end 
and one closed end. The result is a more hollow, square wave-like sound, 
pitched one octave lower.

• A detune control offsets the fundamental frequencies of 
the three comb filters, for chorus-like sounds or drastic 
special effects.

Finally you have access to the common synth parameters 
– two LFOs, four envelopes and an effect section.

• By default, envelope 2 controls the level of the impulse 
sound – this is where you set up the short impulse decay 
when emulating string sounds etc.

The signal flow of the Mystic synth is illustrated in the 
section “Diagrams” on page 43.

Sound parameters

The Impulse Control section

This is where you set up the impulse sound – the sound 
fed into the comb filters, serving as a starting point for the 
sound. The Impulse Control has two basic waveforms that 
are filtered through separate spectrum filters with adjust-
able base frequency; the output is an adjustable mix be-
tween the two waveform/spectrum filter signals. 
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Spectrum displays

Allows you to draw a filter contour with your mouse for 
spectrum filters A & B. 

• To set up the contour, click in one of the displays and 
drag the mouse to draw the desired curve. Note that this 
will produce the inverse contour in the other display, for 
maximum sonic versatility.
To set up the contour independently for the two filters, hold down [Shift] 
and click and drag the mouse in either display.

• Use the Preset pop-up menu to select a preset contour 
if you like.

• If you want to random calculate a spectrum filter curve, 
you can choose the Randomize function from the Preset 
pop-up.
Each time you choose this function, a new randomized spectrum will ap-
pear.

Waveform pop-up

The pop-up at the bottom of the waveform section (the 
central box at the top of the panel) allows you to select a 
basic waveform to be sent through filter contour A. The op-
tions are especially suited for use with the spectrum filter.

Cut

This offsets the frequency of the filter contour, working 
somewhat like a cutoff control on a standard synth filter. 
To use the filter contour in its full frequency range, set Cut 
to its maximum value.

Morph

Adjusts the mix between the two signal paths: waveform A 
spectrum contour A and waveform B spectrum contour B.

Coarse

This offsets the pitch for the impulse sound. In a typical 
“string setup”, when the impulse sound is very short, this 
will not change the pitch of the final sound, but the tonal 
color.

Raster

This removes harmonics from the impulse sound. As the 
harmonic content of the impulse sound is reflected in the 
comb filter sound, this will change the final timbre.

Comb filter sound parameters

Damping

This is a 6dB/oct lowpass filter that affects the sound be-
ing fed back into the comb filters. This means the sound 
will become gradually softer when decaying, i.e. high har-
monics to decay faster than the lower harmonics (as when 
plucking a string on a guitar, for example). 

• The lower the Damping, the more pronounced this ef-
fect.
If you open the filter completely (turn Damping up to max) the harmonic 
content will be static – i.e. the sound will not get softer when decaying.

Level

This determines the level of the impulse sound being fed 
into the comb filters. By default, this parameter is modu-
lated by envelope 2. That is, you use envelope 2 as a level 
envelope for the impulse sound. 

• For a string-type sound, you want an envelope with a 
quick attack, a very short decay and no sustain (an “im-
pulse” in other words), but you can also use other enve-
lopes for other types of sounds.
Try raising the attack for example, or raising the sustain to allow the im-
pulse sound to be heard together with the comb filter sound.
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Crackle

This allows you to send noise directly into the comb filters. 
Small amounts of noise will produce a “crackling”, erratic 
effect; higher amounts will give a more pronounced noise 
sound.

Feedback

This determines the amount of signal sent back into the 
comb filters (the feedback level). 

• Setting Feedback to zero (twelve o’clock) will effectively turn 
off the comb filter sound, as no feedback tone is produced.

• Setting Feedback to a positive value will create a feedback 
tone, with higher settings generating longer decays.

• Setting Feedback to a negative value will create a feedback 
tone with a more hollow sound, pitched one octave lower. 
Lower settings generate longer decays.

Detune

This offsets the notch frequencies of the three parallel 
comb filters, effectively changing the pitches of their feed-
back tones. At low settings, this creates a chorus-like de-
tune effect. Higher settings detunes the three tones in 
wider intervals.

Pitch and Fine

Overall pitch adjustment of the final sound. This changes 
the pitch of both the impulse sound and the final comb fil-
ter sound.

Key Tracking

This button determines whether the impulse sound should 
track the keyboard or not. This will affect the sound of the 
comb filters in a way similar to a key track switch on a reg-
ular subtractive synth filter.

Portamento

This parameter makes the pitch glide between the notes 
you play. The parameter setting determines the time it 
takes for the pitch to glide from one note to the next. Turn 
the knob clockwise for longer glide time.

The “Mode” switch allows you to apply glide only when 
you play a legato note (when switch is set to Legato). Le-
gato is when you play a note without releasing the previ-
ously played note. Note that Legato mode only works with 
monophonic Parts.

Master Volume and Pan

The master Volume controls the master volume (ampli-
tude) of the instrument. By default this parameter is con-
trolled by Envelope 1, to generate an amplitude envelope 
for the oscillators.

The Pan dial controls the position in the stereo spectrum 
for the instrument. You can use Pan as a modulation des-
tination.

Modulation and controllers
The lower half of the control panel displays the various 
modulation and controller assignment pages available as 
well as the effect page. You switch between these pages 
using the buttons above this section.

The following pages are available:

• The LFO page has two low frequency oscillators (LFOs) 
for modulating parameters – see below.

• The Envelope page contains the four Envelope genera-
tors which can be assigned to control parameters – see 
“Envelope page” on page 34.

• The Event page contains the common MIDI controllers 
(Mod wheel, Aftertouch etc. and their assignments – see 
“The Event page.” on page 36.

• The Effect page has three separate effect types avail-
able; Distortion, Delay and Modulation – see “Effects 
(EFX) page” on page 36.

LFO page
This is opened by clicking the LFO button at the top of the 
lower half of the control panel. The page contains all pa-
rameters and the modulation and velocity destinations for 
two independent LFOs. Depending on the currently se-
lected Preset, there may already be modulation destina-
tions assigned, in which case these are listed in the “Mod 
Dest” box for each LFO – see “Assigning LFO modulation 
destinations” on page 33. 
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A low frequency oscillator (LFO) is used for modulating 
parameters, for example the pitch of an oscillator (to pro-
duce vibrato), or for any parameter where cyclic modula-
tion is desired.

The two LFOs have identical parameters:

About the sync modes

The Sync modes determine how the LFO cycle affects the 
notes you play:

About the waveforms

Most standard LFO waveforms are available for LFO mod-
ulation. You use Sine and Triangle waveforms for smooth 
modulation cycles, Square and Ramp up/down for differ-
ent types of stepped modulation cycles and Random or 
Sample for random modulation. The Sample waveform is 
different:

• In this mode, the LFO actually makes use of the other 
LFO as well. 
For example, if LFO 2 is set to use Sample the resulting effect will also 
depend on the speed and waveform of LFO 1.

Assigning LFO modulation destinations

To assign a modulation destination for a LFO, proceed as 
follows:

1. Click in the “Mod Dest” box for one of the LFOs.
A pop-up appears with all possible modulation destinations are shown. 
All Sound parameters as well as most LFO and Envelope parameters are 
available as destinations.

The modulation destination pop-up.

2. Select a destination, e.g. Cut.
The selected modulation destination is now shown in the list. Beside the 
destination, a default value (50) has been set. The value represents the 
modulation amount. 

• You can set positive and negative modulation values by 
clicking on the value in the list, typing in a new value and 
pressing the Enter key.
To enter negative values type a minus sign followed by the value.

3. Select a suitable LFO Waveform, Speed, Depth and 
Sync mode.
You should now hear the Cut parameter being modulated by the LFO. 

4. Using the same basic method, you can add any num-
ber of modulation destinations for the LFO.
They will all be listed in the “Mod Dest” box.

• To remove a modulation destination click on its name in 
the list and select “Off” from the pop-up.

Parameter Description

Speed This governs the rate of the LFO. If MIDI Sync is activated 
(see below), the available rate values are selectable as 
note values, so the rate will synced to the sequencer 
tempo in Nuendo in various beat increments.

Depth This controls the amount of modulation applied by the 
LFO. If set to zero, no modulation is applied.

Waveform This sets the LFO waveform. 

Sync mode 
(Part/MIDI/
Voice/Key)

This sets the sync mode for the LFO. See below for a de-
scription.

Parameter Description

Part In this mode, the LFO cycle is free running and will affect 
all the voices in sync. “Free running” means that the LFO 
cycles continuously, and doesn’t reset when a note is 
played.

MIDI In this mode the LFO rate is synced in various beat incre-
ments to MIDI clock.

Voice In this mode each voice in the Part has its own indepen-
dent LFO cycle (the LFO is polyphonic). These cycles are 
also free running – each key down starts anywhere in the 
LFO cycle phase.

Key Same as Voice except that it is not free running – for 
each key down the LFO cycle starts over.
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Assigning LFO velocity destinations

You can also assign LFO modulation that is velocity con-
trolled (i.e. governed by how hard or soft you strike a key). 
This is done as follows:

1. Click in the “Vel Dest” box for one of the LFOs.
A pop-up appears with all possible velocity destinations are shown. 

2. Select a destination. 
The selected velocity destination is now shown in the list. Beside the 
destination, a default value (50) has been set. The value represents the 
modulation amount. See below for an example of how velocity modula-
tion works.

• You can set positive and negative values by clicking on 
the value in the list, typing in a new value and pressing the 
Enter key.
To enter negative values type a minus sign followed by the value.

3. Using the same basic method, you can add any num-
ber of velocity destinations for the LFO.
They will all be listed in the “Vel Dest” box.

• To remove a modulation destination click on its name in 
the list and select “Off” from the pop-up.

LFO modulation velocity control – an example:

If you follow the steps above and select the Cut parameter 
as a Velocity destination, the following happens:

• The harder you strike the key, the more the Cut parame-
ter will be modulated by the LFO.

• If you should enter a negative value for the velocity mod-
ulation amount, the opposite happens; the harder you play 
the less the Cut parameter is modulated by the LFO.

Envelope page
The Envelope page is opened by clicking the ENV button 
at the top of the lower half of the control panel. The page 
contains all parameters and the modulation and velocity 
destinations for the four independent envelope generators. 

Envelope generators govern how a parameter value will 
change when a key is pressed, when a key is held and fi-
nally when a key is released.

The Envelope page.

On the Envelope page, the parameters for one of the four 
envelope generators is shown at a time.

• You switch between the four envelopes in the section to 
the left.
Clicking on either of the four mini curve displays 1 to 4 will select it and 
display the corresponding envelope parameters to the right. The mini 
curve displays also reflect the envelope settings for each corresponding 
envelope.

• Envelope generators have four parameters; Attack, De-
cay, Sustain and Release (ADSR).
See below for a description of these.

• You can set envelope parameters in two ways; either by 
using the sliders or by click-dragging the curve in the En-
velope curve display.
You can also do this in the mini curve displays.

• By default Envelope 1 is assigned to the master volume, 
and therefore acts as an amplitude envelope. The ampli-
tude envelope is used to adjust how the volume of the 
sound should change from the time you press a key until 
the key is released.
If no amplitude envelope were assigned, there would be no output.

• Envelope 2 is by default assigned to the Level parame-
ter.
See “Level” on page 31.

The Envelope parameters are as follows:

Attack

The attack phase is the time it takes from zero to the max-
imum value. How long this should take, depends on the 
Attack setting. If the Attack is set to “0”, the maximum 
value is reached instantly. If this value is raised, it will take 
time before the maximum value is reached. Range is from 
0.0 milliseconds to 91.1 seconds.

Decay

After the maximum value has been reached, the value 
starts to drop. How long this should take is governed by 
the Decay time parameter. The Decay time has no effect if 
the Sustain parameter is set to maximum. Range is from 
0.0 milliseconds to 91.1 seconds.
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Sustain

The Sustain parameter determines the level the envelope 
should rest at, after the Decay phase. Note that Sustain 
represents a level, whereas the other envelope parame-
ters represent times. Range is from 0 to 100.

Release

Release determines the time it takes for the value to fall 
back to zero after releasing the key. Range is from 0.0 mil-
liseconds to 91.1 seconds.

Punch

When Punch is activated, the start of the decay phase is 
delayed a few milliseconds (the envelope “stays” at top 
level for a moment before moving on to the decay phase). 
The result is a punchier attack similar to a compressor ef-
fect. This effect is more pronounced with short attack and 
decay times.

Retrigger

When Retrigger is activated, the envelope will re-trigger 
each time you play a new note. However, with certain tex-
tures/pad sounds and a limited number of voices it is rec-
ommended to leave the button deactivated, due to click 
noises that might occur, when the envelope is ended up 
abruptly. This is caused by the incoming re-trigger that 
forces the envelope to start over again.

Assigning Envelope modulation destinations

To assign a modulation destination for an Envelope, pro-
ceed as follows:

1. Click in the “Mod Dest” box for one of the Envelopes.
A pop-up appears with all possible modulation destinations are shown. 
All Sound parameters as well as most LFO and Envelope parameters are 
available as destinations.

2. Select a destination, e.g. Cut.
The selected modulation destination is now shown in the list. Beside the 
destination, a default value (50) has been set. The value represents the 
modulation amount. 

• You can set positive and negative modulation values by 
clicking on the value in the list, typing in a new value and 
pressing the Enter key.
To enter negative values type a minus sign followed by the value.

3. Select a suitable envelope curve for the modulation.
You should now hear the Cut parameter being modulated by the enve-
lope as you play. 

4. Using the same basic method, you can add any num-
ber of modulation destinations for the envelope.
They will all be listed in the “Mod Dest” box.

• To remove a modulation destination click on its name in 
the list and select “Off” from the pop-up.

Assigning Envelope velocity destinations

You can also assign Envelope modulation that is velocity 
controlled (i.e. governed by how hard or soft you strike a 
key). This is done as follows:

1. Click in the “Vel Dest” box for one of the envelopes.
A pop-up appears with all possible velocity destinations are shown. 

2. Select a destination. 
The selected velocity destination is now shown in the list. Beside the 
destination, a default value (50) has been set. The value represents the 
modulation amount. See below for an example of how velocity modula-
tion works.

• You can set positive and negative values by clicking on 
the value in the list, typing in a new value and pressing the 
Enter key.
To enter negative values type a minus sign followed by the value.

3. Using the same basic method, you can add any num-
ber of velocity destinations for the Envelope.
They will all be listed in the “Vel Dest” box.

• To remove a modulation destination click on its name in 
the list and select “Off” from the pop-up.

Envelope modulation velocity control – an example:

If you follow the steps above and select the Cut parameter 
as a Velocity destination, the following happens:

• The harder you strike the key, the more the parameter 
will be modulated by the Envelope.

• If you should enter a negative value for the velocity mod-
ulation amount, the opposite happens; the harder you play 
the less the Cut parameter will be modulated by the Enve-
lope.
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Event page
The Event page is opened by clicking the EVENT button 
at the top of the lower half of the control panel. This page 
contains the most common MIDI controllers and their re-
spective assignments.

The Event page.

The following controllers are available:

To assign any of these controllers to one or several pa-
rameters, proceed as follows:

1. Click in the “Mod Dest” box for one of the controllers.
A pop-up appears with all possible modulation destinations are shown. 
All Sound parameters as well as most LFO and Envelope parameters are 
available as destinations.

2. Select a destination.
The selected modulation destination is now shown in the list. Beside the 
destination, a default value (50) has been set. The value represents the 
modulation amount when the controller is at its full range. 

• You can set positive and negative modulation values by 
clicking on the value in the list, typing in a new value and 
pressing the Enter key.
To enter negative values type a minus sign followed by the value.

3. Using the same basic method, you can add any num-
ber of modulation destinations for the controllers.
They will all be listed in the “Mod Dest” box for the respective controller.

• To remove a modulation destination click on its name in 
the list and select “Off” from the pop-up.

Effects (EFX) page
This page features three separate effect units: Distortion, 
Delay and Modulation (Phaser/Flanger/Chorus). The Ef-
fect page is opened by clicking the EFX button at the top 
of the lower half of the control panel.

• Each separate effect section is laid out with a row of 
buttons that determine the effect type or characteristic 
and a row of sliders for making parameter settings.

• To activate an effect, click the “Active” button so that a 
dot appears.
Clicking again deactivates the effect.

Distortion

You can select between 4 basic distortion characteristics:

• Distortion provides hard clipping distortion.
• Soft Distortion provides soft clipping distortion.
• Tape Emulation produces distortion similar to magnetic tape 

saturation.
• Tube Emulation produces distortion similar to valve amplifiers.

The parameters are as follows:

Delay

You can select between 3 basic delay characteristics:

• Stereo Delay has two separate delay lines panned left and 
right.

• In Mono Delay the two delay lines are connected in series for 
monophonic dual tap delay effects.

• In Cross delay the delayed sound bounces between the ste-
reo channels.

The parameters are as follows:

Controller Description

Modulation 
Wheel

The modulation wheel on your keyboard can be used to 
modulate parameters.

Velocity Velocity is used to control parameters according to how 
hard or soft you play notes on your keyboard. A common 
application of velocity is to make sounds brighter and 
louder if you strike the key harder.

Aftertouch Aftertouch, or channel pressure, is MIDI data sent when 
pressure is applied to a keyboard after the key has been 
struck, and while it is being held down or sustained. Af-
tertouch is often routed to control filter cutoff, volume, 
and other parameters to add expression. Most (but not 
all) MIDI keyboards send Aftertouch.

Key Pitch 
Tracking

This can change parameter values linearly according to 
where on the keyboard you play.

Parameter Description

Drive Sets the amount of distortion by amplifying the input sig-
nal.

Filter This parameter sets the crossover frequency of the dis-
tortion filter. The distortion filter consists of a lowpass fil-
ter and a highpass filter with a cutoff frequency equal to 
the crossover frequency. 

Tone This parameter controls the relative amount of lowpass 
and high-pass filtered signal. 

Level This controls the output level of the effect.

Parameter Description

Song Sync This switches tempo sync of the delay times on or off.
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Modulation

You can select between 3 basic modulation characteris-
tics:

• The Phaser uses an 8-pole allpass filter to produce the classic 
phasing effect. 

• The Flanger is composed of two independent delay lines with 
feedback for the left and the right channel respectively. The 
delay time of both delays is modulated by one LFO with ad-
justable frequency. 

• Chorus produces a rich chorus effect with 4 delays modulated 
by four independent LFOs.

The parameters are as follows:

SR parameters

With these buttons you can change the sample rate. 
Lower sample rates basically reduces the high frequency 
content and sound quality, but the pitch isn’t altered. This 
is a great way to emulate the “lo-fi” sounds of older digital 
synths!

• If button “F” is active, the selected Part’s program will play 
back with the sample rate set in the host application.

• If button “1/2” is active, the selected Part’s program will play 
back with half the original sample rate.

• If button “1/4” is active, the selected Part’s program will play 
back with a quarter of the original sample rate.

• A bonus effect of using lower sample rates is that it re-
duces the load on the computer CPU, allowing more si-
multaneous voices to be played etc.

HALionOne

HALionOne is a sample player that can play sound content 
in the *.hsb (HALion Sound Bank) format. These samples 
have associated preset files that store the panel settings 
and reference the HSB samples. Included are several pre-
sets (as *.vstpreset and *.trackpreset files).

The operation of HALionOne is very simple; load a preset 
(a *.vstpreset or a *.trackpreset file for an Instrument 
Track) and start playing! You do, however, have the option 
to tweak the basic parameters to tailor the sound to your 
liking.

HALionOne parameters
The HALionOne differs from other VST Instruments in that 
the panel parameters shown can vary according to which 
parameters are stored in the HSB file. HSB files cannot 
be created with HALionOne – you need the full version of 
HALion to do this – but when created, certain parameters 
are assigned as part of the file and the associated pro-
gram (or preset). This means that for each preset, only 
these assigned parameters are shown on the instrument 
panel. Typically, these are filter cutoff, DCA and DCF pa-
rameters and any assigned effect parameters (the effects 
are “built in”).

Delay 1 Sets the delay time ranging from 0ms to 728ms. If MIDI 
sync is activated the range is from 1/32 to 1/1; straight, 
triplet or dotted.

Delay 2 Same as Delay 1.

Feedback This controls the decay of the delays. With higher set-
tings the echoes repeat longer.

Filter A lowpass filter is built into the feedback loop of the de-
lay. This parameter controls the cutoff frequency of this 
feedback filter. Low settings result in successive echoes 
sounding darker. 

Level This controls the output level of the effect. 

Parameter Description

Song Sync This switches tempo sync of the Rate parameter on or 
off.

Rate Sets the rate of the LFOs modulating the delay time. If 
Song Sync is activated the rate will be synced to various 
beat increments.

Depth This parameter controls the depth of the delay time mod-
ulation. 

Delay This parameter sets the delay time of the four delay lines. 

Feedback The feedback parameter controls the amount of positive 
or negative feedback for all four delay lines. The adjust-
able range is from -1 to 1.

Level This controls the output level of the effect. 

Parameter Description
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If you load HALionOne for an Instrument track and select, 
for example, the “Draw Organ” preset, the following pa-
rameters are shown:

These parameter assignments are used for many of the 
HALionOne presets, but not for all. As stated above, other 
parameters may be shown; these will be clearly labelled 
on the panel. For most of the presets there are also asso-
ciated effects – the effect parameters are usually as-
signed to the quick controls on the right and typically 
control the dry/wet mix of the effect.

Effect Bypass

• This button, located at the bottom right in the box dis-
playing the preset name, allows you to bypass any effects.
The blue LED beside the button is lit if any effects are used in the preset.

Efficiency slider

The Efficiency slider provides a way of balancing audio 
quality vs. conservation of computer power. The lower the 
setting, the more voices are available. As a trade-off, 
sound quality is reduced.

Voices allocated

• The Voices field dynamically displays the number of 
voices currently used.

MIDI and Disk activity LEDs

The MIDI activity LED indicates received MIDI input. The 
Disk LED will light up green when samples are streamed 
from disk, and red when samples cannot be loaded from 
disk in time. In such a case you should consider lowering 
the Efficiency slider. When the disk LED doesn’t light up, 
samples are read from memory.

Locate Contents

If you have moved the HALionOne content files to a differ-
ent location (i.e. any other location than the folder in which 
it was stored at installation time), you need to use the Lo-
cate Contents function to inform HALion One about 
where to find its files. This is done as follows:

• Right-click anywhere on the control panel and select 
“Locate contents”.
A file dialog opens where you can navigate to the folder location.

HALionOne and MIDI files

When the Preferences option “Import to Instrument Tracks” 
is activated (on the MIDI–MIDI File page), importing a MIDI 
file into Nuendo will automatically set up instrument tracks, 
with HALionOne as the associated instrument. This allows 
you to quickly audition any imported MIDI files, to change 
parameter settings or to add effects, etc.

Parameter Description

Cutoff This allows you to adjust filter frequency or cutoff. The fil-
ter used is a Waldorf Low Pass filter with a 24dB slope.

Resonance Raising the filter resonance value will emphasize the fre-
quencies around the set filter frequency.

DCF Amount Controls the amount of the DCF (filter) envelope.

DCA Attack Controls the time it takes for the DCA signal to reach its 
highest level.

DCA Decay Controls the time it takes the DCA signal to decay to the 
sustain level.

DCA Sustain Controls the DCA signal level after the Decay phase, as 
long as you press the key on your MIDI keyboard.

DCA Release Controls the DCA signal after a key is released.

DCA Amount Controls the amount of the DCA (amplifier) envelope.
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Embracer – Surround Pad 
Synthesizer
Embracer is a simple but powerful polyphonic synthesizer 
designed entirely for producing pads and accompaniment 
sounds. With its easy-to-use envelope and tone controls, 
it gives you fast access to the sounds you need without 
having to search through thousands of presets. However, 
the most powerful feature of Embracer is its surround out-
put. With a single switch, you can turn the instrument from 
stereo to surround and the width control allows you to 
spread your pad sound anywhere from mono to stereo to 
full 360° surround. The unique “eye” controller gives you 
an exact idea of how the sound will be placed in a mix. 

If you’ve never worked with a surround system before, 
now is the time to start exploring these possibilities.

The Embracer Surround Pad Synthesizer has the follow-
ing properties:

• Embracer is a Polyphonic surround pad synthesizer.
• 2 oscillators with 12 waveforms.
• Independent envelope and tone controls.
• Stereo and surround outputs.
• Up to 32 voices of polyphony per instance.
• Dynamic width control for exciting 3D sounds.
• “Eye” controller for simultaneous tone and width control.
• Full MIDI control implementation.

Osc 1 and 2

Envelope and Level

Master

Parameter Description

Wave Selects the waveform for each oscillator. Available wave-
forms are: Carpet, DigiPad, Choir, Ensemble, Metal 
Phaze, Phase Strings, Sing Sing, Soft Wave, Spit Strynx, 
Stepfloor, Submerged, Wave Bellz. 
Note: If you want to use only one oscillator, set the wave-
form to OFF. In this case only one voice per key will be 
used.

Tone Embracer offers a high pass and low pass filter for each 
oscillator. Both filters are controlled via a single Tone 
knob. In the 50% center position, the signal will not be fil-
tered. Reducing the tone value adds low pass filtering. 
Values above 50% add high pass filtering. This parame-
ter can also be controlled by the “eye” controller.

Width Controls the spatial spread of the signal. A value of 0% 
puts the signal mono into the center position. In stereo 
mode, a value of 100% results in a maximum stereo 
width. In surround mode, a value of 100% creates a full 
360° surround image. The width parameter can be con-
trolled by a variety of modulation sources, as well as by 
the “eye” controller.

Coarse 
(Oscillator 2 
only)

Changes the pitch in semitones. Maximum range is +1/24 
semitones = 2 octaves.

Fine 
(Oscillator 2 
only)

Changes the pitch in fine steps with a range of up to 
+/- 50 cents. 
Note: If you want to create a slight detune effect between 
the oscillators, make sure to set the master tune parame-
ter to a negative value of the same amount to keep the in-
strument in tune.

Parameter Description

Attack Controls the attack time of each oscillator. Higher values 
create slower attacks.

Attack Vel Sets the amount of velocity control of the attack time. 
Higher values increase the velocity sensitivity.

Level Controls the oscillator output level.

Level Vel Sets the amount of velocity control of the oscillator level. 
Higher values increase the velocity sensitivity.

Parameter Description

Release Controls the overall release time of the volume envelope. 
Higher values result in longer release times.

Mode Sets the output mode of Embracer. You can choose be-
tween “Stereo” and “Surround”. In Stereo Mode, Em-
bracer has one stereo output in the VST Mixer. In Surround 
Mode, Embracer has either a quadraphonic 4-channel out-
put or two independent stereo outputs in the Mixer. See 
below for more details on using Embracer in a surround 
mixer setup.
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The “Eye”

The Embracer’s unique “Eye” controller offers a creative 
new way of controlling the sound’s overall character and 
shape. This controller gives you access to several para-
meters at the same time. 

For each oscillator, there is a circle representing the tone 
and width of the sound. Click and drag the corresponding 
circle to change its shape. There are also two (numbered) 
oscillator handles. You can drag these vertically to change 
the tone or horizontally to change the width of the respec-
tive oscillator. When you drag a handle, the respective 
Tone and Width knobs of the oscillator are adjusted ac-
cordingly. Play a note while editing to hear the effect.

The “eye” can not only be used as a controller for the tone 
and width parameters, but also works as a surround 
scope for monitoring the spatial integration of the current 
sound. The display represents the sound’s position in the 
stereo or surround sound field. In stereo mode, the sound 
position is shown only in the upper half of the display and 
represents the front part of the sound field. In surround 
mode, the sound position is shown in the upper and lower 
half of the display and represents the front and rear part of 
the sound field.

• You can use Embracer’s automation feature to record 
the movements of the mouse within the “eye” controller!

Using Embracer in Surround Mode

When you want to enjoy Embracer in 3D, set it up in sur-
round mode and listen to it on a surround system. Let’s 
assume you have a surround monitoring system set up 
with your VST mixer and your VST output connections are 
properly set up.

1. Open an instance of Embracer in the VST instruments 
rack and set it to surround mode. 

2. When you open the mixer you will see two separate 
stereo channels for the Embracer. The first is titled “Em-
bracer” and the second “Embracer rear”. 

3. Assign both channel outputs to the surround output 
bus. 
The two channel strips will now show independent surround panners. By 
default, the first output pair is assigned to the front left and right channels 
and the second output pair to the rear left and right channels. The sur-
round width can be controlled with the “width” parameter.

4. Double-click on the surround panner to open its con-
trol panel. Set the “Mono/Stereo” parameter to either 
“Y-Mirror”, “X-mirror” or “XY-mirror”. You can now freely 
adjust the surround panning to your taste.

5. If your surround configuration includes a center or LFE 
channel, you can also add some of Embracer’s signal to 
the center or LFE channels. Feel free to experiment to find 
out what works best in a given project and mix.

Width Ctr Use this parameter to select a modulation source for the 
width parameter. Available sources are: Mod Wheel, Af-
tertouch, Velocity and Envelope. 
Both oscillators are controlled simultaneously. However, 
modulation depth is controlled independently by the re-
spective width parameter of each oscillator.

Max Poly Sets the total number of voices available. Each oscillator 
uses one voice per note played. Thus, a two-oscillator 
sound with 8 voices results in 4-voice polyphony. The de-
fault value for Max Poly is 16.

Fine Tune Use this to adjust the pitch of the whole instrument. 
Range is +/- 50 cents. Use Fine Tune in combination 
with the Fine Tune parameter of OSC 2 to create smooth 
detune effects.

Master Out Sets the overall output volume of the instrument.

Parameter Description
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Monologue – Monophonic Analog 
Modeling Synthesizer 
Monologue is a monophonic analog synthesizer based on 
physical modeling technology. It offers full, rich and color-
ful sounds without consuming a lot of CPU power. The 
Monologue synthesizer is the perfect tool for bass, lead 
and sequenced sounds.

The Monophonic Analog Modeling Synthesizer has the 
following properties:

• 2 oscillators with sawtooth, square and triangle waveforms.
• An additional noise generator for white noise.
• Monologue has two filters: a high pass filter and a versatile 

multimode filter.
• Monologue has a single LFO.
• Monologue has 4-stage ADSR mod and amp envelopes.
• Monologue has an effects section with chorus, phaser, and 

flanger effects, plus separate delay and overdrive units.
• Monologue has a X/Y matrix pad for additional realtime modu-

lation with access to all Monologue parameters.

Osc 1 and 2

Mix

Filter

Parameter Description

Waveform
(pop-up menu)

This is where you select the waveform: Saw, Square and 
Sub for oscillator 1 and Saw, Square and Triangle for 
Oscillator 2.

Coarse Sets the coarse pitch in semitones. The available range is 
+/- one octave.

Fine Allows you to fine-tune the pitch in cent increments. The 
available range is +/- 50 cents.

Depth Controls the pitch modulation depth for the mod source 
defined in the “mod src” field. The available range is +/- 
one octave.

Mod Src Defines the pitch modulation source. Available sources 
are: Modwheel, Aftertouch, Pitchbend, Velocity, LFO and 
Mod Env.

PWM 
(OSC2 only)

Controls the pulse width of the square wave. In the cen-
ter position, pulse width is 50/50. Turning the PWM knob 
clockwise or counter clockwise creates a positive or neg-
ative pulse, respectively.

Sync
(OSC2 only)

Activating the sync button synchronizes the pitch of os-
cillator 2 to the pitch of oscillator 1. When this is active, 
changing or modulating the pitch of oscillator 2 will 
change the tone and not the pitch. For the typical sync 
sound, turn osc 1 down in the mix and use osc 2 only.

Parameter Description

Osc 1 Sets the pre-filter level for oscillator 1.

Noise Sets the pre-filter noise level.

Osc 2 Sets the pre-filter level for oscillator 2.

Parameter Description

Mode Sets the filter type. Available filter types are 24 dB Low 
pass, 18dB Low pass, 12dB Low pass, 6dB Low pass, 
12dB Band pass and 12dB High pass.

Cutoff Sets the filter cutoff frequency. How this parameter oper-
ates is governed by the filter type.

High Pass Sets the cutoff frequency of the additional high-pass fil-
ter.

Res Changes the resonance of the multi-mode filter. Full res-
onance puts the filter into self-oscillation.

Key Track Determines the amount of key tracking applied to the fil-
ter cutoff frequency. The available range is 0 to 100%. A 
range of 100% tunes the filter cutoff frequency to the 
keyboards pitch 1:1.

Mod Src 
(A+B)

Defines the filter modulation source. The available 
sources are: Modwheel, Aftertouch, Pitchbend, Velocity, 
LFO, and Mod Env.

Depth 
(A+B)

Controls the filter modulation depth for the mod source 
set in the “mod src” field. 

Parameter Description
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Envelope

LFO

X/Y Pad

Effects

Master

Parameter Description

A – (Attack) Sets the attack time.

D – (Decay) Sets the decay time.

S – (Sustain) Sets the sustain level.

R – (Release) Sets the release time.

Mod Src (A+B) Defines the envelope modulation source. You can select: 
Modwheel, Aftertouch, Pitchbend, Velocity, LFO and 
Mod Env.

Depth (A+B) Controls the envelope modulation depth for the mod 
source defined in the “mod src” field.

Parameter Description

Waveform
(pop-up menu)

Here, you can select the waveform for the low frequency 
oscillator. Available waveforms are: Triangle, Square, 
Sawtooth, Sample & Hold and Random.

Rate Adjusts the frequency of the LFO, thus changing the rate 
of the modulation. Depending on the LFO sync parame-
ter, you can edit the rate in Hertz or in note values. 

Sync When “Sync” is “on” the LFO speed will be synchronized 
to the sequencer’s tempo. This also affects the LFO rate 
format.

Mod Src Defines the LFO modulation source. Available sources 
are: 
Modwheel, Aftertouch, Pitchbend, Velocity, LFO and 
Mod Env.

Depth Controls the LFO modulation depth for the mod source 
defined in the “mod src” field. 

Parameter Description

X Par Sets the parameter to be modulated on the x axis of the 
XY Pad. All of Monologue’s parameters are available as 
destinations.

Y Par Sets the parameter to be modulated on the y axis of the 
XY Pad.

XY Pad Use the mouse to control any two of Monologue’s param-
eters in combination. By moving the mouse horizontally, 
you can control the x parameter, by moving it vertically, 
you can control the y parameter. You can also record 
controller movements as automation data.

Parameter Description

FX Type
(pop-up menu)

Selects the effect type for Monologue’s pitch effects. The 
available types are Chorus, Flanger and Phaser.

Rate Use this to adjust the rate of the effect modulation.

Depth Use this to adjust the depth of the effect modulation.

FBK Controls the feedback of the effect.

Mix Controls the balance between dry and wet (effect) signal. 
Set to 0, the effect will be off. Set to 50, the balance be-
tween dry and wet signal is 50/50.

Overdrive Controls the amount of overdrive (distortion) added to 
the signal. A slight amount of overdrive will create punch 
and bottom. Higher amounts will add distortion.

Delay Sets the delay time in musical values. The delay effect is 
always in sync with the song tempo.

Spread Controls the stereo spread of the delay signal. If you set 
this to 0, the delay will be centered mono. Higher 
amounts of spread will shift the left and right delay chan-
nels. If you set this to 100, the delays will “ping-pong” 
between the left and right channels at an even rate.

Tone Adds a low pass filter to the delay. Increasing “tone” will 
make every delay repetition darker in tone.

FBK Controls the amount of feedback of the delay. High feed-
back levels will create infinite delays. Use this parameter 
with caution.

Mix Controls the balance between dry and wet (effect) signal. 
Set to 0, the effect will be off. Set to 50, the balance be-
tween dry and wet signal is 50/50.

Parameter Description

Glide Mode The available modes are: “held”, “on” and “off”. With 
“held” selected, a glide effect only occurs for notes 
played legato.

Rate Controls the glide rate – the time it takes for a note to 
reach its destination pitch.

PB Range Controls the range of a pitch bend MIDI controller. Range 
can be set between 1 and 24 semitones for a total of two 
octaves.

Env Trigger When set to “Multi”, each keystroke will re-trigger the en-
velopes. When set to “single”, legato notes will not retrig-
ger the envelopes, effectively holding the envelopes on 
the sustain level until all keys are released before a new 
note is triggered.

Note Priority Defines which note is played when multiple keys are held. 
Options are: First, Lowest, Highest, and Last.

Oct Controls the master pitch of Monologue in octave steps. 
Range is +/- 4 octaves.

Master Out Controls the master output level that is sent to the VST 
mixer. Use it to adjust the balance between different pre-
sets. Use the VST mixer channel volume to control or au-
tomate the Monologue master volume.

Keyboard Pressing the “keyboard” button will reveal a six octave 
virtual keyboard. Pressing the “keyboard” button again 
will hide the keyboard and display the master section 
again.

Parameter Description
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Diagrams

Prologue

Mystic
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Spector
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Editing drums
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Introduction
The Drum Editor is similar to the Key Editor (see the chap-
ter “The MIDI editors” in the Nuendo Operation Manual), 
but takes advantage of the fact that with drum parts, each 
key corresponds to a separate drum sound. 

This is the editor to use when you’re editing drum or per-
cussion parts.

Double-clicking a MIDI part in the Project window will open 
the editor selected on the Default Edit Action pop-up menu 
in the Preferences dialog (Event Display-MIDI page). How-
ever, if the option “Edit as Drums when Drum Map is as-
signed” is activated and a drum map is selected for the 
edited track (see “Selecting a drum map for a track” on 
page 52), the Drum Editor will open. This way you can dou-
ble-click other MIDI parts to open the Key Editor (or the 
Score Editor, List or Edit In-Place Editor, depending on 
your preferences) but drum tracks will automatically open in 
the Drum Editor.

How the Key Editor handles drum 
maps
When a drum map is assigned to a MIDI track (see “Wor-
king with drum maps” on page 50), the Key Editor will dis-
play the drum sound names as defined by the drum map.

This allows you to use the Key Editor for drum editing, e.g. 
when editing drum note lengths (which may be necessary 
for some external instruments) or when editing several 
parts, to identify drum events.

The drum sound names are displayed…

…in the info line, 
in the Pitch field.

…in the Mouse 
Note Value field.

…in the event 
(if the zoom factor is high enough).

…when dragging a note.
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The Drum Editor – Overview

The toolbar and info line
These are much the same as the toolbar and info line in the 
Key Editor (see the chapter “The MIDI editors” in the Nu-
endo Operation Manual), with the following differences:

• The Drum Editor has no Pencil tool – instead there is a 
Drumstick tool (for entering and removing notes) and a 
Line tool with various line and curve modes (for drawing 
several notes in one go or editing controller events).

• There are no Scissors and Glue Tube tools in the Drum 
Editor.

• As in the Key Editor, the mouse pointer display in the 
toolbar shows the pitch and position of the pointer, but the 
pitch is shown as a drum sound name rather than a note 
number.

• The Use Global Quantize button allows you to select 
which value should be used when Snap is activated – the 
global quantize value on the toolbar or the individual quan-
tize values for the drum sounds.

• Instead of a Length Quantize pop-up, there is an Insert 
Length pop-up menu.
It is used in much the same way, as described on the following pages.

The drum sound list

A drum sound list for GM Drum Map.

The purpose of the Drum Editor is to edit MIDI tracks where 
each note (pitch) plays a separate sound, as is typically the 
case with a MIDI drum kit. The drum sound list to the left 
lists all drum sounds by name (according to the selected 
drum map or name list – see below), and lets you adjust 
and manipulate the drum sound setup in various ways.

Note:

• The number of columns in the list depends on whether a 
drum map is selected for the track or not.
See “Working with drum maps” on page 50.

• You can reorder the columns by dragging the column 
headings, and resize them by dragging the dividers be-
tween the column headings.

Toolbar

Ruler

Note 
display

Controller 
display

Drum 
sound list

Drum 
Maps
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The note display

The note display of the Drum Editor displays notes as dia-
mond symbols. The vertical position of the notes corres-
ponds to the drum sound list to the left, while the horizontal 
position corresponds to the note’s position in time, just as in 
the Key Editor. Note however, that the diamond symbols 
don’t indicate the length of the notes. This makes sense, 
since drum sounds most often are “one-shot” samples that 
play to their end regardless of the note lengths.

Drum map and name pop-up menus

Below the drum sound list you will find two pop-up menus, 
used for selecting a drum map for the edited track or (if no 
drum map is selected) a list of drum sound names. For an 
explanation of drum maps, see “Working with drum maps” 
on page 50.

Controller display
The controller display in the Drum Editor is the same as in 
the Key Editor. You can add or remove controller lanes via 
the Quick menu, and create and edit events as described 
in the chapter “The MIDI editors” in the Nuendo Operation 
Manual.

• Note that when you select a line in the drum sound list 
(to the left of the event display), only the velocity controller 
events belonging to the note events on this line are dis-
played in the controller display.

• You can select more than one line in the drum sound list 
(using [Shift]/[Ctrl] as usual), which will show all velocity 
controller events for all notes on all selected lines.
This will help you when having to adjust the controller values between 
different drum sounds.

Drum Editor operations
The basic handling (zooming, playback, auditioning, etc.) 
is the same as in the Key Editor (see the chapter “The 
MIDI editors” in the Nuendo Operation Manual). The fol-
lowing sections describe the procedures and features 
specific to the Drum Editor.

Creating and editing notes
The standard way of entering notes in the Drum Editor is 
to click with the Drumstick tool.

When you move the pointer in the note display, its bar position and 
drum sound is indicated in the toolbar, making it easy to find the right 
sound and position.

The position of the created note depends on the following 
factors:

• If Snap is deactivated on the toolbar, the note will ap-
pear exactly where you clicked.
In this mode, notes can be positioned freely.

• If Snap is activated and Use Global Quantize is deacti-
vated on the toolbar, the note will snap to positions ac-
cording to the quantize value set for the sound in the drum 
sound list.
You can set up different quantize values for different drum sounds. You 
may for example want hi-hat notes snap to sixteenth notes, but snare and 
bass drum snap to eighth notes.

• If both Snap and Use Global Quantize are activated, the 
note will snap to positions according to the Quantize set-
ting on the toolbar (next to the Use Global Quantize but-
ton).

The length of the inserted note is determined by the Insert 
Length setting on the toolbar. However, if this is set to 
“Drum-Map Link”, the note will get the length of the quan-
tize value for the drum sound.

You can quickly audition the drum sounds by clicking 
in the leftmost column in the drum sound list.
This plays the corresponding note.
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Clicking with the Drumstick tool on an existing note 
will remove it.
This makes drum pattern editing very quick and intuitive.

Setting velocity values

The notes you enter will get the insert velocity value set in 
the insert velocity field on the toolbar – to speed up things 
you may want to assign key commands to the insert velo-
city options.

Selecting notes

Selecting notes is done by any of the following methods:

• Use the Arrow tool.
The standard selection techniques apply.

• Use the Select submenu on the Quick menu.

• Use the left and right arrow keys on the computer key-
board to step from one note to the next or previous note.
If you press [Shift] and use the arrow keys, the current selection will be 
kept, allowing you to select several notes.

• You can also press [Shift] and double-click on a note to 
select all the following notes for the same drum sound.

• If the option “Auto Select Events under Cursor” is acti-
vated in the Preferences (Editing page), all notes currently 
“touched” by the project cursor are automatically selected.

Moving, duplicating or repeating notes

To move or copy notes in the editor (to other positions or 
other drum sounds), you use the same methods as in the 
Key Editor: click and drag, use the arrow keys or Edit 
menu functions, etc. – see the chapter “The MIDI editors” 
in the Nuendo Operation Manual. To help you identify the 
right notes, the drum sound names as defined in the drum 
map are displayed in the Pitch field on the Drum Editor 
info line and, when dragging notes in the event display, in 
the text fields displayed next to the mouse cursor.

There is one other thing to note:

When you move or copy several selected notes by drag-
ging them and Snap is activated but Use Global Quantize 
is deactivated, the notes will snap to positions according 
to the quantize values for the drum sounds. If the moved/
copied notes have different quantize values, the largest 
value will determine snapping. For example, if you are 
moving two notes, with the quantize values 1/16 and 1/4 
respectively, the notes will snap to quarter notes (1/4).

You can also adjust the position of notes by quantizing 
(see the chapter “The MIDI editors” in the Nuendo Opera-
tion Manual).

Muting notes and drum sounds

You can mute individual notes by clicking or enclosing 
them with the Mute tool or by using the Mute function on 
the Edit menu.

Furthermore, if a drum map is selected (see “Selecting a 
drum map for a track” on page 52), the drum sound list will 
have a Mute column. Click in the Mute column for a drum 
sound to mute that sound. Finally, clicking the Drum Solo 
button will mute all drum sounds other than the selected 
one.

Muted drum sounds

Deleting notes

To delete notes, click on them with the Drumstick or 
Eraser tool or select them and press [Backspace].

Other editing methods
As in the Key Editor, you can edit notes on the info line or 
via MIDI, and enter notes using step input, see the chapter 
“The MIDI editors” in the Nuendo Operation Manual.

! Please note that the mute state for drum sounds is 
part of the drum map, so any other tracks using the 
same map will also be affected. 
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Working with drum maps

Background
A drum kit in a MIDI instrument is most often a set of dif-
ferent drum sounds with each sound placed on a separate 
key (i.e. the different sounds are assigned to different MIDI 
note numbers). One key plays a bass drum sound, another 
a snare and so on.

Unfortunately, different MIDI instruments often use differ-
ent key assignments. This can be troublesome if you have 
made a drum pattern using one MIDI device, and then 
want to try it on another. When you switch device, it is very 
likely that your snare drum becomes a ride cymbal, or your 
hi-hat becomes a tom, etc. – just because the drum 
sounds are distributed differently in the two instruments.

To solve this problem, and simplify several aspects of MIDI 
drum kits (like using drum sounds from different instru-
ments in the same “drum kit”), Nuendo features so-called 
drum maps. A drum map is a list of drum sounds, with a 
number of settings for each sound. When you play back a 
MIDI track for which you have selected a drum map, the 
MIDI notes are “filtered” through the drum map before be-
ing sent to the MIDI instrument. Among other things, the 
map determines which MIDI note number is sent out for 
each drum sound, and so which sound is played in the re-
ceiving MIDI device.

A solution to the problem above would therefore be to set 
up drum maps for all your instruments. When you want to 
try your drum pattern on another instrument, you simply 
switch to the corresponding drum map and your snare 
drum sound will remain a snare drum sound.

Drum map settings
A drum map consists of settings for 128 drum sounds 
(one for each MIDI note number). To get an overview of 
these settings, open the Drum Editor and use the Map 
pop-up menu below the drum sound list to select the “GM 
Map” drum map.

This drum map is set up according to the General MIDI standard. For in-
formation on how to load, create and select other drum maps, see 
“Managing drum maps” on page 52.

Now, take a look at the drum sound list (you may have to 
drag the divider between the list and the note display to 
the right to see all columns). The columns show the set-
tings of the drum map for each sound.

Here’s a brief description (details follow below):

Column Description

Pitch The actual note number of the drum sound. This is what 
links notes on a MIDI track to drum sounds. For example, 
with the above drum map, all MIDI notes with the pitch 
C1 would be mapped to the Bass Drum sound.

Instrument The name of the drum sound.

Quantize This value is used when entering and editing notes as de-
scribed in the sections “Creating and editing notes” on 
page 48 and “Moving, duplicating or repeating notes” on 
page 49.

Mute Allows you to mute a drum sound, excluding it from play-
back. See “Muting notes and drum sounds” on page 49.
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All settings in a drum map (except the Pitch) can be 
changed directly in the drum sound list or in the Drum 
Map Setup dialog (see “The Drum Map Setup dialog” on 
page 52).
Note that the changes you make will affect all tracks that use the drum 
map.

About Pitch, I-note and O-note
This can be a somewhat confusing area, but once you’ve 
grasped how it all works it’s not very complicated. Going 
through the following “theory” will help you make the most 
out of the drum map concept – especially if you want to 
create your own drum maps.

As mentioned earlier, a drum map is a kind of “filter”, 
transforming notes according to the settings in the map. It 
does this transformation twice; once when it receives an 
incoming note (i.e. when you play a note on your MIDI 
controller) and once when a note is sent from the program 
to the MIDI sound device.

In the following example, we have modified the drum map, 
so that the Bass Drum sound has different Pitch, I-note 
and O-note values.

I-notes (input notes)

Let’s look at what happens on input: When you play a note 
on your MIDI instrument, the program will look for this note 
number among the I-notes in the drum map. In our case, if 
you play the note A1, the program will find that this is the I-
note of the Bass Drum sound.

This is where the first transformation happens: the note 
will get a new note number according to the Pitch setting 
for the drum sound. In our case, the note will be trans-
formed to a C1 note, because that is the pitch of the Bass 
Drum sound. If you record the note, it will be recorded as a 
C1 note.

O-notes (output notes)

The next step is the output. This is what happens when 
you play back the recorded note, or when the note you 
play is sent back out to a MIDI instrument in real time 
(MIDI Thru):

The program checks the drum map and finds the drum 
sound with the pitch of the note. In our case, this is a C1 
note and the drum sound is the Bass Drum. Before the 
note is sent to the MIDI output, the second transformation 
takes place: the note number is changed to that of the O-
note for the sound. In our example, the note sent to the 
MIDI instrument will be a B0 note.

Usage

So, what’s the point of all this? Again, the purposes are 
different for I-notes and O-notes:

Changing the I-note settings allows you to choose 
which keys will play which drum sounds, when playing or 
recording from a MIDI instrument.
For example, you may want to place some drum sounds near each other 
on the keyboard so that they can be easily played together, move sounds 
so that the most important sounds can be played from a short keyboard, 
play a sound from a black key instead of a white, and so on.
If you never play your drum parts from a MIDI controller (but draw them in 
the editor) you don’t need to care about the I-note setting.

The O-note settings let you set things up so that the 
“Bass Drum” sound really plays a bass drum.
If you’re using a MIDI instrument in which the bass drum sound is on the 
C2 key, you set the O-note for the Bass Drum sound to C2. When you 
switch to another instrument (in which the bass drum is on C1) you want 
the Bass Drum O-note set to C1. Once you have set up drum maps for 
all your MIDI instruments, you don’t have to care about this anymore – 
you just select another drum map when you want to use another MIDI in-
strument for drum sounds.

I-note This is the “input note” for the drum sound. When this 
MIDI note is sent into Nuendo, (i.e. played by you), the 
note will be mapped to the corresponding drum sound 
(and automatically transposed according to the Pitch set-
ting for the sound).

O-note This is the “output note”, i.e. the MIDI note number that is 
sent out every time the drum sound is played back. 

Channel The drum sound will be played back on this MIDI channel.

Output The drum sound will be played back on this MIDI output. 
If you set this to “Default”, the MIDI output selected for 
the track will be used.

Column Description
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The channel and output settings
You can set separate MIDI channels and/or MIDI outputs 
for each sound in a drum map. The following rules apply:

• When a drum map is selected for a track, the MIDI chan-
nel settings in the drum map override the MIDI channel set-
ting for the track.
In other words, the MIDI channel setting you make in the Track list or In-
spector for the track is normally disregarded. If you want a drum sound to 
use the channel of the track, set it to channel “Any” in the drum map.

• If the MIDI output is set to “default” for a sound in a 
drum map, the sound will use the MIDI output selected for 
the track.
Selecting any other option allows you to direct the sound to a specific 
MIDI output.

By making specific MIDI channel and output settings for 
all sounds in a drum map, you can direct your drum tracks 
directly to another MIDI instrument simply by selecting an-
other drum map – you don’t need to make any channel or 
output changes for the actual track.

To select the same MIDI channel for all sounds in a 
drum map, click the Channel column, press [Ctrl]/[Com-
mand] and select the desired channel.
All drum sounds will be set to this MIDI channel. The same procedure 
can be used for selecting the same MIDI output for all sounds as well.

It can also be useful to select different channels and/or out-
puts for different sounds. This allows you to construct drum 
kits with sounds from several different MIDI devices, etc.

Managing drum maps

Selecting a drum map for a track

To select a drum map for a MIDI track, use the Map pop-
up menu in the Inspector or in the Drum Editor:

Selecting “No Drum Map” turns off the drum map func-
tionality in the Drum Editor. Even if you don’t use a drum 
map, you can still separate sounds by name using a name 
list (see “Using drum name lists” on page 53).

The Drum Map Setup dialog

To set up and manage your drum maps, select Drum Map 
Setup from the Map pop-up menus or the MIDI menu. This 
opens the following dialog:

The Drum Map setup dialog.

This is where you load, create, modify and save drum 
maps. The list to the left shows the currently loaded drum 
maps; selecting a drum map in the list displays its sounds 
and settings to the right.

The settings for the drum sounds are exactly the same 
as in the Drum Editor (see “Drum map settings” on page 
50).
As in the Drum Editor, you can click the leftmost column to audition a 
drum sound. Note: if you audition a sound in the Drum Map Setup dialog, 
and the sound is set to MIDI output “Default”, the output selected on the 
Output pop-up menu in the lower left corner will be used. When audi-
tioning a Default output sound in the Drum Editor, the MIDI output se-
lected for the track will be used, as described in section “The channel 
and output settings” on page 52.

! Initially, the Map pop-up menu will only contain one 
map: “GM Map”. However, you will find a number of 
drum maps included on the program DVD – how to 
load these is described below.
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Open the Functions pop-up menu in the top left corner to 
open a list of available functionalities:

Drum maps are saved with the project files. If you have 
created or modified a drum map, you should use the Save 
function to store it as a separate XML file, available for 
loading into other projects.
If you always want to have the same drum map(s) included in your projects, 
you may want to load these into the template – see the chapter “File Han-
dling” in the Nuendo Operation Manual.

O-Note Conversion

This function on the MIDI menu goes through the selected 
MIDI part(s) and sets the actual pitch of each note ac-
cording to its O-note setting. This is useful if you want to 
convert a track to a “regular” MIDI track (with no drum 
map) and still have the notes play back the correct drum 
sound. A typical application is if you want to export your 
MIDI recording as a standard MIDI file – by first perform-
ing an O-Note Conversion you make sure that your drum 
tracks play back as they should when they are exported. 

Use Head Pairs and Edit in Scores

These options are explained in detail in the section “Set-
ting up the drum map” on page 186.

Using drum name lists
Even if no drum map is selected for the edited MIDI track, 
you can still use the Drum Editor if needed. As previously 
mentioned, the drum sound list will then only have four col-
umns: Audition, Pitch, Instrument (drum sound name) and 
Quantize. There will be no I-note and O-note functionality.

In this mode, the names shown in the Instrument column 
depend on the selection on the Names pop-up menu, just 
below the Map pop-up in the Drum Editor.

The options on this pop-up menu are the currently loaded 
drum maps plus a “GM Default” item which is always avail-
able. This means you can use the drum sound names in any 
loaded drum map without using I-notes and O-notes, if you 
want to.

Button Description

New Map Click this to add a new drum map to the project. The 
drum sounds will be named “Sound 1, Sound 2” and so 
on, and have all parameters set to default values. The 
map will be named “Empty Map”, but you can rename it 
by clicking and typing in the list.

New Copy Adds a copy of the currently selected drum map. This is 
probably the quickest way to create a new drum map: se-
lect the map that is similar to what you want, create a 
copy, change the desired drum sound settings and re-
name the map in the list.

Remove Removes the selected drum map from the project.

Load Opens a file dialog, allowing you to load drum maps from 
disk. On the Nuendo DVD you will find a number of drum 
maps for different MIDI instruments – use this function to 
load the desired maps into your project.

Save Opens a file dialog for saving the drum map selected in 
the list. If you have created or modified a drum map, you 
should use this function to save it as a file on disk – this 
allows you to load it into other projects. Drum map files 
have the extension “.drm”.

Edit head pairs Allows you to customize the note pairs, see “Customizing 
note head pairs” on page 187.

Init Display 
Notes

Allows you to reset the Display Notes entry to the original 
setting, i.e. the Pitch entry.

Close Closes the dialog.
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About this chapter
In this chapter you will learn:

• How the Score Editor and MIDI data relate.
• What display quantize is and how it works.

Welcome!
Welcome to scoring in Nuendo! The Score Editor has 
been created to allow you to get any possible piece of 
music displayed as a score, complete with all the neces-
sary symbols and formatting. It allows you to extract parts 
out of a full orchestra score, to add lyrics and comments, 
create lead sheets, score for drums, create tablature, etc. 
In other words: just about any type of notation you could 
ever desire!

There are a few basic principles to how the Score Editor 
works, which you have to understand to make full use of it. 
So please bear with us during this chapter, we’ll try to be 
as concise as possible.

How the Score Editor operates
The Score Editor does the following:

• Reads the MIDI notes in the MIDI parts.
• Looks at the settings you have made.
• Decides how the MIDI notes should be displayed according to 

the settings.

The Score Editor takes MIDI data and settings as input and produces a 
score as output.

The Score Editor does all this in real time. If you change 
some of the MIDI data (for example by moving or shorten-
ing a note) this is immediately reflected in the score. If you 
change some of the settings (for example the time signa-
ture or key signature) this is also immediately apparent.

You should not think of the Score Editor as a drawing pro-
gram, but rather as an “interpreter” of MIDI data.

MIDI notes vs. score notes
MIDI tracks in Nuendo hold MIDI notes and other MIDI 
data. As you may know, a MIDI note in Nuendo is only de-
fined by its position, length, pitch and velocity. This is not 
nearly enough information to decide how the note should 
be displayed in a score. The program needs to know more: 
What type of instrument are we talking about, Drums? Pi-
ano? What key is the piece in? What is the basic rhythm? 
How should the notes be grouped under beams? etc. You 
provide this information by making settings and working 
with the tools available in the Score Editor.

An example of the MIDI/score relationship
When Nuendo stores a MIDI note’s position, it makes the 
measurement in an absolute value, called ticks. There are 
480 ticks to a quarter note. Have a look at the example be-
low.

A quarter note at the end of a 4/4 measure.

The note is on the fourth beat of the measure. Now, let’s 
say you change the time signature to 3/4. This shortens the 
length of a “measure” to only three quarter notes – 1440 
ticks. Suddenly our quarter note is in the next measure:

The same note in 3/4.

Why? Since you are not changing the MIDI data in the 
track/part (that would ruin your recording!) by changing 
the time signature, the note is still at the same absolute 
position. It’s just that now each “measure” is shorter, 
which effectively moves the note in the score.

What we are trying to get across here is that the Score 
Editor is an “interpreter” of the MIDI data. It follows rules 
that you set up by making settings in dialogs, on menus, 
etc. And this interpretation is “dynamic”, or in other words, 
it is constantly updated whenever the data (the MIDI 
notes) or the rules (the score settings) change.

MIDI data

Score Editor Score display

Score settings
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Display quantize
Let’s say you used the Project window to record a figure 
with some staccato eighth notes. When you open the 
Score Editor, these notes are displayed like this:

This doesn’t look anything like what you intended. Let’s 
start with the timing – obviously, you were off at a couple 
of places (the third, fourth and last note all seem to be a 
32nd note late). You can solve this by quantizing the fig-
ure, but this would make the passage sound too “stiff”, and 
not fit in the musical context. To resolve this problem the 
Score Editor employs something called “display quantize”.

Display quantize is a setting which is used to tell the pro-
gram two things:

• How precise the Score Editor should be when display-
ing the note positions.

• The smallest note values (lengths) you want displayed in 
the score.

In the example above, the display quantize value seems to 
be set to 32nd notes (or a smaller note value).

Let’s say we change the display quantize value to six-
teenth notes in the example:

With display quantize set to sixteenth notes.

OK, now the timing looks right, but the notes still don’t 
look like what you intended. Maybe you can understand 
that from a computer’s point of view, you did play sixteenth 
notes, which is why there are a lot of pauses. But that’s 
not how you meant it. You still want the track to play back 
short notes, because it is a staccato part, but you want 
something else “displayed”. Try setting the display quan-
tize value to eighth notes instead:

With display quantize set to eighth notes.

Now we have eighth notes, as we wanted. All we have to 
do now is to add staccato articulation which can be done 
with one simple mouse click using the Pencil tool (see the 
chapter “Working with symbols” on page 126).

How did this work? By setting the display quantize value 
to eighth notes, you give the program two instructions, 
that would sound something like this in English: “Display 
all notes as if they were on exact eighth note positions, re-
gardless of their actual positions” and “Don’t display any 
notes smaller than eighth notes, regardless of how short 
they are”. Please note that we used the word “display”, 
which leads us to one of the most important messages of 
this chapter:

Choose your display quantize values with care
As explained above, the display quantize value for notes 
puts a restriction on the “smallest” note value that can be 
displayed. Let’s see what happens if we set it to quarter 
notes:

With display quantize set to quarter notes.

Oops, this doesn’t look too good. Well of course it 
doesn’t! We have now instructed the program that the 
“smallest” note that occurs in the piece is a quarter note. 
We have explicitly told it that there are no eighth notes, no 
sixteenths, etc. So when the program draws the score on 
screen (and on paper) it quantizes the display of all our 
eighth notes to quarter note positions, which makes it look 

! Setting a display quantize value does not alter the 
MIDI notes of your recording in any way, as regular 
quantizing does. It only affects how the notes are 
displayed in the Score Editor (and nowhere else)!
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like above. But again, please note that when you hit Play, 
the passage will still play as it originally did. The display 
quantize setting only affects the score image of the re-
cording. One last important note:

Using Rests display quantize
Above we used display quantize for notes. There is a sim-
ilar setting called “Rests” display quantize which is used 
to set the smallest rest to be displayed. Often, this setting 
is very effective:

Let’s start with the following note example:

As you see, the first note appears one sixteenth note late. 
If we change the display quantize value for notes to eighth 
notes, the score will be displayed like this:

With Notes display quantize set to eighth notes.

Unfortunately, this moves the first note to the same posi-
tion as the second, since sixteenth note positions aren’t 
allowed. We can solve this by inserting extra display quan-
tize values within the bar with the Display Quantize tool 
(see “Inserting display quantize changes” on page 78), 
but there is a much easier way: Change the display quan-
tize value for notes back to sixteenths, but set the display 
quantize value for rests to eighth notes! This tells the pro-
gram not to display any rests smaller than eighth notes, 
except when necessary. The result looks like this:

With Notes display quantize set to sixteenth notes, but Rests display 
quantize set to eighth notes.

How did this work? Well, you instructed the program not 
to display any rests smaller than eighth notes, except 
when “necessary”. Since the first note appeared on the 
second sixteenth note position, it was necessary to put a 
sixteenth rest at the beginning of the figure. All other rests, 
however, can be hidden by displaying the notes as eighth 
notes, and were therefore not “necessary”.

This leads us to the following general guidelines:

Set the Notes display quantize value according to the 
“smallest note position” you want to be shown in the score.
For example, if you have notes on odd sixteenth note positions, the Notes 
display quantize value should be set to sixteenth notes.

Set the Rests display quantize value according to the 
smallest note value (length) you want to be displayed for a 
single note, positioned on a beat.

A common setting would be to have Notes display quan-
tize set to 16 (sixteenth notes) and Rests display quantize 
set to 4 (quarter notes).

Handling exceptions
Unfortunately, the guidelines above won’t work perfectly in 
every situation. You may for example have a mix of straight 
notes and tuplets of different types, or you may wish to 
display equally long notes with different note values de-
pending on the context. There are several methods you 
can try:

Automatic display quantize

If your score contains both straight notes and triplets, you 
can use automatic display quantize. When this is acti-
vated, Nuendo tries to “understand” whether the notes 
should be display quantized to straight notes or triplets. 
See “If your music contains mixed straight notes and trip-
lets” on page 74.

Using the Display Quantize tool

With the “Q” tool, you can insert new display quantize val-
ues anywhere in the score. Inserted display quantize val-
ues affect the staff from the insertion point onwards. See 
“Inserting display quantize changes” on page 78.

! Even if you manually enter notes in the score using 
perfect note values, it is very important that you have 
your display quantize settings right! These values are 
not just used for MIDI recordings! If you for example 
set the display quantize value for notes to quarter 
notes and start clicking in eighth notes, you will get 
eighth notes in the track (as MIDI data), but still only 
quarter notes in the display!
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Permanent alteration of MIDI data

As a last resort, you can resize, quantize or move the ac-
tual note events. However, this would result in the music 
not playing back like it originally did. Often it is possible to 
get the score to look the way you want without altering any 
MIDI data.

Summary
This closes our discussion on the basic concept of display 
quantizing. There are a number of other special situations 
which require more advanced techniques, which you will 
find out about in the next chapters. You will also read 
about other settings which work along the same lines as 
display quantize but each with its own application. These 
are called “interpretation options”.

Entering notes by hand vs. recording 
notes
Sometimes you will enter and edit notes by hand (or rather 
using the mouse and/or the computer keyboard) and at 
other times you will record them from a MIDI keyboard. 
Most of the time, you will do a combination of both. In the 
chapter “Transcribing MIDI recordings” on page 71 you 
will find out how to make a recorded score as legible as 
possible without performing any permanent changes to 
the MIDI data. The chapter “Entering and editing notes” 
on page 81 shows you how to enter and edit notes using 
the mouse. In real life, even if you have recorded the piece 
perfectly, you will often have to do some permanent edit-
ing to your recording before printing. Which leads to this 
conclusion:

! You will have to read both chapters in order to un-
derstand how to produce legible scores!
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About this chapter
In this chapter you will learn:

• How to open the Score Editor.
• How to switch between Page Mode and Edit Mode.
• How to set up the page size and margins.
• How to hide and show the symbol Inspector, the toolbar and 

the extended toolbar.
• How to set up the ruler.
• How to set a zoom factor.
• How to make initial settings for key, clef and time signature.

Preparations
1. In the Project window, create a MIDI track for each in-
strument.
You can prepare a piano (split) staff from a single track, i.e. there’s no 
need to create one track for the bass clef and one for the treble clef.

2. Name each track after the instrument.
This name can later be used in the score if you like.

3. Record into the tracks or create empty parts on all 
tracks.
You can make very long parts that cover the entire project, or you can 
start out with shorter parts to begin with. If you choose the latter option, 
you can always go back later and add new parts or copy existing parts.

Opening the Score Editor

Editing one or several parts
To open one or several parts in the Score Editor, select 
the parts (on the same or on different tracks) and select 
“Open Score Editor” from the MIDI menu or “Open Selec-
tion” from the Scores menu. The default key command for 
this is [Ctrl]/[Command]-[R]. 

• You can also select the Score Editor as your default ed-
itor, allowing you to open it by double-clicking parts.
This is done with the Default Edit Action pop-up menu in the Preferences 
dialog (Event Display–MIDI page).

Editing whole tracks
When preparing a score for printing, you probably want to 
open whole MIDI tracks in the Score Editor. To do this, se-
lect the track(s) in the track list and make sure no parts are 
selected – then open the Score Editor as described above.

Editing parts on different tracks
If you have selected parts on two or more tracks (or sev-
eral entire tracks – no parts) and open the Score Editor, 
you will get one staff for each track (although you can split 
a staff in two, e.g. when scoring for piano). Think of the 
Project window as an overview of your entire score and 
the tracks as representing one instrument each.

Editing predefined combinations of tracks
In the section “Layout operations” on page 165, you will 
find out how to open the Score Editor for a certain combi-
nation of tracks that you edited before.

Quickly switching between display of parts or 
tracks
When the option “Double-click on staff flips between full 
score/part” is activated in the Preferences dialog (Scores-
Editing page), double-clicking on the blue rectangle to the 
left of a staff will switch between display of either the 
whole score or the current voice.

The project cursor
The project cursor appears as a vertical line across the 
staff. When you open the Score Editor, the view is auto-
matically scrolled so that the project cursor is visible in the 
window. This means you don’t always see the beginning 
of the edited part when you first open the Score Editor.

• Hold down [Alt]/[Option] and [Shift] and click anywhere 
in the score to move the project cursor there.
This is handy when the project cursor isn’t visible. This is not possible if 
Keyboard Input mode is activated, see “Entering notes using the compu-
ter keyboard” on page 84.
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Page Mode
When you are preparing a score for printout, you should 
set the Score Editor to Page Mode. This is done by se-
lecting Page Mode from the Scores menu. When Page 
Mode is activated, a check mark will appear next to this 
menu option.

Page Mode is activated.

In Edit mode, the window switches to display one page at 
a time, as it will appear on printout.

Page Mode vs. Edit Mode
When Page Mode is not activated, the Score Editor is in 
Edit Mode. All you can do in Edit Mode, you can also do in 
Page Mode. But Page Mode offers lots of additional fea-
tures which are directly related to how the score is dis-
played and printed.

Using the scroll bars in Page Mode

In Page Mode, the scroll bars are used to scroll the image 
of the page inside the window.

Moving between pages in Page Mode

If your score takes up more than one page, you can skip 
between the pages in two ways:

• By using the page number indicator in the lower right 
corner.
The number can be adjusted using the standard value editing tech-
niques.

The Page Number indicator – adjust it to move to another page.

• By assigning key commands to the functions “Move to 
Next Page” and “Move to Previous Page” in the Key Com-
mands dialog (Scores category).

Also, if Autoscroll is activated on the toolbar, the score 
display will follow the project cursor position. This way you 
can scroll the score by using fast forward or rewind.

Editing individual parts in Page Mode

When you view a single part in Page Mode, the bars be-
fore and after the part will normally be shown as empty 
measures in the Score editor. This is to preserve the lay-
out of the track, i.e. the spacing between staves and bar 
lines, number of bars per staff etc.

If you want to view and print a single part, without any sur-
rounding empty bars, activate the option “Unlock Layout 
when editing single parts” in the Preferences dialog 
(Scores-Editing page). Note, however, that if you adjust 
the layout when editing the part in this mode, this will 
erase the layout for the whole track!

Playing back and recording
You can play back and record MIDI in the Score Editor us-
ing the standard transport commands, just like in the other 
MIDI editors. See the chapter “The MIDI editors” in the 
Nuendo Operation Manual.

! This section of the manual assumes you are in Page 
Mode. It will be mentioned explicitly if something in 
this text specifically relates to Edit Mode.
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Changing the Zoom factor
There are two ways to change the zoom in Page Mode: by 
setting a zoom factor on the zoom pop-up menu or by us-
ing the Zoom tool (magnifying glass).

Using the zoom pop-up menu
Above the vertical scrollbar to the right you will find a pop-
up allowing you to set the zoom factor. 

The zoom pop-up.

By zooming in you will be able to make detailed adjust-
ments to symbols, etc. By zooming out you will get a bet-
ter overview.

• If you select “Fit Page”, the zoom factor will be adjusted 
according to the window size so the whole page is visible.

• If you select “Fit Width”, the zoom factor will be ad-
justed according to the window width so the full width of 
the page is visible.

This pop-up menu can also be opened by right-clicking in 
the ruler.

Using the Zoom tool
The Zoom tool in the Score Editor works much like in the 
Project window:

• Click once with the Zoom tool to zoom in one step.

• Hold down [Alt]/[Option] and click once with the Zoom 
tool to zoom out one step.

• Drag a rectangle with the Zoom tool to set a custom 
zoom factor.
The section encompassed by the rectangle is zoomed to fill the window.

The active staff
One thing to note when you are working with multiple 
staves is the “active” staff. Only one staff at a time can be 
active, and is indicated by a blue rectangle to the left of 
the clef symbol.

To make a staff active, click anywhere in it.
By default, you can also use the up and down arrow keys on the com-
puter keyboard to step between staves.

Making page setup settings
Before preparing the score for printout, you have to make 
some page settings for your project. This does not have to 
be the first thing you do, but it’s a good working habit, be-
cause it will also affect the on-screen display of the score.

1. On the File menu, select Page Setup.
The Page Setup dialog appears. This is the regular operation system 
Page Setup dialog, described in detail in your system’s documentation. 
The only things that Nuendo adds to this are the margin settings.

2. Select the preferred printer, paper size, orientation, etc.

3. If you need to, change the margins by setting the left, 
right, top and bottom settings.

• To make the settings permanent, save the project.
If you want new projects to always start with certain page setup settings, 
you can create project templates with these, see the chapter “File Han-
dling” in the Nuendo Operation Manual.

This staff is active.
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Designing your work space
Some of the areas in the Score editor can be hidden. Ex-
actly which areas to show/hide depends e.g. on what kind 
of project you are working on, and how big a monitor you 
have.

These areas can be hidden or displayed.

• You can configure the toolbar, the info line and the In-
spector in their own setup dialogs. Here you can specify 
exactly which buttons, which properties for a particular 
object, or which symbol tabs you wish to see.
The handling is the same for the different Setup dialogs. For a detailed 
description of the Inspector Setup dialog, see “The symbol Inspector Se-
tup dialog” on page 128.

The info line
The info line displays information about the selected note. 
It can be hidden/displayed by clicking the “Show Info” 
button on the toolbar, or by using a key command, by de-
fault [Ctrl]/[Command]-[I].

The extended toolbar
The extended toolbar can be displayed/hidden by clicking 
the “Show Tool Strip” button on the main toolbar.

The display filter bar
This area contains checkboxes determining which indica-
tors, handles and other non-printed elements should be 
shown in the score. You can show/hide the filter bar by 
clicking the “Show Filter View” button on the toolbar.

The ruler
In the Score Editor there are no meter/time position rulers 
as in the other editors. Instead, there are horizontal and 
vertical “graphic rulers” in Page Mode. These help you in 
positioning symbols and graphical objects in the score.

• To specify which units should be used on the rulers, 
open the Zoom pop-up menu and select one of the options.
You can choose between points, inches or centimeters.

• To hide the rulers, select “Off” from the pop-up menu.

Inspector

Extended toolbar

Info line

Display filter bar

Ruler 
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The symbols Inspector
The symbol buttons, which are used to add symbols to the 
score, can be found in the Score Editor Inspector to the 
left of the score display.

• To display the Inspector, click the Show Symbols but-
ton on the toolbar. 

• You can open Symbol Inspector tabs as palettes by 
right-clicking on one of the buttons and selecting “Open 
as Palette” from the context menu.
You can move symbol palettes around on the screen by clicking and 
dragging their title bars. 

Right-clicking in a symbol palette brings up a pop-up 
menu.

• Select “Toggle” to switch between a vertical or a horizontal 
palette.

• Select one of the symbol palettes on the pop-up menu to 
bring up that palette and replace the current.

• Hold down [Ctrl]/[Command] and select a palette from the 
pop-up menu to open the selected palette in a new window 
(without closing the existing one).

• Click the close button to close a symbol palette.

How to work with symbols is explained in detail in the 
chapter “Working with symbols” on page 126.

The Position Info window
To help you further when positioning objects in the score, 
Page Mode has a special Position Info window, in which 
you can view and adjust object positions numerically, in 
the unit selected for the ruler. To display the Position Info 
window, click in the ruler.

Showing and hiding “invisible” elements
Some of the elements in the score will not be printed, but 
rather serve as indicators for layout changes, handles, etc. 
These elements can be hidden or shown in any combina-
tion by using the display filter bar.

• If the filter bar isn’t shown, click the Show Filter View 
button on the toolbar.

The checkboxes on the filter bar determine whether an 
element should be visible (checkbox ticked) or not. The 
following options are available:

Option Description

Bar Handles Displays the bar handles, used for copying bars (see 
“Moving and duplicating with the bar handles” on page 
141).

Hidden Notes Displays any notes you might have hidden (see “Hiding/
showing objects” on page 174).

Hide Displays markers in the score for each hidden element 
(notes excepted, see “Hiding/showing objects” on page 
174).

Quantize Displays markers in the score where you have made dis-
play quantize “exceptions” (see “Inserting display quantize 
changes” on page 78).

Layout tool Displays markers in the score where you have made ad-
justments with the Layout tool (see “Graphic moving of 
notes” on page 122).

Grouping Displays markers in the score where you have made 
beam groupings (see “Grouping” on page 116).

Cutflag Displays markers in the score where you have inserted 
cutflag events (see “The Cut Notes tool” on page 121).
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About the Score Editor context 
menus
Many functions and settings of the Score Editor can be 
accessed via context menus, opened by right-clicking on 
certain elements of the score. Right-clicking on a note will 
for example open the note context menu, listing note-re-
lated functions.

• If you right-click on an empty area of the score, the 
Quick menu opens. This lists all available tools (allowing 
you to quickly switch between tools) and it contains many 
functions of the main menus.

About dialogs in the Score Editor
There are two types of dialogs available in the Score 
Editor:

• Non-modal dialogs can remain open while you continue 
working in the score.
In a non-modal dialog, you click the Apply button to apply the settings in 
the dialog to the selected objects in the score. This means you can se-
lect different elements in the score and change their settings, without 
having to close the dialog in between.
The dialog is closed by clicking the standard close button in the window 
title bar. The Score Settings dialog is an example for a non-modal dialog.

• Regular dialogs have an OK button instead of an Apply 
button.
Clicking OK applies the settings you’ve made and closes the dialog. You 
cannot continue working in the score (or select other objects) until you 
close the dialog.

If the option “Apply closes Property Windows” is acti-
vated in the Preferences dialog (Scores-Editing page), 
clicking the Apply button in a non-modal dialog closes the 
dialog.
In other words, this makes a non-modal dialog work a bit more like a reg-
ular dialog.

Setting key, clef and time signature
When preparing to enter notes into a score, you will prob-
ably want to start out by setting the desired key, clef and 
time signature for the staff. The text below assumes you 
are working on one track only. If you have multiple staves, 
you either make this setting independently for each staff or 
for all staves at once. See “Staff settings” on page 73.

Normally, all these symbols appear at the beginning of 
each staff. However, you can control this by using the Real 
Book option (see “Real Book” on page 173) and by hiding 
objects (see “Hiding/showing objects” on page 174).

When entering or editing keys, there is one important 
thing to note:

Using the symbol Inspector to set the initial 
key, clef and time signature
1. Click the Show Symbols button in the Score Editor 
tool bar to open the symbol Inspector.

2. Select the Keys tab and click on the symbol for the key 
that you wish to use.
The Pencil tool is now selected.

3. Click anywhere in the first bar of the staff to set the key 
for the track.

4. Open the Clefs tab of the Inspector and click on the 
symbol for the clef that you wish to use in your score.

5. Click anywhere in the first bar of the staff to set the 
clef for this track.

Split Rests Displays markers in the score wherever you have split 
multiple rests (see “Splitting multi-rests” on page 176).

Stems/Beams Displays markers in the score where you have made any 
stem or beam adjustments (see “Setting stem direction” 
on page 111 and “Manual adjustment of beams” on page 
120).

Option Description

! On the Score Settings–Project page, on the Nota-
tion Style subpage (Keys category) you will find the 
option “Key Changes for the entire Project” (acti-
vated by default). When this option is activated, all 
changes made to the key will always affect every 
staff in the project, i.e. it is not possible to define dif-
ferent keys for different staves.
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6. Open the Time Sign tab of the Inspector and click on 
the symbol for the time signature value that you wish to use.
If you cannot find the desired time signature, you can use the Edit Time 
Signature dialog (see below).

The settings you have made so far are valid for the entire 
track. If you wish to further edit these settings, or if you 
need different settings for different bars of your track, pro-
ceed as described in the next section.

Editing the time signature
1. Double-click on the time signature symbol at the be-
ginning of the staff.
A dialog opens.

The Edit Time Signature dialog with a 4/4 signature.

2. If the project is in 4/4 or 2/2, you can select common 
time/cut time directly by clicking one of the two symbols 
on the right.
This will set the time signature to 4/4 or 2/2, respectively and will also in-
sert a common/cut time symbol on the staff.

3. If the project is in any other time, set the numerator 
and denominator above and below the line, respectively.
The numerator can consist of several numbers for composite time signa-
tures. However, if the project is in a simple time signature you only need 
to fill in the first number above the line. The more advanced options are 
described below.

• The “Pickup Bar” option is described in the section “By 
using the Pickup Bar feature” on page 177.

4. Click OK or press [Return].

If you need to enter half a bar somewhere (for example) 
you have to make a time signature change (e.g. from 4/4 
to 2/4 and back again). See “Inserting and editing clefs, 
keys or time signatures” on page 93 to find out how to en-
ter time signature changes.

Composite time signatures and the For Grouping Only 
option

For composite signatures, the numerator can be made up 
of up to four groups. For example, “4+4+3+/” on the up-
per line and 8 on the lower means the time signature is 
11/8.

The reason for dividing the numerator into several num-
bers is to get beaming and tied notes displayed correctly 
automatically. This does not affect the metronome or any-
thing else, only beams and ties. For more information on 
beaming, see “Handling beaming” on page 116.

If “For Grouping Only” is not activated, the numerator will 
show all the numbers entered. If it is activated, it will show 
the sum of the numbers entered, as for “simple” time sig-
natures.

“For Grouping Only” off and on.

Note that Nuendo tries to preserve the denominator when 
you insert a composite signature with “For Grouping Only” 
activated. This means that if you have a 4/4 time signature, 
and change it to a composite value (3+3+2 eighths for ex-
ample), the time signature will still be displayed as 4/4 in-
stead of 8/8.

Setting the time signature from the Transport panel

You can also set the time signature directly on the Trans-
port panel. Please note the following:

• The time signature section of the Transport panel always dis-
plays the first time signature event on the tempo track. When 
you change this value you are in fact editing the first time sig-
nature event on the tempo track.

• You cannot create composite time signatures from the Trans-
port panel.

! All tracks share the time signature! In other words, 
when you set the time signature, you do this for all 
tracks in the project.

The time signature on the Transport panel.
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Setting the time signature by using the tempo track

You can also add, edit and delete time signatures using 
the tempo track (see the chapter “Working with the Tempo 
track” in the Nuendo Operation Manual). Please note:

• The score always shows the time signature events on the 
tempo track, regardless of whether or not the Tempo button is 
activated. Likewise, any time signatures you create in the 
Score Editor will be shown in the tempo track.

• You cannot create composite time signatures from the tempo 
track.

Editing the clef

In the clef context menu

When you right-click on a clef symbol, a context menu 
with a list of all available clefs is opened. This menu also 
contains the following options:

• Display Clef Changes as Small Symbols
If you activate this option and insert a clef change in the score, the clef 
will be displayed with a smaller symbol.

• Warnings for new Clefs at Line Breaks
If you activate this option and insert a new clef at a line break, the Clef 
change symbol will be inserted in the last bar before the staff break. 
When this is deactivated, the symbol will be inserted in the first bar of the 
next staff line.

• Hide
If you select this function, the clef will be hidden.

• Properties
If you select this function, the Edit Clef dialog is opened.

In the Edit clef dialog

1. Double-click on the current clef.
A dialog appears.

Double-clicking on a clef brings up the Edit Clef dialog.

2. Use the scroll bar to select a clef.

3. Repeat the steps above for all staves in the system.

On the Score Settings–Staff page

1. Click on a staff to make it the active staff.

2. On the Scores menu, select “Settings…” to open the 
Score Settings dialog. Click the Staff button at the top to 
open the Staff page–Main tab, showing the current set-
tings for the active staff.
You can also double-click to the left of a staff to make it active and bring 
up the Score Settings dialog in one go (if this doesn’t work, the option 
“Double-click on staff flips between full score/part” in the Preferences 
dialog (Scores-Editing page) may be activated – see “Quickly switching 
between display of parts or tracks” on page 60).

3. In the Clef/Key section, use the scroll bar on the left to 
select one of the available clefs.
You will find out how to insert clef changes in the section “Inserting and 
editing clefs, keys or time signatures” on page 93.

4. Click Apply.

• You can select another staff in the score and make set-
tings for it without having to close the Score Settings dia-
log first.

! This does not work if Auto Clef is activated on the 
Score Settings–Staff page, see below.
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In a split system

If you have a split system (see “Split (piano) staves” on 
page 92 and “Strategies: How many voices do I need?” 
on page 99) you can of course set different clefs for the 
upper and lower staff.

1. Open the Score Settings–Staff page.

2. Select a clef for the upper staff.

3. Activate the “Lower Staff” check box.

4. Set a clef for the lower staff.

Using Auto Clef

Auto Clef activated on the Score Settings–Staff page.

On the Score Settings–Staff page you will also find the 
option Auto Clef. If this is activated, the program will auto-
matically select a treble clef or a bass clef for the staff, de-
pending on the range of the notes in the part.

Editing the key
When editing keys, there is one important thing to note:

Therefore, when you want to edit the key, decide if you 
want the key change to apply to the entire project, or if you 
want to use different keys on different staves:

• If the key set at the beginning of the track is to be used 
on all staves, and if any subsequent key changes are also 
valid for all staves, then leave the option “Key Changes for 
the entire Project” activated.

• If you want to use more than one key on different staves, 
make sure that the option “Key Changes for the entire 
Project” is deactivated.

In the key context menu

When you right-click on a key symbol, a context menu 
with a list of all available keys is opened. This menu also 
contains the following options:

• Key changes for the entire Project
If this option is activated (default setting), all changes made to the key 
will always affect the entire project, i.e. it is not possible to define differ-
ent keys for different staves.

• Hide
If you select this, the key will be hidden.

• Properties
If you select this, the dialog “Edit Key” is opened.

In the “Edit Key” dialog

If the current key is anything but C major/A minor (no acci-
dentals), you can set the key directly in the score:

1. Double-click on the accidentals at the beginning of a 
staff.
The “Edit Key” dialog opens.

2. Use the scroll bar to select a key and click OK.

• You can also enter a display transpose value, see 
“Transposing instruments” on page 69.

! On the Score Settings–Project page, on the Nota-
tion Style subpage (Keys category) you will find the 
option “Key Changes for the entire Project” (acti-
vated by default). When this option is activated, all 
changes made to the key will always affect every 
staff in the project, i.e. it is not possible to define dif-
ferent keys for different staves (other than the relative 
display transpositions for transposing instruments as 
set up in their respective Staff Settings).
Also from the Staff settings dialog, any staff (e.g. a 
drum staff) can be set to not show key signatures.

Double-click here…

…to open the Edit Key dialog.
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On the Score Settings–Staff page

1. Make sure the desired staff is the active staff and open 
the Score Settings–Staff page.

The Clef/Key section on the Score Settings–Staff page.

2. Use the right scroll bar in the Clef/Key section to se-
lect the desired key.

3. Click Apply.

• You can select other staves in the score and make set-
tings for these, without having to close the Score Settings 
dialog.

Setting the key for a split system

If you have a split system with two staves (see “Split (pi-
ano) staves” on page 92 and “Strategies: How many 
voices do I need?” on page 99) you can set different clefs 
for the upper and lower staff.

1. Click in the system to make one of its staves the active 
staff.

2. Open the Score Settings–Staff page.

3. Set a key for the upper staff.
This will automatically set the lower staff to the same key.

4. If you need to set a different key for the lower staff, ac-
tivate the “Lower Staff” check box and set a key for this.

The Lower Staff check box

Setting a local key

You can also set a different key for the selected staff only. 
This is useful for instruments like oboe and english horn 
that change display transpose and therefore also the key. 

1. Make sure the desired staff is the active staff and open 
the Score Settings–Staff page.

2. Activate the option “Local Keys” on the Main subpage 
in the Clef/Key section.

Note that this option is only available, if “Key changes 
for entire Project” is activated in the Score Settings–Project 
page on the Notation style subpage (Keys category).

3. Use the scroll bar to the right to set the desired key.

4. Click Apply to set the selected key for the staff.

Transposing instruments
Scores for some instruments, for example a lot of brass in-
struments, are written transposed. Therefore, the Score 
Editor provides a “display transpose” function. With this 
function notes are transposed in the score without affect-
ing the way they are played back. This allows you to 
record and play back a multi-staff arrangement, and still 
score each instrument according to its own transposition.

Setting display transpose
1. Make the desired staff active and open the Score Set-
tings–Staff page.

2. Select your instrument from the transpose pop-up or 
adjust the value directly in the Semitones field.

The Display Transpose section on the Score Settings–Staff page.

3. Click Apply.

For some instruments, you may wish to set the different 
keys in the notation. In this case, activate the “Local Keys” 
option, see above.

! Display transpose does not affect MIDI playback!
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Display transpose in the Edit Key dialog

If you want to change the display transpose setting in the 
middle of the score, you can do this by inserting a key 
change (see “Inserting and editing clefs, keys or time sig-
natures” on page 93). In the Edit Key dialog (which is 
opened by double-clicking a key symbol) you will find a 
Transpose field, in which you can enter a transposition 
value in semitones. This is useful if you are for example 
writing a saxophone part and want the player to switch 
from alto to tenor saxophone.

Note that you have to enter the absolute display trans-
pose value that should be used from this point on.
In other words, this setting is not relative to any display transpose set-
tings you made on the Score Settings–Staff page.

Disabling Display transpose
You can also disable display transpose by clicking on the 
“Disable Display Transpose” button on the Score Editor 
toolbar. This can be useful, if you work with transposing 
instruments and want to show the scored key and not the 
concert key.

Working order
When you prepare a score we suggest you do things in 
the following order, since this will minimize the time 
needed if you make a mistake somewhere and need to 
redo a step.

• Preferably work on copies of recorded tracks.
If the parts are fairly complex you might have to change them perma-
nently after which they won’t play back as they originally did.

• If memory is short, break the score up into segments.
You might for example use the Split Loop function (on the main Edit 
menu) to split the parts across all tracks.

• Arrange the tracks in the Project window in the order 
you want them displayed in the score.
You cannot rearrange the order of systems in the Score Editor. However, 
you can go back and change the order in the Project window at any time.

• When opening the Score Editor, begin with the adjust-
ments described above.
You should always begin by setting page margins, etc.

• If you have recorded music into tracks already, try ad-
justing the score “picture” as much as possible without 
permanently editing the notes.
Use the score settings, display quantize, grouping etc.

• If the tracks are empty, make basic staff settings, enter 
the notes and then make detailed adjustments, add dis-
play quantize etc.

• If needed, use polyphonic voicing to resolve overlapping 
notes, to create piano systems, to handle crossing voices 
etc.

• When all this is done, decide if you need to perform 
“destructive” editing.
You might for example have to permanently alter the length or position of 
some of the recorded notes.

• Hide unwanted objects and add note-dependent and 
note-related symbols.
This includes accents, dynamic symbols, crescendo, slurs, lyrics, 
“graphic rests” etc.

• Work through the score and adjust the number of bars 
across the page.

• Adjust the vertical spacing between staves and grand 
staves.
The last two steps can be performed automatically by the program using 
the Auto Layout features.

• Add layout symbols like endings, page text, etc.

• Print.

• Go back and create alternative layouts to extract voices 
etc.

Force update
If for some reason the screen isn’t redrawn properly (as a 
result of the computer’s recalculation of the appearance of 
the page), you can select “Force Update” from the Func-
tions submenu on the Scores menu or click the Update but-
ton on the toolbar. This forces a redraw of the whole page.

The Force Update button



7
Transcribing MIDI recordings



72

Transcribing MIDI recordings

About this chapter
In this chapter you will learn:

• How to make initial staff settings to make a score as legible as 
possible.

• How to use the Display Quantize tool to handle “exceptions” 
in the score.

• How to resolve parts that contain mixed notes and triplets.

About transcription
This chapter assumes you have a MIDI recording that you 
want to transform into a printable score. However, if the 
parts are fairly complicated, you will probably need to per-
form some manual editing of the notes. Hence you will 
need to read the next chapter, too!

Getting the parts ready
1. Record the music.
You must definitely play in time with the click.

2. Play back to check that the music was recorded as in-
tended.
If not, you might need to re-record or perform some editing.

3. Decide how much permanent alteration to the record-
ing you can accept to make the score look good.
If the answer is “none”, you should prepare your score from a copy of the 
track. See the section below.

4. Select all parts (on all tracks) that you wish to work on.

5. Open the Score Editor (e.g. by pressing [Ctrl]/[Com-
mand]-[R]).

6. Activate Page Mode.

Strategies: Preparing parts for score 
printout
Below follow a few tips that you might want to refer to 
when preparing a score for printout:

• If a part is complex, you may have to do some “manual” editing 
of notes, like moving them or changing their lengths (see the 
chapter “Entering and editing notes” on page 81). This means 
that the recording will not play back exactly as it originally did. 
If this is a problem, we suggest you work on a copy of the re-
cording. Use the Duplicate Track function on the Project menu 
to create a version of the track for scoring. Rename the track 
and mute the original track while you are preparing the score. 
You could of course also work on a copy of the entire project 
file.

• For reasons described in the previous chapter, quantizing the 
track might be a good idea. This will reduce the amount of de-
tailed adjustments needed in the Score Editor.

• If you need to quantize, always play back your tracks afterwards 
to make sure timing wasn’t disrupted due to inappropriate 
quantize settings. You might have to quantize some sections 
with one value and others with another.

• If the project contains many repetitions, it might be quicker to 
record just one instance of each to start with. If you then finish 
the score work on each section, you can assemble the entire 
project by working with parts in the Project window. This 
might save you some time since the detailed adjustments to 
each section have to be performed only once.

• A similar approach can also be used when you create sec-
tions where several instruments play the same rhythm (a horn 
section, for example): Record the first instrument and make 
adjustments so that it looks like it should in the Score Editor. 
Then copy the part to the other tracks, and change the pitches 
of the notes using MIDI input. Finally, go through the copied 
parts and make fine adjustments, change display transpose 
settings, etc. This can be a very fast way to create polyphonic 
parts with complicated rhythms.

• There also may be situations when the quickest way to record 
a part for several instruments is simply to record it in one go, 
by playing the chords on your MIDI instrument. If you later 
want to split the recording into separate tracks or polyphonic 
voices, you can use the Explode function, see “The Explode 
function” on page 79.

! Before starting, make sure you understand the basic 
principles behind the score notes/MIDI notes rela-
tionship and also what display quantize is, as de-
scribed in the chapter “How the Score Editor works” 
on page 54.
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Staff settings
The first thing to do after opening the Score Editor is to 
make initial staff settings. This is done on the Score Set-
tings–Staff page. There are three ways to open the Score 
Settings dialog:

• Make the staff active, pull down the Scores menu and 
select “Settings…”.

• Double-click on the blue rectangle to the left of the staff.
Please note that when the option “Double-click on staff flips between full 
score/part” is activated in the Preferences dialog (Scores-Editing page), 
double-clicking will instead switch between display of either the whole 
score or the current voice. If your score shows more than one track, dou-
ble-clicking will display this track and hide all others. If your score shows 
only one track, double-clicking will either show the layout, that contains 
most of the tracks or, if no multi-track layout exists, all tracks. 

• Make the staff active and click the “i” button on the ex-
tended toolbar.
For this to work, make sure no notes or symbols are selected – other-
wise, clicking the “i” button may open a dialog with settings for the se-
lected object instead.

Click the Staff button to open the Score Settings–Staff 
page. The Staff page shows the current settings for the 
staff on four tabs.

The Main tab

The Main tab of the Staff page.

Applying settings and selecting other staves
The Score Settings dialog is non-modal (see “About dia-
logs in the Score Editor” on page 65). This means you click 
Apply to apply the settings you’ve made to the active staff.

To make settings for another staff, simply make it active in 
the score (by clicking anywhere in the staff or by using the 
up/down arrow keys on the computer keyboard). How-
ever, please note:

Remember to click Apply before making another staff 
active – otherwise your settings will be lost!

Staff presets
When you know you will reuse settings made for one track 
in other tracks, you will save some time by creating a staff 
preset. This is described in “Working with staff presets” 
on page 106.

There are a number of staff presets available, set up to 
suit various instruments, etc.
The presets are accessed from the Presets pop-up menu on the Score 
Settings–Staff page, or from the staff context menu, opened by right-
clicking on the blue rectangle to the left of a staff. Use them as they are, 
or as starting points for your own settings.

Names
Allows you to specify a “long” and a “short” name for the 
staff. The long name is shown for the very first system for 
the staff in the score (at the start of the project), while the 
short name is shown for the remaining systems.

• Whether the names should be shown at all is set on the 
Layout page of the Score Settings dialog (see “Staff na-
mes” on page 162).
There, you can also choose to use the names of the edited MIDI tracks 
instead.

• If you only want the “long name” to be shown (i.e. if you 
don’t want a name shown for each system in the score), 
simply delete the short name.
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Display quantize

The display quantize settings.

This is where you give the program basic information 
about how to interpret your playing. There are “fixed” dis-
play quantize values plus an “Auto” option which should 
only be used when your music contains mixed straight 
notes and triplets. For background information about dis-
play quantize, see “Display quantize” on page 56.

If your music only contains “straight” notes or triplets

1. Set the Notes display quantize value according to the 
“smallest note position” you want to be shown in the score.
For example, if you have notes on odd sixteenth note positions, the Notes 
display quantize value should be set to 16 (sixteenth notes). The “T” val-
ues on the pop-up are for triplets.

2. Set the Rests display quantize value according to the 
smallest note value (length) you want to be displayed for a 
single note, positioned on a beat.
For example, if you want a single short note on a beat (quarter note posi-
tion) to be displayed as a quarter note, set the Rests display quantize 
value to 4 (quarter notes).

3. Deactivate the Auto Quantize option.

4. Set all the interpretation options.
These are described in detail below.

5. Examine the score.

6. If necessary, use the Display Quantize tool to insert 
“exceptions” to the staff settings.
See “Inserting display quantize changes” on page 78.

If your music contains mixed straight notes and triplets

1. Examine the score and decide if it mainly contains trip-
lets or mainly “straight” notes.

2. Set the Notes display quantize value accordingly.
If the score is mainly triplets, select the smallest triplet note position used 
in the score. If it is mainly straight notes, select the smallest “ordinary” 
note position.

3. Set the Rests display quantize value.
This is done according to the same rules as above.

4. Activate the Auto Quantize option.

5. Activate the Deviation (”Dev.”) and Adapt flags if you 
need them.
When Deviation is activated, triplets/straight notes will be detected even 
if they are not exactly “on the beat”. However, if you know your triplets/
straight notes are perfectly recorded (quantized or entered by hand), de-
activate this option.
When Adapt is activated, the program “guesses” that when one triplet is 
found, there are probably more triplets surrounding it. Activate this option 
if not all of your triplets are detected.

Clef/Key
The basic key and clef settings are described in detail in 
the section “Setting key, clef and time signature” on page 
65. There is also a Lower Staff checkbox which is only 
used in conjunction with piano (split) staves and poly-
phonic voicing. This is described in the section “In a split 
system” on page 68.

Interpretation options

The Interpretation options.

Syncopation

The Syncopation parameter has three different values:

Option Description

Relax When Syncopation is “relaxed”, the program will apply 
syncopation in a number of common cases.

Full Syncopation is on.

Off Syncopation is off, with no exceptions.
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For a “modern” notation of syncopated notes, activate 
Syncopation.

Without and with Syncopation.

Again, without and with Syncopation.

Please note that you can insert “exceptions” to the Synco-
pation setting on the Score Settings–Staff page, by using 
the Display Quantize tool. You can also create tied notes 
in various combinations by using the Cut Notes tool.

Consolidate Rests

Activate this when you want small consecutive rests 
joined into one (an eight note rest and a sixteenth note 
rest joined to a dotted eighth note rest for example). 

Consolidate Rests deactivated and activated.

Clean Lengths

When this option is activated, the program interprets the 
length of your notes differently. A note’s length (in the dis-
play only) might be extended to the beginning of the next 
note or to the next Rests display quantize “position”. An 
example:

• If a note is too short, you may get a rest just after it.
• When Clean Lengths is activated, the rest will disappear.

A slightly short eighth note without and with “Clean Lengths”.

If using Clean Lengths doesn’t help in a particular situa-
tion, you will have to manually resize the offending note(s) 
or use the Display Quantize tool (see “Inserting display 
quantize changes” on page 78).

No Overlap

When notes starting at the same position have different 
lengths, the program tends to add more ties than you may 
want. This can be avoided by using No Overlap.

This recording in the Key Editor…

…will be displayed like this when No Overlap is deactivated…

…and like this when No Overlap is activated.

You can insert “exceptions” to the No Overlap setting on 
the Score Settings–Staff page, by using the Display 
Quantize tool.

! Please note that there may be situations when neither 
of these alternatives is ideal. If you run into such a sit-
uation, it can probably be resolved by using poly-
phonic voices, see “Polyphonic voicing” on page 95.
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Shuffle

In jazz it is very common to score a shuffled beat as 
straight notes, simply to make it more legible. 

When the Shuffle flag is activated, the program searches 
for eighth note or sixteenth note pairs where the second 
note is played late (with a “swing feel” or as the third note 
in a triplet). Such pairs are displayed as regular eighth or 
sixteenth notes instead of triplet-based figures.

Without and with Shuffle.

Display transpose
This is used when preparing parts for instruments that are 
not scored at the actual concert key. For example, if you 
want the note C3 to be played by an alto sax, you have to 
score it as an A3 – nine semitones up. Luckily, the display 
transpose setting takes care of this for you:

• Use the pop-up menu to select the instrument for which 
you’re scoring.

• If the pop-up menu doesn’t list the needed instrument, you 
can set the desired transposition with the Semitones value 
field.

The display transpose setting doesn’t affect playback 
or the actual pitch of the notes – it only changes how they 
are displayed and printed.

• If you want to set a different key symbol, e.g. when scor-
ing for french horn, activate the “Local Keys” option.

• You can disable display transpose by clicking on the 
button “Disable Display Tranpose” in the toolbar of the 
Score Editor. 

For more details, see “Transposing instruments” on page 
69.

The Options tab

The Options tab of the Staff page.

The Options tab contains additional settings for the staff. 
Below you can find a brief description of these, with refer-
ences to more detailed explanations.

Switches
Option Description

Flat Beams Activate this when you want the beams over notes to be 
flat (as opposed to slanted). See “Beam appearance and 
slant settings” on page 120.

No Beams Activate this when you don’t want any beaming at all on 
the staff (for example for vocal scoring). See “Turning be-
aming on/off” on page 116.

Beam 
Subgroups

Use this when you want sixteenth notes displayed under 
a beam to be divided into groups of four notes. See 
“Handling beam groups” on page 119.

Without and with Beam Subgroups.

16th 
Subgroups

Use this when you want even smaller subgroups of six-
teenth notes. This setting has no effect if Beam Sub-
groups is deactivated.

As above, but with 16th Subgroups activated.
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Score Drum Map
These settings are all described in the chapter “Scoring 
for drums” on page 185.

System Sizes
This section allows you to set the number of system lines 
and to control spacing between the lines. See “Creating 
tablature manually” on page 191 for an example of how 
this can be used with tablature.

Fixed Stems
Activate this if you want all note stems to end at the same 
vertical position. The Up and Down fields let you specify 
the desired positions for stems in the respective direction, 
using the graphic figure to the right as a guideline.

Note Limits
Use the Low and High fields to specify a note range. In the 
active staff, any notes outside this range will be displayed 
in a different color. When writing a score for a specific in-
strument, this makes it easy to find notes that are outside 
of this instrument’s note range.

If the option “Hide Notes beyond Limits” is activated in 
the Preferences dialog (Scores-Editing page), any notes 
outside the Note Limits range will be hidden.

The Polyphonic tab
This is where you activate and set up split (piano) systems 
or polyphonic voices (several independent score lines in 
the same staves). See the chapter “Polyphonic voicing” 
on page 95.

The Tablature tab
This contains settings for creating tablature scores. See 
the chapter “Creating tablature” on page 189.

Situations which require additional 
techniques
The notes may not always appear in the score as you ex-
pect them to, initially. This is because there are a number 
of situations which require special techniques and set-
tings. Below you can find a list of some of these and 
where to find more information about handling them:

• Notes at the same position are considered to be part of 
a chord. To get independent voicing (e.g. notes with dif-
ferent stem directions), such as for vocal material, you 
need to use the polyphonic voicing feature, see the chap-
ter “Polyphonic voicing” on page 95.

Without and with polyphonic voicing.

• If two notes beginning at the same position have different 
lengths, the longer one will be displayed as a number of tied 
notes. To avoid this, you will either have to use the No Over-
lap feature (see “No Overlap” on page 75) or polyphonic 
voicing (see “Polyphonic voicing” on page 95).

• One note will often be displayed as two notes with a tie. 
Please note that this is merely the way the program dis-
plays this note; only a single note is “stored”.

This single note in the Key Editor is displayed as two tied notes in the 
Score Editor.

• Normally the program adds ties where necessary (if a 
note stretches over a beat), but not always. For a “mod-
ern” notation of syncopated notes (less ties), you will need 
to use the Syncopation feature, see “Syncopation” on 
page 74.

The same note, without and with syncopation.

• If you find that you want a long note to be displayed as 
two or more tied notes, you can achieve this with the Cut 
Notes tool. See “The Cut Notes tool” on page 121.
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• If two notes on the same position are too close to each 
other or if you want their order in the part reversed, you 
can do this without affecting playback. See “Graphic mo-
ving of notes” on page 122.

• If a note has the wrong accidental, this can be changed. 
See “Accidentals and enharmonic shift” on page 113.

• Stem direction and length are automatic, but you can 
change them manually if you wish. See “Background: 
Note stems” on page 111.

• If you need a split staff (e.g. when you are scoring for 
piano), there are special techniques for this – see “Split 
(piano) staves” on page 92 and “Polyphonic voicing” on 
page 95.

If you run into trouble
Below you can find a few simple troubleshooting steps 
that will help you pinpoint other common problems:

• The note I recorded is displayed with the wrong length. 
For example, I recorded a sixteenth and got a quarter note.
You probably have the wrong display quantize value set, see “Display 
quantize” on page 74 for details. If you feel uncertain about what display 
quantize is, and how it works, please read the chapter “How the Score 
Editor works” on page 54. Also, you may want to check the No Overlap 
setting.

• There is a pause after a note that I don’t want.
The note is probably too short. This can be adjusted in two ways, by us-
ing Clean Lengths (see “Clean Lengths” on page 75) or by manually 
lengthening it (see “Changing the length of notes” on page 90). If this 
problem occurs a lot in your score, try selecting a larger Rests display 
quantize value (see “Using Rests display quantize” on page 57).

• There is no pause after the note although there should 
be one.
Either the note is too long (use Clean Lengths or change the current 
note’s length), or Rests display quantize is set to too high a value. Open 
the Score Settings–Staff page and lower it.

• The note has an accidental when it shouldn’t, or it 
doesn’t when it should.
Enharmonic shifting is described in the section “Accidentals and enhar-
monic shift” on page 113.

• Notes are not grouped under beams the way I want it.
Normally the program groups eighth notes, sixteenths etc. under beams. 
This can be deactivated. There is also detailed control of which notes are 
grouped under a beam. This is described in the section “Handling bea-
ming” on page 116.

Inserting display quantize changes
Some situations may require different staff settings on dif-
ferent sections of the track. The staff settings are valid for 
the entire track, but you can insert changes wherever you 
like:

1. Select the Display Quantize tool from the toolbar or 
Quick menu.

The Display Quantize tool on the toolbar.

2. When you select the tool, the Display Quantize dialog 
appears.

3. Activate the flags you need and set the quantize val-
ues as desired.
For details, see “Display quantize” on page 74 and “Interpretation opti-
ons” on page 74. Additional hints below.

4. If you want to restore the settings to the ones used on 
the Score Settings–Staff page, click the Restore To Staff 
button.

5. Move the mouse over the staff where you want to in-
sert a new display quantize value.
Use the mouse position box to find the exact location. The vertical posi-
tion is of no relevance as long as you click somewhere in the staff.

6. Click the mouse button to insert a display quantize 
event.
The new quantize settings are now inserted into the staff at the position 
where you clicked. The settings are valid until a new change is inserted. 
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• If you are using polyphonic voices (see “Polyphonic voi-
cing” on page 95), you can insert a display quantize event 
for all voices by pressing [Alt]/[Option] and clicking with 
the tool.
If the option “Display Quantize Tool affects all Voices” is activated on the 
Score Settings–Project page (Notation Style subpage, in the Miscella-
neous category), display quantize events will always be inserted for all 
voices.

Viewing and editing display quantize changes
If you activate the “Quantize” checkbox on the display filter 
bar (see “Showing and hiding “invisible” elements” on 
page 64), a marker will be shown under the staff for each 
display quantize setting you have entered with the tool.

This allows you to edit your settings in the following ways:

• To edit a display quantize change event, double-click on 
its marker.
This opens the Display Quantize dialog again – adjust the settings and 
click Apply.

• If the Display Quantize dialog is already open, you can 
select any display quantize change event, adjust its set-
tings in the dialog and click Apply.

• To remove a display quantize change, either click its 
marker to select it and press [Backspace] or [Delete], or 
click on it with the Erase tool.

Strategies: Adding display quantize 
changes
Very often, the score will be fine except for a few bars 
somewhere. To remedy the problem, insert two display 
quantize changes with the tool (one at the beginning of the 
section, one after it to restore to the current staff settings).

If you have mixed triplets and straight notes, it can be 
tempting to insert many display quantize changes. Before 
you do so, try the Auto Quantize options and their addi-
tional settings. See “If your music contains mixed straight 
notes and triplets” on page 74.

The Explode function
This function allows you to “split” the notes on a staff into 
separate tracks. It is also possible to use this function to 
convert a polyphonic staff into polyphonic voices – this is 
described in the section “Automatically – the Explode 
function” on page 100.

1. Pull down the Scores menu, open the Functions sub-
menu and select “Explode…”.

The Explode dialog, set to create tracks.

2. Make sure “To New tracks” is selected at the top of 
the dialog.

3. Enter the desired number of new tracks.
Note that this is the number of new tracks to be created! For example, if 
you have a three-part polyphonic section and want to split this into three 
separate tracks, you must specify 2 new tracks, since the original track 
will hold one of the parts.

4. Use the options in the bottom section to set up the cri-
teria for the split.
Choose from the following options:

5. Click OK.
A number of new tracks are now added to the score and the Project win-
dow.

! You may want to create a copy of the original track 
first, since this will be changed by the operation.

Option Description

Split Note Use this to move all notes below a certain pitch to an-
other track. When this is selected, it is pointless to spec-
ify more than 1 new track.

Lines To tracks Use this when you want all musical “lines” to be put on 
one track each. The notes with the highest pitch will re-
main on the original track, the notes with the second 
highest pitch will be put on the first new track, and so on. 

Bass To 
Lowest Voice

When this is activated, the lowest notes will always end 
up on the lowest track.
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Using “Scores Notes To MIDI”
For very complicated scores, there may be situations 
where you have tweaked the parameters for display quan-
tize and interpretation as best you can, and you still can’t 
get the score exactly as you want it. Perhaps one setting 
works fine in one section of the track and another is 
needed for another section.

In such a case, “Scores Notes To MIDI” will help you out. 
It changes the lengths and position of some or all the MIDI 
notes in the edited parts so that they have exactly the val-
ues currently shown on screen.

1. For safety, go back to the Project window and make a 
copy of the track.

2. Open the part(s) again in the Score Editor.
If you only want some sections of your score to be “converted”, make 
sure to only open those parts.

3. Make sure the notes you want to affect are not hidden 
(see “Hiding/showing objects” on page 174).

4. Select “Scores Notes To MIDI” from the Functions 
submenu on the Scores menu.
The notes are now “converted”.

5. Make whatever adjustments are needed to make the 
score read as intended.

Now that the notes have the exact lengths and positions 
that were previously only displayed, you can probably de-
activate many of the options on the Score Settings–Staff 
page and delete display quantize settings, etc.

If you find the operation didn’t give you the result you were 
after, you can undo your settings or go back to the original 
track, make a copy of that, and start over.
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About this chapter
In this chapter you will learn:

• How to make various settings for how notes are displayed.
• How to enter notes.
• How to use tools and settings to make the score as legible as 

possible.
• How to set up a split (piano) staff.
• How to work with multiple staves.

Score settings
Before you start entering notes, you need to make some 
initial staff settings in addition to those described in the 
chapter “The basics” on page 59. To understand why and 
how these settings and the note data in the score interact, 
please read the chapter “How the Score Editor works” on 
page 54.

There are three ways to open the Score Settings dialog:

• Make the staff active, pull down the Scores menu and 
select “Settings…”.

• Double-click on the blue rectangle to the left of the staff.
Please note that when the option “Double-click on staff flips between full 
score/part” is activated in the Preferences dialog (Scores-Editing page), 
double-clicking will instead switch between display of either the whole 
score or the current voice. If your score shows more than one track, dou-
ble-clicking will display this track and hide all others. If your score shows 
only one track, double-clicking will either show the layout that contains 
most of the tracks or, if no multi-track layout exists, all tracks.

• Make the staff active and click the “i” button on the ex-
tended toolbar.
For this to work, make sure no notes or symbols are selected – other-
wise, clicking the “i” button may open a dialog with settings for the se-
lected object instead.

The Score Settings dialog shows the current settings for 
the active staff.

Applying settings and selecting other staves
To make settings for another staff, simply make it active in 
the score (by clicking anywhere in the staff or by using the 
up/down arrow keys on the computer keyboard). How-
ever, please note:

Always click Apply before making another staff active 
– otherwise your settings will be lost!

Staff presets
When you want to reuse settings made for one track in 
other tracks, you will save some time by creating a staff 
preset (see “Working with staff presets” on page 106).

There are a number of staff presets available, set up to 
suit various instruments, etc.
The presets are accessed via the Presets pop-up menu on the Score 
Settings–Staff page, or from the Staff context menu, opened by right-
clicking on the blue rectangle to the left of the staff. Use them as they 
are, or as starting points for your own settings.

Suggested initial settings
When you start out entering notes, your staff settings 
should make your score display the notes as entered. We 
suggest the following:

You will find out later how to adapt these settings in detail 
to make the score read as you want it to.

It is very important that you understand how the dis-
play quantize values for notes and rests interact with the 
score. If you select too large a notes/rests value, the notes 
you “click in” may not appear as intended. 
Please read “How the Score Editor works” on page 54. If you have mixed 
triplets and straight notes, see “Display quantize” on page 74.

Option Description

Names As desired

Display Quantize: Notes 64

Display Quantize: Rests 64

Auto Quantize Activated

Syncopation Off

Consolidate Rests Off

Clean Lengths Off

No Overlap Off

Shuffle Off

Key As desired

Clef As desired

Auto Clef Activate this if you want the program to 
select a treble or bass clef automatically.

Display Transpose 0

Options tab settings As is

Polyphonic tab settings Staff Mode: Single (For split staves, see 
“Split (piano) staves” on page 92.)

Tablature tab settings Tablature Mode deactivated
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Note values and positions
Two of the most important settings for entering notes (and 
the ones you will change most often) are the length of the 
note (the note value) and the minimum spacing between 
notes (the quantize value).

Selecting a note value for input
This can be done in one of three ways:

• By clicking the note symbols on the extended toolbar.
You can select any note value from 1/1 to 1/64th and activate/deactivate 
the dotted and triplet options by clicking the two buttons to the right. The 
selected note value is displayed in the Length value field on the toolbar 
and in the Insert Note tool cursor shape.

The note value is reflected in the extended toolbar, the Length value 
field and the Insert Note tool shape.

• By selecting an option from the Length pop-up menu on 
the toolbar.

• By assigning key commands to the different length 
values.
This is done in the Key Commands dialog on the File menu, under the 
category “Set Insert Length”.

About unusual note values

Not all note values can be selected directly, for example 
double dotted notes. Such notes are created by changing 
the length of the note after you have put it in (see “Chan-
ging the length of notes” on page 90), by gluing notes to-
gether (see “Lengthening a note by gluing two notes 
together” on page 91) or by using the Display Length 
feature.

Selecting a display quantize value
When you move the mouse pointer over the score, you will 
see that the position box on the toolbar tracks your move-
ment and shows the current position in bars, beats, six-
teenth notes and ticks.

Positioning on screen is controlled by the current quantize 
value. If you for example set this to “1/8 Note”, you can only 
insert and move notes to eighth note positions, at quarter 
notes, at half bars or at bar positions. It is a good strategy 
to set the quantize value to the smallest note value in the 
project. This doesn’t stop you from inputting notes at 
“coarser” positions. However, if you set the quantize value 
to too small a note value, it is easier to make mistakes.

The quantize value is set on the toolbar in the Quantize 
pop-up menu:

• You can also assign key commands to the different 
quantize values.
This is done in the Key Commands dialog on the File menu, under the 
category “MIDI Quantize”.

• Just like in the other MIDI editors, you can use the 
Quantize Setup dialog to create other quantize values, ir-
regular grids, etc.
However, this is not often used when inputting score notes.

The “mouse position box”
While you will most often use the graphical position in the 
actual score to determine where the notes go, there are 
instances when you will want to verify the position numer-
ically using the mouse position box:

With the quantize value set to “1/8 Note”, you can only 
input notes at eighth note positions.
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The upper field shows the pitch according to the vertical 
position of the pointer in a staff. The lower field shows the 
“musical position” in bars, beats, sixteenth notes and ticks:

• The relation between beats and bars depends on the 
time signature: In 4/4 there are 4 beats to a bar. In 8/8 
there are eight, in 6/8 there are six, etc.

• The third number is the sixteenth note within the beat. 
Again, the time signature determines the number of six-
teenth notes to each beat. In a quarter note based time 
signature (4/4, 2/4, etc.) there are four sixteenth notes to 
each beat, in an eighth note based time signature (3/8, 4/
8, etc.), there are two sixteenth notes, etc.

• The last value is in ticks, with 480 ticks per quarter note 
(and thus 120 ticks per sixteenth note).
The figures below show some note positions and their corresponding 
position values:

Eighth note positions.

Eighth note triplet positions.

Sixteenth note positions.

Adding and editing notes

Entering notes using the computer keyboard
A quick and easy way to enter notes, without having to de-
cide on the pitch, position and note value first is using the 
computer keyboard. To enter a note, proceed as follows:

1. On the toolbar, activate the “Keyboard Input” button. 
Now you can enter notes using the computer keyboard.

The “Keyboard Input” button

2. Hold down [Alt]/[Option].
A note with the note value specified in the extended toolbar appears. By 
default, the insert position is the first position of the bar and the pitch is C3. 
You can however change this using the computer keyboard, see below.

• You can change the pitch of the note by using the up 
and down arrow keys.
To transpose the note in octave steps, use the Page Up/Page Down 
keys.

• To change the insert position of the note use the right 
and left arrow keys.
Note that for position changes, the Quantize value is taken into account.

• To change the length of the note, hold down [Shift] and 
use the right and left arrow keys.
This changes the note value step by step, passing from one quantize 
value to the next.

3. To insert the note, press [Return].
The note with the specified pitch and note value is inserted at the desired 
position and a the insert position for the next note changes according to 
the Quantize value. When you press [Shift]+[Return] the insert position 
will not change, allowing you to enter chords.
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Entering notes with the mouse
To add a note to the score, proceed as follows:

1. Make the staff active.
Notes are always inserted on the active staff. See “The active staff” on 
page 62 for details.

2. Select the desired note value.
See “Selecting a note value for input” on page 83.

3. If you select the note value by clicking on a symbol on 
the extended toolbar, the Insert Note tool is automatically 
selected – otherwise select the Insert Note tool from the 
toolbar or Quick menu.

4. Select a quantize value.
The quantize value determines the spacing between notes. If you set 
quantize to “1/1 Note” you will only be able to add notes at downbeats. If 
you set quantize to “1/8 Note” you will be able to add notes at eighth 
note positions, etc.

5. Click in the staff and keep the mouse button pressed.
The Insert Note tool changes into a note symbol (showing the note ex-
actly as it would be inserted in the score). 

6. Move the mouse horizontally to find the correct position.
Check the mouse position box – the position snaps to the grid defined 
by the current quantize value. This allows you to easily find the correct 
position.

7. Move the mouse vertically to find the correct pitch.

If the option “Show Note Info by the Mouse” is acti-
vated in the Preferences dialog (Scores-Editing page), the 
position and pitch of the note will also be shown in a “tool 
tip” next to the pointer while you’re dragging.
If you find that screen redraws are too sluggish, you may want to deacti-
vate this option.

8. Release the mouse button.
The note appears in the score.

Adding more notes
1. If you want the next note to be of another note value, 
select a new note value.

2. If you need finer positioning, or if the current value is 
too fine, change the quantize value.

3. Move the mouse to the desired position, and click.
Notes input at the same position are automatically interpreted as chords, 
see below.

About the interpretation
The notes may not always appear in the score as you ini-
tially expect them to. This is because there are a number 
of situations that require special techniques and settings. 
Below you can find a list of some of these and where to 
find more information about handling them:

• Notes at the same position are considered parts of a chord. 
To get independent voicing (for example notes with different 
stem directions), such as for vocal material, you need to use 
polyphonic voicing – see “Polyphonic voicing” on page 95.

Without and with polyphonic voicing

• If two notes beginning at the same position have different 
lengths, the longer will be displayed as a number of tied notes. 
To avoid this, you will either have to use the “No Overlap” fea-
ture (see “No Overlap” on page 75) or polyphonic voicing 
(see “Polyphonic voicing” on page 95).

• One note will often be displayed as two notes with a tie. This 
is only how the program displays the note, there is still only a 
single note “stored”.

This single note in the Key Editor is displayed as two tied notes in the 
Score Editor.

! If you activate the option “Animate Note Cursor” in 
the Preferences (Scores-Editing page), you do not 
need to keep the mouse button pressed to see the 
note as it would be inserted in the score.

Accidentals are shown beside the 
note to indicate the current pitch
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• Generally the program adds ties where necessary (if a note 
stretches over a beat), but not always. For more “modern” no-
tation of syncopated notes (less ties), you will need to use the 
syncopation feature, see “Syncopation” on page 74.

The same note, without and with Syncopation.

• If you want a long note to be displayed as two (or more) tied 
notes, you can use the Cut Notes tool for this.

• If a note has the wrong accidental, this can be changed. See 
“Accidentals and enharmonic shift” on page 113.

• If two notes on the same position are too close to each other 
or if you want their “graphical order” in the score reversed, you 
can do this without affecting playback. See “Graphic moving 
of notes” on page 122.

• Stem direction and length is normally automatic, but you can 
set it yourself. See “Background: Note stems” on page 111.

• If you are scoring for piano and therefore (or for other reasons) 
need a split staff, there are special techniques for this, see 
“Split (piano) staves” on page 92 and “Polyphonic voicing” on 
page 95.

If you run into trouble
Below you can find some questions and answers that will 
help you pinpoint some common mistakes:

• The note I put in has the wrong length. For example, I 
added a sixteenth and got a quarter note.
You probably have the wrong display quantize value set. Open the Score 
Settings–Staff page. If Auto Quantize is activated, deactivate it, unless 
you have mixed triplets and regular notes. Also check the Notes and 
Rests display quantize values. If the settings are too “coarse”, change 
them to a smaller note value. If you for example need the program to dis-
play an eighth note rest, Rests display quantize must be set to “8” or a 
smaller value (please refer to the chapter “How the Score Editor works” 
on page 54). If No Overlap is activated, you might want to turn it off.

• There is a pause after a note that I don’t want.
You probably added a note with the wrong note value. Either lengthen 
the note (physically or graphically – see “Changing the length of notes” 
on page 90) or delete the one you have (see “Deleting notes” on page 
94) and add a new one with the correct note value.

• There is no pause after the note although there should 
be one.
Either the note is too long (delete and enter a new one or change the cur-
rent note length, physically or graphically). Or Rests display quantize is set 
to too large a note value. Open the Score Settings–Staff page and lower it.

• The note has an accidental when it shouldn’t, or it 
doesn’t when it should.
Maybe the note is simply of the wrong pitch? Click on it (using the Ob-
ject Selection tool) and look at the info line (if this is not shown, see “The 
info line” on page 63). Move it to the correct pitch (see “Editing pitches 
of individual notes” on page 89). If this is not the reason, maybe you have 
the wrong key set? And finally, you can also use enharmonic shifting (see 
“Accidentals and enharmonic shift” on page 113).

• Notes are not grouped under beams the way I want it.
Normally the program groups eighth notes, sixteenths etc. under beams. 
This can be deactivated. There is also detailed control of which notes are 
grouped under a beam, see “Handling beaming” on page 116.

Selecting notes
In the operations described in the rest of this chapter, you 
will often work on selected notes. The text below de-
scribes how to select notes in various ways:

By clicking
To select a note, click on its note head with the Object 
Selection tool. The note head turns red to indicate that it is 
selected.

• To select more notes, hold down [Shift] and click on 
them.

• To deselect notes, hold down [Shift] and click on them 
again.

• If you hold down [Shift] and double-click on a note, this 
note and all the following notes in the same staff are se-
lected.

Selected notes
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Using a selection rectangle
1. Click in an empty area in the score with the Object Se-
lection tool and keep the mouse button pressed.

2. Drag the mouse pointer.
A selection rectangle appears. You can drag to select notes on several 
voices or staves if you wish.

3. Release the mouse button.
All notes with their note heads inside the rectangle are selected.

If you want to deselect one or more of the notes, hold 
down [Shift] and click on them.

Using the keyboard
By default, you can step through (and select) the notes in 
the staff using the left and right arrow keys. If you press 
[Shift], you can select a series of notes as you step 
through them.

• If you are working with polyphonic voices, you will step 
through the notes in the current track, i.e. in a split system, 
you will step through the staffs.

• If you want to use other keys for selecting notes, you 
can customize the settings in the Key Commands dialog 
on the File menu (in the Navigate category).

Selecting tied notes
Longer notes are often displayed in the score as one note 
with a tie. When you intend to select the entire note for 
deleting etc., you should select the first note, not the tied 
note.

Deselecting everything
To deselect everything, simply click in an empty area of 
the score with the Object Selection tool.

Moving notes

Moving by dragging
1. Set the quantize value.
The quantize value will restrict your movement in time. You cannot place 
notes on positions smaller than the quantize value. If Quantize is set to 
“1/8 Note” for example, you will not be able to move the notes to a six-
teenth note position. However, you will be able to put them on any eighth 
note, quarter note, half note or whole note position.

2. Select the note(s) you want to move.
You can select notes across several staves if you wish.

3. Click one of the selected notes and drag it to a new 
position.
The horizontal movement of the note is “magnetically attracted” to the 
current quantize value. The mouse position box on the toolbar shows 
what the new position and pitch for the dragged note will be.

If the option “Show Note Info by the Mouse” is acti-
vated in the Preferences dialog (Scores-Editing page), the 
position and pitch of the note will also be shown in a “tool 
tip” next to the pointer while you’re dragging.
If you find that screen redraws are too sluggish, you may want to deacti-
vate this option.

4. Release the mouse button.
The notes appear at their new position.

• If you press [Ctrl]/[Command] and drag, movement is 
restricted to vertical or horizontal only (depending on the 
direction in which you drag).

• If you move notes vertically and the option “Keep moved 
notes within key” is activated in the Preferences dialog 
(Scores-Editing page), the notes will be transposed within 
the current key only.

Moving by using key commands
Instead of dragging the note with the mouse, you can as-
sign key commands for this:

• The commands for which you should assign keys are 
found in the Nudge category in the Key Commands dialog.
The commands are listed as “Left”, “Right”, “Top” and “Bottom”.

! There is a setting for this in the Preferences dialog 
(Scores-Editing page): If you activate “Tied notes 
selected as Single Units”, the whole note will be 
selected, even if you click on one of the tied notes.



88

Entering and editing notes

• When moving notes to the left or right using key com-
mands, the notes will be moved in steps according to the 
current quantize value.
The keys assigned for up/down nudging will transpose notes in semitone 
steps.

Moving across staves – the Lock button
If you are editing several tracks, you may want to move 
notes from one staff to another. Proceed as follows:

1. Make the desired Quantize settings and select the 
notes.
Make sure to select only notes on the same staff.

2. Make sure the “L” (Lock) button on the extended tool-
bar is deactivated.

When this button is activated, you cannot move notes and other objects 
from one staff to another, which is handy if you for example need to trans-
pose a note very high or low.

3. Click on one of the notes and drag them to the new 
system.
The active staff rectangle indicates on which staff the dragged note(s) 
will appear.

The Snap mode
The notes you move, or copy, will snap to positions de-
fined by the note length and quantize values. Using the 
Snap pop-up menu in the Score Editor toolbar you can 
set the Snap mode used when moving or copying notes:

• When using the “Grid” Snap mode, notes you move or 
copy will always snap to exact grid positions.

• When using the “Grid Relative” Snap mode, a note with 
a certain position relative to a grid line will always maintain 
that relative position, to the grid, when moved or copied.

Activating auditioning

Auditioning activated.

To hear the pitch of the note while moving, activate the 
speaker icon (Acoustic Feedback) on the toolbar.

About the lock layers
When you are moving and editing notes in the score, you 
might accidentally move other objects nearby. To avoid 
this, assign different types of objects to different “lock lay-
ers” (up to three) and instruct Nuendo to “lock” one or two 
of these layers, making them unmovable.

There are two ways to set up which type of object should 
belong to which lock layer:

• Open the Preferences dialog from the File menu and 
select the Scores–Event Layer page.
This page lets you adjust the layer setting for each object type.

• Right-click on one of the layer buttons (1-2-3) in the ex-
tended toolbar to bring up a pop-up menu, showing which 
object types are associated with that layer.
A checkmark for an object type means it belongs to that layer. If no 
checkmark is shown, you can select the object type on the menu to move 
it to that layer.

To lock a layer, click on its Lock Layer button, so that it is 
not blue. You can only select or move objects whose 
Layer button is activated. For more detailed information, 
see “Using the lock layers” on page 138.

The “L” (Lock) button is deactivated.
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There are also “L” and “P” layer buttons, for the layout 
and project layer, respectively.
Clicking these buttons allows you to lock the layout layer and project 
layer (see “Background: The different layers” on page 127).

Duplicating notes
1. Set the quantize value and select the desired notes.
You can duplicate any block of notes, even on several systems at the 
same time. The Snap mode applies, see “The Snap mode” on page 88.

2. Press [Alt]/[Option] and drag the notes to their new 
position.

• If you want to restrict movements to one direction only, 
press [Ctrl]/[Command].
This works just as for moving, as described above.

• If you want to restrict the pitch to inside the current key 
only, make sure the option “Keep moved notes within key” is 
activated in the Preferences dialog (Scores-Editing page).

3. Release the mouse button to insert the notes.

• [Alt]/[Option] is the default modifier key for copying/du-
plicating. If you like, you can change this in the Prefer-
ences dialog (Editing–Tool Modifiers page).
The entry for this is found in the Drag & Drop category (“Copy”).

You can also move or copy whole bars by dragging 
the bar handles, see “Moving and duplicating with the bar 
handles” on page 141.

Cut, copy and paste
• To cut notes, select them and select Cut from the Edit 
menu (or use a key command, by default [Ctrl]/[Com-
mand]-[X]).
The notes are now removed from the score and put on the clipboard.

• To copy notes, select them and select Copy from the 
Edit menu (or use a key command, by default [Ctrl]/[Com-
mand]-[C]).
A copy of the notes is made, and put on the clipboard. The original notes 
remain where they were.

Notes that you have put on the clipboard by cutting or 
copying can be inserted into the score again in the follow-
ing way:

1. Activate the desired staff.

2. Move the project cursor to the position where you 
want the first note to appear.
This is done by holding down [Alt]/[Option] and [Shift] and clicking at the 
desired position in the score.

3. Select Paste from the Edit menu (or use a key com-
mand, by default [Ctrl]/[Command]-[V]).
The notes are pasted in, beginning at the project cursor. If the cut or cop-
ied notes come from different staves, they will also be inserted on different 
staves. Otherwise, the notes are inserted on the active staff. They keep 
the pitch and relative positions they had when you cut or copied them. 

Editing pitches of individual notes

By dragging
The simplest way to edit the pitch of a note would be to 
drag it up or down. Remember to hold down [Ctrl]/[Com-
mand] to avoid moving the note sideways as well.

• If the option “Keep moved notes within key” is activated 
in the Preferences dialog (Scores-Editing page), notes 
will be transposed within the current key only.

• To avoid accidentally moving the note into another staff, 
activate the Lock button (see “Moving across staves – the 
Lock button” on page 88).

• When you drag the mouse up and down before releas-
ing the button, accidentals are shown beside the note to 
indicate the current pitch.
This helps you verify the vertical position for the note.

Using the Transpose palette
The Transpose palette on the toolbar contains buttons for 
transposing the selected notes up or down in steps of one 
semitone or one octave.

• To show the Transpose palette, right-click the toolbar 
and activate “Transpose Palette” on the context menu that 
appears.! The clipboard can only hold one set of notes. If you 

cut or copy and then cut or copy again, the notes 
that first were on the clipboard will be lost.
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Using key commands
Instead of transposing the note with the mouse, you can 
assign key commands for this.

• The commands for which you can assign key commands 
are found in the Nudge category in the Key Commands 
dialog.
The commands are listed as “Top” (transpose one semitone up) and 
“Bottom” (transpose one semitone down).

Using the info line
You can use the info line to change the pitches (and other 
properties) of one or several notes numerically, see the 
chapter “The Project window” in the Nuendo Operation 
Manual.

• If you have several notes selected and change the pitch 
on the info line, the changes will be relative.
That is, all selected notes will be transposed by an equal amount.

• If you have several notes selected, hold down [Ctrl]/
[Command] and change the pitch on the info line, the 
changes will be absolute.
That is, all selected notes will be set to the same pitch.

Via MIDI
1. On the toolbar, activate the MIDI Input button and the 
Record Pitch button to the right.
If you also want to change the note-on and/or note-off velocity of the notes 
via MIDI, this can be done by also activating the corresponding velocity 
buttons, as described in the chapter “The MIDI editors” in the Nuendo 
Operation Manual.

To edit notes via MIDI (pitches only), set up the buttons like this.

2. Select the first note you want to edit.

3. Press a key on your MIDI keyboard.
The note takes on the pitch of the key you pressed. The program then se-
lects the next note.

4. To change the pitch of the next selected note, simply 
press the desired key.
In this manner you can change the pitches of as many notes as you wish, 
by simply pressing the relevant keys. You can also use key commands 
(by default the left and right arrow key) to pass from one note to the 
other. For example, if you make a mistake, you can step back to the pre-
vious note by pressing the left arrow key.

Changing the length of notes
When it comes to note lengths, the Score Editor is special 
in that it doesn’t necessarily display the notes with their 
actual length. Depending on the situation, you may want to 
change the “physical length” of the notes or the “display 
length”.

Changing the “physical” length
This will change the actual length of the notes. The 
change will be audible when you play back the music.

By using the Insert Note tool

1. Select the note symbol with the desired note value on 
the extended toolbar.

2. Hold down [Alt]/[Option] and click on the note(s) you 
wish to set to this length.

By using the extended toolbar

Using the extended toolbar is another quick way to set a 
number of notes to the same length:

1. Select the notes you want to change.

2. Hold down [Ctrl]/[Command] and click on one of the 
note icons on the extended toolbar.
All the selected notes now get the note value on which you clicked.

By using the info line

You can also edit length values numerically on the info 
line. The same rules apply as when changing the pitch of 
notes (see “Using the info line” on page 90).

! Remember that the appearance of notes and rests in 
the score is determined by the display quantize set-
tings on the Score Settings–Staff page. Depending 
on the display quantize “Notes” and “Rests” values, 
notes may be displayed as if they were longer than 
they really are (see “Display quantize” on page 56).
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Lengthening a note by gluing two notes together

You can create unusual note length values by gluing notes 
of the same pitch together.

1. Insert the notes you want to glue together (if they don’t 
already exist).

2. Select the Glue tool from the toolbar or Quick menu.

The Glue tool on the Quick menu.

3. Click on the first note.
This note will now be tied to the first following note with the same pitch.

4. If you want to glue more notes, click again.

By gluing together a quarter note, an eighth note and a sixteenth note…

…you get a double dotted quarter note.

Changing the display length
If you want to change the displayed length of notes with-
out affecting how they play back, the first thing to try is to 
adjust display quantize, either for the whole staff or for a 
separate section, using the Display Quantize tool (see 
“Inserting display quantize changes” on page 78). 

But you can also make display length adjustments to indi-
vidual notes in the Set Note Info dialog:

1. Double-click on the note.
The Set Note Info dialog opens.

2. Locate the “Displ. Length” setting.
By default, this is set to “Auto”, i.e. the note will be displayed according 
to its actual length (and the display quantize settings).

3. Double-click in the value field and enter a new length 
value (displayed in bars, beats, sixteenth notes and ticks).
To set the display length to “Auto” again, scroll the value down to zero.

4. Click Apply and close the dialog.
The note will now be displayed according to its display length setting. 
However, the display quantize settings still apply!

Splitting a note in two
If you have two notes strung together by a tie, and click on 
the “tied” note head with the Split tool, the note will be di-
vided into two, with the respective length of the “main” 
and the tied note.

Before and after splitting a tied note.

Working with the Display Quantize 
tool
There are instances when you will want different staff set-
tings for different sections of the track. The settings on the 
Score Settings–Staff page are valid for the entire track, 
but by using the Display Quantize tool, you are able to in-
sert changes and exceptions wherever you like. This is de-
scribed in detail in the section “Inserting display quantize 
changes” on page 78.

! Make sure you have display quantize values for notes 
and rests that allow you to display notes of the cre-
ated note value.
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Split (piano) staves

Setting up the split staff
1. Make a staff active.

2. Open the Score Settings–Staff page for the staff and 
select the Polyphonic tab.

3. From the Staff Mode pop-up, select Split.

4. Set the Splitpoint value to a suitable note.
All notes below this note value will be put on the lower clef, all above will 
be put on the upper clef.

Split mode selected.

• If the default piano clef settings for the upper and lower 
staff are not what you want, you can adjust these settings 
now (or you can make key and clef adjustments directly in 
the score, see “Setting key, clef and time signature” on 
page 65).

5. Make whatever additional staff settings you need.
These will apply to both the upper and lower staves of the split system.

6. Click Apply.

Before and after setting a split at C3.

Adding notes
This is done just as on a single system, see “Adding and 
editing notes” on page 84. Please note the following:

• When you enter a note, use the mouse position box (on the 
toolbar) to determine the pitch. Whether it ends up on the up-
per or lower staff has nothing to do with where you aim with 
the mouse. The Splitpoint setting always decides if a note 
goes on the upper or lower clef. If you change the splitpoint, 
this will affect existing notes, see below.

• Sometimes a fixed splitpoint isn’t good enough. You might 
want to put two notes with the same pitch on different staves 
in different parts of the score. To achieve this you need to use 
polyphonic voicing, see “Polyphonic voicing” on page 95.

Changing the splitpoint
1. Open the Score Settings–Staff page for the system 
you are working on.

2. Select the Polyphonic tab.

3. Change the Splitpoint value.

4. Click Apply.

Now, some notes that were previously on the lower staff 
will be on the upper, or vice versa.

Strategies: Multiple staves
As described above, when you have parts on several 
tracks selected in the Project window, these will be put on 
one staff each, when you open the Score Editor. This al-
lows you to work on several staves in parallel.

Working with several staves is not much different from 
working with one. Below follow some guidelines that apply 
specifically to working with multiple staves.

Score settings–Staff page
• The settings on the Score Settings–Staff page are local to 

each staff. You can have the Score Settings dialog open and 
select each staff in turn to make settings – just remember to 
click Apply before selecting another staff, otherwise your 
changes will be lost.
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• If several staves share settings, you will save some time by us-
ing staff presets. Set up the staff settings for the first staff, and 
save them as a preset. This preset can then be applied to any 
of the other staves, one at a time. See “Working with staff pre-
sets” on page 106 for details.

Selecting notes
• You can select notes from one or several staves at the same 

time, using any of the selection methods, see “Selecting notes” 
on page 86.

Adding notes
• You can add notes to any staff by clicking on it with the Insert 

Note tool. The active staff rectangle will move to the staff 
where you input the note.

• If you need to enter a note with a very high or low pitch, which 
makes it wind up on the wrong staff when you click, first enter 
a note with the wrong pitch, and then edit its pitch as de-
scribed in the section “Editing pitches of individual notes” on 
page 89.

Inserting and editing clefs, keys or 
time signatures
It is possible to insert a change of key, clef, or time signa-
ture anywhere in the score:

Inserting a symbol on one staff
1. Open the “Clefs etc.” tab in the Inspector.
This contains clef, key and time signature symbols.

The “Clefs etc.” tab in the Inspector.

2. Select the symbol you wish to insert.
When you move the mouse over the score display, the pointer takes on 
the form of a pencil (see also “About the Pencil tool” on page 132).

3. Move the mouse over the staff where you want to in-
sert a new symbol.
Use the mouse position box to find the exact location. The vertical posi-
tion is of no relevance as long as you click somewhere in the staff. Time 
signature changes can only be inserted at the beginning of a bar.

4. Click the mouse button to insert the symbol.

Inserting a symbol on all staves
If you hold down [Alt]/[Option] when you insert a symbol 
with the Pencil tool, it will be inserted at this position on all 
staves currently being edited in the Score Editor. Note:

Time signature changes are always inserted on all 
tracks in the score.
Or rather, they are inserted on the tempo track, which affects all tracks.

For key changes, display transpose is taken into 
account.
This allows you to set all staves to a new key and the staves set to dis-
play transpose will still show the correct key after the key change.

If some of the staves are bracketed (straight brackets 
only, as set up on the Score Settings–Layout page, see 
“Adding brackets and braces” on page 181), inserting a 
symbol for one of these staves will insert it for all other 
staves within the bracket.
Staves outside the bracket will not be affected.

Editing keys, clefs and time signatures
If you double-click on a symbol, a dialog appears allowing 
you to change the settings for it.

If you hold down [Alt]/[Option] when double-clicking, all 
symbols at the same position are changed accordingly. 
With key signatures, the display transpose value is taken 
into account as described above.

! Inserting a symbol at position 1.1.1.0 is the same as 
changing the staff settings which are stored in the 
track. Inserting anywhere else adds the change to 
the part.
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• On the Score Settings–Project page (Notation sub-
page), you will find several options for how key, clef and 
time signature changes should be displayed.
You can also adjust the automatic spacing between these symbols in the 
Spacings subpage. See the dialog help for details.

Moving clefs
Clefs inserted into the score have an effect on how notes 
are displayed. If you for example insert a bass clef in the 
middle of a treble staff, the staff switches to show bass 
pitches. Therefore it is very important where you insert the 
clef.

If you want to move the clef graphically, without disturbing 
the relation between the clef and the notes, proceed as 
follows:

1. Select the Layout tool.
This is available in Page Mode only.

2. Click and move the clef just as with the normal Object 
Selection tool.
Now the clef is moved, but the score is still interpreted as if it remained in 
its original position.

When you inserted a clef change in the score, you can 
decide whether this should have the same size as the first 
(default) clef symbol or whether it should be displayed 
with a smaller symbol. Simply right-click the symbol and 
activate or deactivate “Display Clef Changes as small 
Symbols”, respectively.

When “Warnings for new Clefs at Line Breaks” is ac-
tivated on the Clef context menu and you inserted a clef 
change at a line break in the score, the Clef change sym-
bol will be inserted in the last bar before the staff break. 
When this is deactivated, the symbol will be inserted in 
the first bar of the next staff line.

Deleting notes
Notes can be deleted in two ways:

Using the Erase tool
1. Select the Erase tool from the toolbar or Quick menu.

The Erase tool on the Quick menu.

2. Click on the note(s) you want to erase, one at a time or 
drag over them with the mouse button pressed to enclose 
them in a selection rectangle, and click on one of the notes.

Using delete menu item or the keyboard
1. Select the notes you want to delete.

2. Select Delete from the Edit menu, or press [Delete] or 
[Backspace] on the computer keyboard.
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About this chapter
In this chapter you will learn:

• How to decide when to use polyphonic voicing.
• How to set up voices.
• How to automatically convert your score to polyphonic voicing.
• How to enter and move notes into voices.

Background: Polyphonic voicing
Polyphonic voicing allows you to resolve a number of situ-
ations impossible to score properly otherwise:

• Notes starting at the same position, but with different lengths. 
Without polyphonic voicing you get unnecessary amounts of 
ties.

Without and with polyphonic voicing.

• Vocal scoring and similar. Without polyphonic voicing, all notes 
starting at the same position are considered parts of a chord. 
With polyphonic voicing you can give each voice a stem direc-
tion, you can have individual rest handling for each voice etc.

Without and with polyphonic voicing.

• Complicated piano systems. Without polyphonic voicing you 
have to resort to a fixed split note setting to decide which 
notes go on which clef. With polyphonic voicing the splitpoint 
can be “floating”. The program can even automatically put a 
bass line on the lower clef for you!

With a split system and with polyphonic voicing.

How voices are created
There are eight voices. The first thing you do is to set them 
up. This includes “telling” the program which voices be-
long to the upper clef and which belong to the lower, how 
you want rests displayed for each voice, etc.

The second thing you do is to move or enter notes into the 
voices. If you have a recording done already, the program 
can do much of this work for you, automatically. You might 
then want to fine tune by moving one or more notes into 
another voice, or you might want to add notes to a certain 
voice. See “Adding and editing notes” on page 84.

Overlapping notes
Throughout this chapter you will encounter the term “over-
lapping notes”. Two notes are considered overlapping 
when they are on the same staff and:

• They start at the same position, but have different note values 
(for example whole note and a quarter note both at the begin-
ning of a bar), or…

Notes starting at the same position, without and with polyphonic voices.

• One note starts before another has ended. For example a half 
note at the beginning of a bar and an eighth note at the sec-
ond beat.

A note that starts before another has ended, without and with poly-
phonic voices.

Voices and MIDI channels
Internally the program organizes the notes into voices by 
changing their MIDI channel values. Normally you set it up 
so that notes with MIDI channel 3 belong to voice 3 etc. 
Most of the time the link between MIDI channels and 
voices will be totally transparent to you as a user. Some-
times you can take advantage of this relationship, as de-
scribed later in this chapter. There are also a few other 
important things to note:

! Each voice is polyphonic. In other words, one voice 
can contain chords.
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Setting up the voices
This text describes the Polyphonic tab of the Score Set-
tings–Staff page in general. Below you will find more de-
tailed information on how to select from the multitude of 
options.

1. Open the Score Settings–Staff page for the staff.

2. Select the Polyphonic tab.

3. Pull down the Staff Mode pop-up and select Poly-
phonic.

This makes the voice list in the lower part of the dialog available. It con-
sists of eight rows, one for each voice. They are numbered and therefore 
we refer to them as voices 1 to 8.

4. To activate a voice, click in its “On” column, so that a 
tick mark appears.
There are four voices on each staff, for a total of eight. If you activate at 
least one “upper” voice and one “lower” voice, you will get a split (piano) 
staff.

5. If you have particular reasons to use specific MIDI 
channels, change the “Chan” settings for the voices.
The program automatically sets each voice to a different MIDI channel. If 
you don’t have good reasons to make changes, leave the settings as they 
are.

6. Click in the “Rests–Show” column to decide for which 
voices you want rests displayed.
A tick mark indicates that rests will be shown for a voice. Often you will 
only want rests to be shown for one voice per staff, see below.

! When you make a note part of a voice, you are in fact 
changing its MIDI channel value.
However, when you change the voice’s MIDI channel 
values in the setup dialog, this does not affect the 
notes’ MIDI channel setting. This can lead to serious 
confusion, since the relationship between the notes 
and the voices is affected. It might even make notes 
disappear (the program will warn if this happens). In 
other words, don’t change the MIDI channels on the 
Polyphonic tab on the Score Settings–Staff page af-
ter you have put your notes into voices, unless you 
are absolutely sure of what you are doing. Also 
please note that when you open a part that contains 
notes on different MIDI channels, these notes are in 
fact already assigned to voices (since notes are as-
signed to voices using their MIDI channel setting). 
While this fact can be put to good use, it can also 
create confusion, and even disappearing notes, as 
described above.

! You can also convert existing tracks into polyphonic 
voices automatically, using the Merge All Staves 
function.

! Do not confuse the voice numbers with the MIDI 
channel setting for each voice.

! Please note the warnings about changing the MIDI 
channel settings in the section “Voices and MIDI 
channels” on page 96. Also note that if two voices 
are set to the same MIDI channel, the lower will be 
treated as if it were turned off.
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7. If you have activated “Rests–Show” for a voice, but 
don’t want rests to be shown in empty bars, click in the 
“Rests–Reduce” column for that voice.
This is especially useful for cue voices, see “Cue notes” on page 123.

8. Click in the “Rests–Center” column to determine at 
which vertical positions rests should be shown (for voices 
with “Rests–Show” activated).
When this option is activated for a voice, the rest will be put in the verti-
cal center of the staff, when it is not, the rest will get a vertical position 
based on the pitch of the notes.

9. Decide on a stem direction for each voice, by select-
ing from the pop-up in the Stems column.
If you select Auto, the program will make decisions about which stems go 
in which direction (just as when not using polyphonic voices). You can al-
ways force stem direction for individual notes by using the Flip Stem 
function, see “Flipping the stem of one or several notes” on page 111.

10. If you want the notes in a voice to be smaller than reg-
ular notes, put a tick mark in the Cue column for the voice.

11. Click Apply.
The staff is changed to polyphonic voicing, and the program distributes 
the existing notes into voices according to their MIDI channel values.

• At this point you may want to use the Explode function 
to automatically move notes into the proper voices. See 
“Automatically – the Explode function” on page 100.

If the “Some Notes Do Not Belong To 
Voices…” dialog appears
When you click Apply, a warning may appear saying “Some 
notes do not belong to any voice and may be hidden. Cor-
rect these notes?”.

This warning appears when the staff contains notes with 
MIDI channel settings which do not match any of the ac-
tive voices.

If you click the “Correct” button, these notes will be moved 
to active voices. If you click “Ignore”, nothing will be 
changed, and some notes will be hidden. However, they are 
not lost, they appear in all other editors and can be made to 
appear again in the Score Editor if you change the channel 
settings for the notes or voices, activate more voices, etc.

About the polyphonic presets
The Presets pop-up menu on the Polyphonic tab (below 
the list of voices) contains three very useful setups. In-
stead of making settings by hand, you can select one of 
the presets, saving some time. The presets are:

Variable Split

This sets up the dialog for two voices, one on each staff, 
each with auto stem direction. This is a good starting point 
for a piano staff when the fixed split option doesn’t suffice.

Optimize two voices

In this preset, only voices 1 and 2 are activated, and set 
up like this:

This way the first voice behaves as in single staff mode, 
but if there are notes in the second voice, the stems of the 
first one are set to Up.

Optimize four voices

This is like “Optimize Two Voices”, but with two staves. 
Voices 5 and 6 are activated as well, with the same set-
tings as voices 1 and 2. This is the recommended way to 
write piano music.

! There is a special stem feature for voice 1: If you set 
this to Auto, the stem direction will depend on the 
pitch of the note as usual – except if there are voice 
2 notes in the bar, because then the voice 1 stems 
will automatically be set to Up!
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Strategies: How many voices do I 
need?
Well, it depends…

• If you are scoring for vocals, you simply need one voice for 
each voice, so to speak.

• Often you will use voices for resolving the problem of overlap-
ping notes (see “Overlapping notes” on page 96), for example 
when scoring for piano. In this case, you will need two voices 
each time two notes overlap. If three notes overlap, you will 
need three voices. In other words you will need to check for 
the “worst case” (largest number of overlapping notes at a 
certain position) and activate that many. If you don’t know how 
many notes you need when starting out to prepare a score, 
don’t worry, you can add more voices later.

• Voices 1 and 2 on the upper staff and 5 and 6 on the lower 
are special. These handle “collisions” (notes with small inter-
vals, accidentals that otherwise would come too close, etc.) 
automatically which the other voices don’t. Always use these 
voices first!

• An example: in the situation below, three voices are required. 
The lowest note overlaps both the “melody” and the chords, 
so it can’t share a voice with the chords. The chords overlap 
the melody, so they can’t share a voice either.

Entering notes into voices
When you add new notes, you need to decide which 
voice they go into:

1. Make sure the extended toolbar is visible.

2. Select the Object Selection tool.

3. If you have a split system, check the voice Insert 
buttons.
These are displayed after the text “Insert” on the left side on the extended 
toolbar. Only the voices that are activated on the Polyphonic tab are 
shown. If the upper staff is active, the voice Insert buttons are numbered 
1, 2, etc., otherwise they are numbered 5, 6, etc.

Here three voices are available on the upper staff.

4. If you need to switch the voice icons to the right “clef”, 
click somewhere in the system you want to insert notes in.

5. Select one of the voices by clicking on the corre-
sponding button.
Any notes you enter from now on will be inserted into that voice.

Voice 3 activated for insertion.

6. Insert the notes as usual, see “Adding and editing no-
tes” on page 84.

7. If you want to switch to another voice, click the corre-
sponding button.

8. If you want to insert notes into a voice on the other 
clef, click on that clef and then select a voice using the 
buttons.

Symbols and voices
Later in this manual you will learn about symbols that can 
be added to the score. Many of these symbols must also 
be put into a particular voice. See “Important! – Symbols, 
staves and voices” on page 132.

Checking which voice a note 
belongs to
When you select one (and only one) note, the correspond-
ing voice button on the extended toolbar is selected. This 
allows you to quickly find out which voice a certain note is 
in (after you have used the Move To Voice function, for ex-
ample).

• When you step through the notes using the arrow keys, 
you will only step through the notes in one voice at a time. 
This can be used as a quick way to check which notes belong to the 
same voice as some other note.
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Moving notes between voices

Manually
To manually move notes to a particular voice, proceed as 
follows:

1. Select the note(s) you want to move to a particular 
voice.

2. Right-click on one of the notes and select “Move to 
Voice” from the context menu that appears.

Move to Voice and the submenu it invokes.

3. On the submenu, select the voice to which you want 
to move the notes.
Voices not activated are not shown.

• Alternatively, you can press [Ctrl]/[Command] and click 
a voice Insert button on the extended toolbar to move the 
selected notes to the corresponding voice.
You can also assign key commands for this in the Score Functions cate-
gory of the Key Commands dialog on the File menu.

Automatically – the Explode function
The Explode function distributes notes, either into new 
tracks (see “The Explode function” on page 79) or into 
polyphonic voices:

1. Pull down the Scores menu and select “Explode…” 
from the Functions submenu.

The Explode dialog, set to create polyphonic voices.

2. Make sure “To Polyphonic Voices” is selected at the 
top of the dialog.

3. Use the options in the lower half of the dialog to set up 
the criteria for the split.
Choose from the following options:

4. Click OK.

The notes are distributed to different voices.

Option Description

Split Note Use this to move all notes below a certain pitch to another 
voice.

Lines To Tracks Use this when you want all musical “lines” to be put in one 
voice each. The notes with the highest pitch will go to the 
first voice, the notes with the second highest pitch will go 
to the second, and so on.

Bass To Lowest 
Voice

When this is activated, the lowest notes will always end 
up in the lowest voice.
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Alternative ways of handling voices
Below we suggest further “advanced” ways of putting 
notes into voices. This is based on the relation between 
voices and MIDI channels, so please make sure you un-
derstand how this connection works.

• You can use the Logical Editor (see the chapter “The Logical 
Editor, Transformer and Input Transformer” in the Nuendo Op-
eration Manual) to put notes into voices, based on other more 
complex criteria, like for example their pitch and length. This is 
done by setting up the Logical Editor so that the notes that 
meet the criteria get their MIDI channel changed to that of 
their voice.

• When you enter notes using step input you can change the 
MIDI channel on your input device and directly enter notes into 
separate voices.

• You can play back each voice on a different MIDI channel, 
simply by setting the track to Any. This can be used as a con-
venient way of “proof-hearing” each voice separately.

• You can use the Input Transformer to assign a certain key 
range to a MIDI channel, and thereby automatically put notes 
into voices when recording.

• For brass and vocals, you might record each voice on its own 
track, and use the “Merge All Staves” function to automatically 
copy each recording to a separate voice on a new track (see 
“Automatic polyphonic voicing – Merge All Staves” on page 
103).

• When you have assigned parts to voices, you can use the Ex-
tract Voices function to create one track out of each voice (see 
“Converting voices to tracks – Extract Voices” on page 104).

Handling rests
With polyphonic voices you often get more rest symbols 
than desired.

• If a voice doesn’t need any rests at all, you can deacti-
vate rests for each voice individually on the Polyphonic tab 
on the Score Settings–Staff page.

• If you only need rests from one voice on a staff, activate 
Rests–Center for that voice (this is done in the same dia-
log). If two or more voices have rests, deactivate Rests–
Center. The program then automatically makes sure the 
rests don’t “collide” in the score, by adjusting their vertical 
position.

• To avoid having several rests displayed in empty bars, 
you can activate the Rests–Reduce option for all voices 
(that have rests) except one. This option causes the pro-
gram to hide rests in empty bars.

• You can use the Hide feature (see “Hiding/showing ob-
jects” on page 174) to totally remove individual superflu-
ous rests from the score.

• You can use the Object Selection tool to manually move 
rests up/down or sideways to adjust the “picture”.

• If needed you can add “rest symbols” (rests that don’t 
affect the playback data in any way) by using the symbols.

Voices and display quantize
When you insert display quantize changes (see “Inserting 
display quantize changes” on page 78), you can either ap-
ply the settings to all voices (by [Alt]/[Option]-clicking with 
the tool) or to the current voice only.

Making display quantize settings affect one voice only (by 
clicking without pressing [Alt]/[Option]) allows you to do 
two things:

• Make each voice have its own display quantize settings 
by inserting a display quantize event for each voice, at the 
beginning of the staff. This will then be valid for the entire 
staff, until another display quantize event is inserted.

• Insert display quantize “exceptions” anywhere in the 
score, independently for each voice. Proceed as follows:

1. Make sure the option “Display Quantize tool affects all 
Voices” is deactivated.

2. Select the voice for which you wish to insert a display 
quantize event.
This is done by clicking at the corresponding voice button on the ex-
tended toolbar as described above, or by selecting a note that belongs 
to this voice.

! If “Display Quantize tool affects all Voices” is acti-
vated on the “Notation Style” subpage (Miscellaneous 
category) of the Score Settings–Project page, the 
display quantize settings will always affect all voices 
(even if you don’t press [Alt]/[Option] and click).
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3. Select the Display Quantize tool.

4. Click at the position you want to insert the event.
The Display Quantize dialog appears.

5. Fill out the dialog as described in the section “Display 
quantize” on page 74. 

6. Click Apply.

Creating crossed voicings
Often, for example in vocal scoring, you will have crossed 
voicings on one system. You can of course move notes 
manually into voices to get the stem direction and other 
note properties right, but there’s a quicker way. Let’s ex-
plain how to do this by example. Without using polyphonic 
voicing, you have entered this:

1. Open the Score Settings–Staff page and select the 
Polyphonic tab.

2. From the Staff Mode pop-up menu, select Polyphonic.

3. Activate voice 1 and 2 only, and make settings for 
them as in the picture below.

4. Click Apply.
The staff is in Polyphonic staff mode, but all notes are still in the same 
voice.

5. Pull down the Scores menu and select “Explode” from 
the Functions submenu.

6. In the dialog that appears, select the “To Polyphonic 
Voices” option and activate “Lines To Tracks”.
Leave the other options off.

7. Click OK.
The notes have now been split in two “lines”, each in a separate voice. 
However, from the middle of the bar, notes that are in voice 1 should be 
in voice 2 and vice versa.
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8. Select the two notes that should be moved from voice 
1 to voice 2.

Two notes in voice 1 selected.

9. Move the notes to voice 2.
The quickest way to do this is to press [Ctrl]/[Command] and click the 
voice Insert [2] button on the extended toolbar.

Two notes moved to the right voice.

10. Select the two notes that should be moved to voice 1 
and move them too.

All notes in the right voices.

The voicing is now correct, as you can tell from the stem 
directions. However, there's still some work to do on the 
notes graphical positions (see “Graphic moving of notes” 
on page 122) and the display of stems and beams for 
some of the notes (see “Manual adjustment of beams” on 
page 120). When you have made those adjustments, the 
score may look like this:

After graphical adjustments.

Automatic polyphonic voicing – 
Merge All Staves
If you have already created some tracks which look and 
play back as they should, and you want to combine these 
into one track with polyphonic voices, there is a special 
function on the Scores menu for this:

1. Open the tracks (up to four) in the Score Editor.

2. Pull down the Scores menu and select “Merge All 
Staves” from the Functions submenu.
Now a new track is created and shown in the score. The track will have 
polyphonic voices activated, and the four original tracks will be assigned 
to one voice each (voices 1, 2, 5 and 6 will be used).

Furthermore, all non-linked symbols that belong to the staff that will be-
come the first polyphonic voice in the merged staff will be copied. They 
will have the same positions as the original symbols. 

! When you later play back the music, you need to mute 
the four original tracks, or you will get double notes. 
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Converting voices to tracks – 
Extract Voices
This function does the opposite of “Merge All Staves” – it 
extracts polyphonic voices from an existing track and cre-
ates new tracks, one for each voice. Proceed as follows:

1. Open a track containing 2 to 8 polyphonic voices in the 
Score Editor.

2. Pull down the Scores menu and select “Extract 
Voices” from the Functions submenu.
A number of new tracks is created and added to the display of the Score 
Editor. Each track will contain the music from one polyphonic voice. If 
there were non-linked symbols in the original track, each new track will 
get a copy of these symbols. 

! When you later play back the music, you need to 
mute the original track (the one with polyphonic 
voices), or you will get double notes. 
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About this chapter
In this chapter you will learn:

• How to make staff settings.
• How to work with staff presets.

Staff settings
Below follows a run-through of all staff settings, more de-
tailed information about the ones already described and 
references to other places in the manual for some options.

Making settings
1. Open the Score Settings–Staff page.

2. With the dialog open, make the desired staff active.
Click anywhere in a staff to make it active, or use the up and down arrow 
keys to step from staff to staff.

3. Select the desired tab and make whatever settings 
you need to do.
The settings for regular staves are found on the Main and Options tab, 
the Polyphonic tab contains settings for split systems and polyphonic 
voices while the Tablature tab lets you set up tablature scores.

4. When you have made the desired settings, click Apply.
The settings are applied to the active staff.

If the option “Apply closes Property Windows” is acti-
vated in the Preferences dialog (Scores-Editing page), 
clicking Apply will also close the dialog.

5. Select another staff, make settings for this and click 
Apply.
Repeat this until all staves have the right settings.

6. If you want to close the dialog, click its close box as 
usual.

Working with staff presets
You will spend some time making staff settings for your 
scores. Staff presets allow you to reuse those settings 
whenever you work with a staff similar to one you have 
worked on before. A staff preset contains all the settings 
on the Score Settings–Staff page, except for the key.

• To store the current settings (including the settings on 
the Options tab, see below) click the Store button in the 
Presets section of the Staff page.
Enter a name for the preset in the name dialog that appears, and click 
OK. The preset will now be available on the Presets pop-up menu (in all 
projects).

Use this section to 
set up how the dis-
play should be 
quantized – the dis-
played spacing and 
length of notes.

This section contains ad-
ditional settings for how 
the notes are displayed.

Use this 
section to 
select keys 
and clefs.

Use this section to select and apply 
presets, or turn the current settings 
into a preset.

This is where you enter the 
name for the staff. Normally, 
the long name is shown at the 
beginning of the score, while 
the short name is shown for 
the remaining systems.

This is where you specify 
the display transpose for 
instruments that are not 
scored in concert key.

The Staff page has four tabs – here, the Main tab is selected.

! Staff settings can be saved in the track presets. For 
more information, see the chapter “Track Presets” in 
the Nuendo Operation Manual.
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• To load a preset, select it on the Presets pop-up menu.
Note that this loads the settings in the preset into the dialog – to apply 
these to a staff you must click the Apply button as usual. You can also 
apply staff presets directly in the score – see below.

• To remove a preset, select it from the pop-up menu and 
click the Remove button.

Applying a preset directly in the score
If you right-click on the blue rectangle to the left of a staff, 
a context menu will appear, listing all available presets. 
Select one to apply it to the staff.

How staff presets are stored
The staff presets are stored as individual files in the Pre-
sets–Staff Presets folder within the Nuendo program 
folder. The presets are available for selection in any project 
you create or edit.

Staff names

These fields allow you to specify a “long” and a “short” 
name for the staff. The long name is shown for the very first 
system for this staff in the score (at the start of the project), 
while the short name is shown for the remaining systems.

• Whether the names should be shown at all is set on the 
Score Settings–Layout page (see “Staff names” on page 
162).
Here, you can also opt to use the names of the edited MIDI tracks instead.

• If you only want the “long name” to be shown (i.e. if you 
don’t want a name shown for each system in the score), 
simply delete the short name.

• If the option “Show Long Staff Names on new Pages” is 
activated in the “Staff Names” section of the Score Set-
tings–Project page, the long name will be shown at the 
beginning of each new page.

• You can also specify two separate subnames by dou-
ble-clicking the staff name and entering them in the upper 
and lower text entry fields in the dialog that appears. 
Note that this will only be displayed correctly, if you are in Page Mode and 
if “Show Track Names to Left of staff” is activated on the Notation Style 
subpage (Staff Names category) of the Score Settings–Project page.

The Edit Staff Name dialog

Key and clef

The basic key and clef settings are described in detail in 
the section “Setting key, clef and time signature” on page 
65. There is also a Lower Staff check box which is only 
used in conjunction with split (piano) staves and poly-
phonic voicing (see “In a split system” on page 68).
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Display quantize and interpretation 
options

These two sections of the dialog contain a number of set-
tings used to determine how the notes should be inter-
preted. While these settings are more critical to making 
MIDI recorded music appear as legible as possible it is still 
important to have them set correctly when entering notes 
using the mouse. Below you will find a brief summary of the 
settings – for more details, see “Display quantize” on page 
74.

Notes and Rests display quantize values
• Generally, the Notes display quantize value should be set to a 

value equal to, or smaller than, the “smallest note position” you 
want to be shown in the score.

• The Rests display quantize value should be set to a value 
equal to, or smaller than, the smallest note value (length) you 
want to be displayed for a single note, positioned on a beat.

• If the score contains only triplets, or mostly triplets, select one 
of the Triplet options.

Auto Quantize
• If the project contains no triplets or only triplets, deactivate 

this option.
• If the project contains mixed triplets and straight notes, acti-

vate this option (see “If your music contains mixed straight no-
tes and triplets” on page 74).

Interpretation options

Display transpose
This is used when preparing parts for instruments that are 
not scored at the actual concert key. For example, if you 
want the note C3 to be played by an alto sax, you have to 
score it as an A3 – nine semitones up. Luckily, the display 
transpose setting takes care of this for you:

• Use the pop-up menu to select the instrument for which 
you’re scoring.

• If the pop-up menu doesn’t list the desired instrument, 
you can set the desired transposition with the Semitones 
value field.

The display transpose setting doesn’t affect playback 
or the actual pitch of the notes – it only changes how they 
are displayed and printed.

You can also insert display transpose changes anywhere 
in the score, by inserting a key change symbol and using 
the Transpose setting in the Edit Key/Clef dialog (see 
“Display transpose in the Edit Key dialog” on page 70).

• On the Score Settings–Project page (“Chord Symbols” 
subpage), deactivate the option “Use Display Transpose” 
if you do not want the chord symbols to be affected by the 
display transpose setting (see “Chord Symbols” on page 
153).

• You can disable display transpose by clicking on the 
button “Disable Display Tranpose” in the toolbar of the 
Score Editor. 

Option Description

Syncopation Activate this when the program adds more ties to notes 
crossing beats and bar lines than you prefer. See “Syn-
copation” on page 74.

Consolidate 
Rests

Activate this when you want two rests joined to one (for 
example an eighth note and a sixteenth note rest displayed 
as a dotted eighth note rest). See “Consolidate Rests” on 
page 75.

Clean Lengths Activate this when you find the program generally inter-
prets your notes as shorter than you expect. See “Clean 
Lengths” on page 75.

No Overlap Activate this when notes starting at the same position, 
but having different lengths, give you more ties than you 
want. See “No Overlap” on page 75.

Shuffle Activate this when you have played a shuffle beat and 
want it displayed as straight notes (no triplets). For details 
see “Shuffle” on page 76.
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The Options tab

Clicking the Options tab in the dialog brings up another 
page with additional settings (which can be made part of a 
staff preset just like the other settings). Below follows a 
brief description of these, with references to more detailed 
explanations.

Switches

System Sizes
This section allows you to set the number of system lines 
and to control spacing between the lines:

See “Creating tablature manually” on page 191 for an ex-
ample of how this can be used with tablature.

Score Drum Map
These settings are all described in the chapter “Scoring 
for drums” on page 185.

Fixed Stems
If you activate this checkbox, the stems of all notes will 
end at the same vertical position. This feature is perhaps 
most often used when scoring for drums (see “Setting up 
a staff for drum scoring” on page 188).

A drum pattern with Fixed Stem length activated.

The Up and Down parameters determine which position 
(relative to the top of the staff) should be used for up and 
down stems, respectively. The graphical display helps you 
get your settings right. 

Note Limits
Use the Low and High fields to specify a note range. In the 
active staff, any notes outside this range will be displayed 
in a different color. When writing a score for a specific in-
strument, this makes it easy to find notes that are outside 
of this instrument’s note range.

If the option “Hide Notes beyond Limits” is activated in 
the Preferences dialog (Scores-Editing page), any notes 
outside the Note Limits range will be hidden.

The Polyphonic and Tablature tabs
These are described in the chapters “Polyphonic voicing” 
on page 95 and “Creating tablature” on page 189, re-
spectively. For now, just note that the Polyphonic tab con-
tains the Staff Mode pop-up, which determines whether 
the staff should be a single system, a split (piano) staff or 
use polyphonic voices.

Option Description

Flat Beams Activate this when you want the beams over notes to be 
flat (as opposed to slanted). See “Beam appearance and 
slant settings” on page 120.

No Beams Activate this when you don’t want any beaming at all on 
the staff (for example for vocal scoring). See “Turning be-
aming on/off” on page 116.

Beam 
Subgroups

Activate this when you want sixteenth notes displayed 
under a beam to be divided into two groups of eight 
notes. See “Handling beam groups” on page 119.

16th 
Subgroups

Use this when you want even smaller subgroups of six-
teenth notes. This setting has no effect if Beam Sub-
groups is deactivated.

Option Description

System Lines The number of lines in a system. For regular scoring, this 
should be set to 5.

Add Space Allows you to increase or decrease the space between 
the lines in a system.

Size Allows you to set a size for the systems, as a percentage 
(with 100% being the default value). In effect, this setting 
scales the score vertically.

Option Description
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About this chapter
In this chapter you will learn:

• How to control stem direction.
• How to control beaming, and create cross staff beaming.
• How to make detailed adjustments to note appearance.
• How to perform “graphic moving” of notes.
• How to create grace notes.
• How to create tuplets.

Background: Note stems
The direction of stems is governed by five things:

• How notes are grouped under beams.
• Any manual manipulation of beams.
• The Flip Stems function.
• How the note information is set for each note.
• How the Polyphonic tab on the Score Settings–Staff page is 

set up (if you use polyphonic voices).

Also, there is a priority system with these steps, as they 
are listed above. In other words, if you have adjusted the 
beam slant “by hand” (see below), it doesn’t matter if you 
previously flipped the stems, or how the note was set up. If 
you have flipped the stems it doesn't matter how the notes 
or voices were set up, etc.

Setting stem direction

In polyphonic voices

On the Score Settings–Staff page (Polyphonic tab), stem 
direction can be set separately for each voice.

This is the stem setting with the lowest priority. It is only 
valid if no other settings were made specifically.

Using Flip Stems

Flipping the stem of one or several notes

1. Select the note(s).

2. Click the Flip icon on the extended toolbar.
All the stems in the selection are now flipped. Those that pointed up now 
point down and vice versa.

• You can also assign a key command for this.
In the Key Commands dialog on the File menu, the command is called 
“Flip” and is found in the Score Functions category.

• You can also right-click a note or a selection of notes 
and select the Flip option from the context menu.

Flipping the stems of notes grouped under a beam

1. Select any note in the group.

2. Invoke Flip as described above.
The entire group is now flipped. 

Before and after the flip. No matter which note you select, the entire 
group is flipped.

! If you have edited the stem length of a note and then 
flip it, the stem will be reset to default length.

! If you have activated the “Fixed Stems” option on the 
Score Settings–Staff page (Options tab, see “Fixed 
Stems” on page 109), a lot of the automatic stem 
length settings are ignored. However, you can still 
edit the stem length and direction of individual notes.

The voice stem settings

! This will not work if you have adjusted the slanting of 
the beam by dragging. If you have, you must first re-
set the beam as described in the section “Stem 
length” on page 112.

The Flip icon
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Independent stem direction under a beam
If you need stems attached to the same beam to go in dif-
ferent directions, this is achieved by dragging the beam’s 
start and end points, as described in the section “Manual 
adjustment of beams” on page 120. This feature is avail-
able in Page Mode only.

Independent stem direction under a beam.

Stem direction in the Set Note Info dialog
The Set Note Info dialog can be opened by double-click-
ing on a note head, as described below. In its lower left 
corner you will find a pop-up for setting stem direction.

The Set Note Info dialog with the Stem pop-up.

• Setting this pop-up to Up or Down is the same as using Flip 
Stems, see “Using Flip Stems” on page 111. 

• Setting this pop-up to Auto makes the program set the stem 
direction automatically. 

Stem length

Adjusting stem length (Page Mode)
1. Click on the end of the stem so that a handle appears.

The stem handle selected.

2. If you want to change the lengths of several stems at 
the same time, hold down [Shift] and select these stems 
as well.

3. Drag the stem handle (on one of the selected stems) 
up or down.
All selected stems will be lengthened or shortened by the same amount.

Resetting stem length and beam slants
1. Make sure the display filter bar is visible (if not, click the 
Show Filter View button in the toolbar).
For more about the filter bar, see “Showing and hiding “invisible” ele-
ments” on page 64.

2. Make sure the “Stems/Beams” checkbox is activated 
on the filter bar.
Now, below the notes where stems have been changed or beam slant 
adjusted manually, the word “Stem” will appear.

3. Click on the “Stem” text to select it.

4. Press [Backspace] or [Delete] to remove it.

Before and after deleting the “Stem” item.
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Accidentals and enharmonic shift

Making global settings
On the Score Settings–Project page (Accidentals sub-
page), you will find a number of options for how acciden-
tals are displayed in the score. Once set, these are valid 
for all tracks in the project. Proceed as follows:

1. Open the Score Settings–Project page and select the 
Accidentals subpage from the list displayed on the left.

The Accidentals subpage on the Score Settings–Project page.

Now, you can use one of the following possibilities:

• Activate the option “Courtesy Acc Distance” and enter 
a value in the bars field.
This determines after how many measures courtesy accidentals should 
be shown. If you set this to “0”, notes outside the scale get accidentals 
and no courtesy accidentals are shown.

• Activate one of the following options by clicking on the 
graphics:

2. With the radio buttons to the right, you can decide 
how five of the most common intervals outside the scale 
should be displayed, as sharps or as flats.

Enharmonic shift
If one or several notes are not displayed with the acciden-
tals you wish, you can perform an Enharmonic Shift on 
them.

1. Select the notes to be shifted.

2. Click the desired option on the extended toolbar.

3. If the enharmonic shift should be repeated in the whole 
bar, activate the option “Enharmonic shift for entire bar” in 
the Score Settings–Project page, Accidentals subpage.Option Description

Force Notes outside the scale get accidentals and accidentals 
are repeated even within the same measure.

Force all Every single note in the score gets an accidental.

! When you activate the option “Accidentals for Each 
Note” in the Notation Style subpage of the Score 
Settings–Project page (in the “H.W. Henze Style” 
category), all notes will be displayed with accidentals 
(even tied notes).

Option Description

Use these buttons when you want regular Enharmonic 
Shifting (select one option).

Use this button when you want to deactivate Enharmonic 
Shifting for the note(s).

Use this button when you want to hide the accidental 
completely.

Use this button when you want to create a “help acciden-
tal” for the selected note(s) only. For more info see the 
global Help option (on the Score Settings–Projects–
Accidentals subpage) described above.

Use this button when you want to enclose the accidental 
in parentheses. To remove these, select “off”.
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Changing the note head shape
1. Select the notes for which you wish to change the note 
head shape.
Make sure not to select the stems, only the note heads.

2. Open the Set Note Info dialog.
To do so, double-click one of the notes, click the “i” button on the ex-
tended toolbar, or right-click on a note head and select “Properties” from 
the context menu.

3. Pull down the “Note Head” pop-up menu in the top 
left corner of the dialog.
The pop-up menu contains all the available head shapes and an “Auto” 
option, which selects the normal default shape for the note.

The Note Head menu.

4. Select one of the note heads.

5. Click Apply.
The settings are applied to the selected note(s).

6. If you like, select other notes and make settings for 
them.
When you are done, close the dialog by clicking its Close button.

Other note details
Each note has a number of settings in the Set Note Info 
dialog.

• To open the Set Note Info dialog, double-click on a 
note, select a note head and click the “i” button on the ex-
tended toolbar, or right-click on a note head and select 
“Properties” from the context menu.

• If the Set Note Info dialog is already open, you simply 
select the desired notes, adjust the settings in the dialog 
and click Apply.
The settings are applied to all currently selected notes.

The Set Note Info dialog contains the following settings:

Get Info

Option Description

Note Head Used for selecting custom note head shapes (see 
“Changing the note head shape” on page 114).

Tablature on/off 
and number

Used for creating or editing tablature (see “Creating tabla-
ture” on page 189). This feature can be used for individual 
notes or together with the automatic tablature function.

Bows pop-up 
menu

Used for adding bow up/bow down articulation. When 
selecting “Off”, bow symbols will not be displayed for the 
selected notes.

Bow up and down

Display Length This allows you to change the displayed length of notes, 
without affecting playback. Note that the display quantize 
settings still apply (see “Notes and Rests display quan-
tize values” on page 108). To reset this value to “Auto” 
(so that notes are displayed according to their actual 
length), scroll the value down to zero.

Accidental 
Distance

Use this to specify how far from the note, horizontally, you 
want the accidental. The higher the number the greater 
the distance.

No Ledger 
Lines

Turns off ledger lines for notes with high or low pitches.

With and without ledger lines
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Coloring notes
You can assign colors to notes using the color pop-up 
menu on the toolbar.

1. Simply select the notes for which you wish to use col-
ors, click the Color Scheme Selector field to the right in the 
toolbar and pick a color from the pop-up menu.
Only the note heads will be colored. Note that the color will only be visi-
ble once the notes have been deselected.

2. On the far right in the Score Editor toolbar you will find 
the Hide Colors button.
If you assigned colors to some or all of the notes in your score, this but-
ton allows you to switch between display of colored or uncolored notes. 
This may help you to find selected notes among other colored notes.

If the Preferences dialog (Scores–Colors for Additional 
meanings page) you can specify different colors for ele-
ments in the score in order to indicate that they are “spe-
cial” in any way. You can for example chose a color for a 
“Moved Graphic” or a “Moved Slur”. These objects will be 
colored accordingly when they are moved from their default 
positions (see “About moving note symbols” on page 142).

1. Open the Preferences dialog (Scores–Use Colors for 
Additional meanings).

2. Click in the Active column to activate this function for 
the respective element.

3. Click in the color field to the right to specify the de-
sired color.

The colors will be included when you print the score.
When color-printing a score, you will get the colors you selected for the 
notes. When you are using a black-and-white printer, the notes will appear 
in black (notes that have not been assigned a color) and different shades 
of grey (depending on how bright/dark a color was used for the note).

No Stem Hides the note stem completely

No Flag/Beam Activate this to hide the flags or beams of the selected 
note(s).

Bracket Head When this is activated, notes will be displayed with 
brackets:

Bracket Head off and on.

X Stem 
(Spoken)

When this option is activated for a note, it is displayed 
with an x across its stem. This is normally used to indicate 
spoken words.

Hide Note Ticking this checkbox will hide the selected note(s).

Stem pop-up 
menu

Determines the stem direction, see “Using Flip Stems” on 
page 111.

Tie pop-up 
menu

Determines the direction of ties. When this is set to “Auto” 
(the default setting) the program will choose a tie direction 
depending on the stem direction of the tied notes.

Type pop-up 
menu

Determines the note type. There are four options:
– Normal. This is how notes usually are displayed.
– Grace. When this is selected, notes will be displayed as 
grace notes. This is described in detail on “Grace notes” 
on page 123.
– Cue. When this is selected, notes will be displayed as 
cue notes (smaller notes, often used as “guide notes” or 
optional lines). See “Cue notes” on page 123.
– Graphic. These are special notes, useful for example for 
guitar notation (pull-offs) and trills (as “help notes”, indi-
cating which notes to trill between). In both these cases 
the “No Stems” option could be useful. 
Graphic notes are not included in the “automated cutting” 
(see “The Cut Notes tool” on page 121). They are posi-
tioned after the note(s) they “belong to” (as opposed to 
grace notes).

Crossed Activate this option, when you want the stem to be 
crossed by a slanted line (to indicate that the note is a 
grace note).

Grace note 
options

These options are available when Grace is selected on 
the Type pop-up menu. See “Grace notes” on page 123.

Option Description
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Copying settings between notes
If you have made various settings in the Set Note Info dia-
log for a note, and want to use these settings for other 
notes as well, there is an easy way to do this:

1. Set up the first note as desired.
This includes the settings in the Set Note Info dialog, but also any note-
related symbols (such as accents, staccato, articulation, etc. – see “Ad-
ding note symbols” on page 132).

2. In the score, select the note and select “Copy” from 
the Edit menu.

3. Select the notes to which you want to copy the at-
tributes.

4. Right-click the notes to which you want to copy the at-
tributes, and select “Paste Note Attributes” from the con-
text menu.
The selected notes will now get the attributes of the first, copied note, 
but their pitches and note values will remain unchanged.

Handling beaming

Turning beaming on/off
Beaming is enabled/disabled independently for each staff.

1. Click the Options tab.

2. To turn off beaming, activate No Beams and click 
Apply.

Even if beaming is deactivated for the staff, you can put 
some notes under beams, as described below.

Grouping
When beaming is on, the program automatically groups 
notes under beams. However, there are a number of ways 
to determine how notes are grouped.

Using the Edit Time Signature dialog

The time signature for the score naturally affects grouping. 
But you can control this yourself by creating a composite 
time signature used only for grouping:

1. Open the Edit Time Signature dialog by double-click-
ing the time signature symbol for the staff.

2. Set up the numerator with the grouping you desire.
If you for example want eighth notes in two groups of three and one 
group of two, enter 3+3+2.

3. Set the denominator, if necessary.

4. Activate “For Grouping Only”.

The time signature dialog with “For Grouping Only” activated.

5. Click OK.

! Please note that the “For Grouping Only” setting only 
affects the way the numerator is divided. Any changes 
you make to the “sum” of the numerator number or the 
denominator will result in a change of actual time sig-
nature in the project. If you need a grouping which 
can’t be entered in the current time signature, you will 
have to group notes manually, see below.
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Regular grouping of a number of eighth notes or smaller 
(“Beam”)

If the grouping the program assigns isn’t the one you 
want, you can put any selection of eighth notes or smaller 
under a beam:

1. Select at least two notes, where you want the beam to 
begin and end.
You can also select notes in between these two if you wish, it doesn’t 
matter.

2. Click the Group Notes icon on the extended toolbar or 
right-click on one of the notes to be grouped and select 
“Beam” from the “Group/Ungroup” submenu of the con-
text menu.

The Group Notes icon

Before and after grouping.

• Double-clicking on the “Grouping” text opens the 
Grouping dialog, allowing you to adjust the “note value” 
for the symbols.

Grouping quarter notes or larger under a beam 
(“Brillenbass”)

It is also possible to use the grouping feature for notes 
that are not displayed with beams (quarter notes, half 
notes, etc.). The result are so called “Brillenbass” sym-
bols, commonly used for indicating repeated accompani-
ment patterns, etc.

• Double-clicking on the “Grouping” text opens the 
Grouping dialog, allowing you to adjust the “note value” 
for the symbols.

Grouping notes using Repeats

To show Repeats for the grouped notes, proceed as 
follows:

1. Display the display filter bar in the Scores window (by 
clicking the “Show Filter View” button on the toolbar) and 
make sure the “Grouping” checkbox is activated.
Now, you will see the text “Grouping” below all groups you have created.

2. Select the desired notes.

3. Right-click on one of the notes and from the Group/
Ungroup submenu, select “Repeat…”.
A dialog appears.

4. Use the radio buttons to select the desired note value 
for the repeats.

In this example, the “Repeat” feature is used to display two pairs of six-
teenth notes as two eighth notes with “repeat bars”. Note that the second 
and fourth sixteenth note have only been hidden – playback is not affected!

5. Click OK to close the dialog.

• Double-clicking on the “Grouping” text opens the 
Grouping dialog, allowing you to adjust the “note value” 
for the symbols.
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Creating an accelerando/ritardando

To create an accelerando/ritardando, proceed as follows:

1. Select the notes as described above and select 
“Accelerando” from the Group/Ungroup submenu.
A dialog appears.

2. Use the radio buttons to select the desired combina-
tion (i.e. define whether you want an accelerando or a ri-
tardando and specify the desired note values) and click 
OK to close the dialog.

Example for accelerando (on the right) and ritardando (on the left).

• Double-clicking on the “Grouping” text opens the Group-
ing dialog, allowing you to select another combination.

The Grouping dialog

As described above, the Grouping dialog can also be 
opened by double-clicking an existing grouping text in the 
score.

• Which Grouping dialog appears depends on the group-
ing option you used for the notes (Beam, Repeats or Ac-
celerando, see above).

Removing groups

If you have made a grouping as described above, and 
wish to remove it, proceed as follows:

1. Display the display filter bar in the Scores window (by 
clicking the “Show Filter View” button on the toolbar) and 
make sure the “Grouping” checkbox is activated.
Now, you will see the text “Grouping” below all the groups you have 
created.

2. Select a group by clicking on its “Grouping” text.

3. Press [Backspace] or [Delete].
The grouping is removed.

• If you need to remove all groups from the score, hold 
down [Shift] and double-click on the first “Grouping” text. 
This selects all “Grouping” symbols, so you can delete them all at once 
by pressing [Backspace] or [Delete].

Removing a note from a group

There is no dedicated “ungroup” command, simply be-
cause it isn’t needed. A group can consist of one note if 
you wish. In other words… 

• To remove one note at the end of a group, select it and pro-
ceed with grouping as above.

• If you select notes in the middle of a beam and then group, 
three groups are created.

Before and after grouping.
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Automatic grouping

The program can also go through the selected notes and 
automatically create grouping for you, where it’s deemed 
suitable. Proceed as follows:

1. Select the notes you want checked for auto-grouping.
Typically, you would select all notes on the track by using the Select All 
command on the Edit menu.

2. Right-click on one of the notes and select “Auto 
Group Notes” from the context menu.
In 4/4 you will for example get two groups of eighth notes per bar, in 3/4 
you will get one group per bar, etc.

Before and after using auto grouping in 4/4.

Cross staff beaming

To create a beam that extends from one staff to another, 
proceed as follows:

1. Set up a split or polyphonic voicing system or open the 
Score Editor with more than one track.

2. Set up a beam of notes (using the group command) 
and adjust their pitches so that they are correct even 
though some of the notes are on the wrong staff.
Use the info line to edit the pitches if they are very low or high.

3. Select the note(s) that should appear on the other 
staff.

4. Select “Display in Staff” from the context menu for a 
selected note. Select a staff from the submenu that ap-
pears.

The notes are “graphically” moved to the selected system, 
but keep their actual pitch.

Before and after moving a note to the lower staff.

5. If needed, adjust the beam appearance (see “Manual 
adjustment of beams” on page 120).

Cross staff beaming with the beam in the middle.

As the name of the option already implies, Display In Staff 
does not move the affected notes to another track, but 
merely displays them as if they belonged to the other staff.

Handling beam groups
There are two settings for groups under a beam, Beam 
Subgroups and 16th Subgroups, both found on the Op-
tions tab on the Score Settings–Staff page. If “Beam Sub-
groups” is activated, the program displays subgroups after 
four sixteenth notes under a beam. If you also activate “16th 
Subgroups”, subgroups appear after only two sixteenths.

“Beam Subgroups” off, on and on with “16th Subgroups” activated.
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Beam appearance and slant settings

Global settings

On the Score Settings–Project page (Notation Style sub-
page), you will find the following three options for beam 
appearance in the Beams category:

• Thick Beams.
Activate this if you want beams to be displayed as thick lines.

• Show Small Slants as Flat Beams.
When this is activated, beams that would be only slightly slanted will be 
displayed flat.

Without and with “Show Small Slants as Flat Beams”.

• Slanted Beams only Slightly Slanted.
Activate this if you only want a slightly slanted beam even though there 
might be a significant pitch difference between the notes under the beam.

Without and with “Slanted Beams only Slightly Slanted”.

Staff settings

On the Options tab of the Score Settings–Staff page, you 
will find a couple of settings for beams as well.

Manual adjustment of beams
For very detailed control you can manually adjust the 
beam slant:

1. Group and flip notes and adjust the settings described 
above until the beams are as close as possible to how you 
want them.

2. Click on the corner made up by the beam and the 
stem.
A handle appears on the corner of beam and stem.

A beam handle.

3. Drag the handle up or down.
The slant of the beam changes.

Dragging a handle and the effect it has.

You can adjust the distance between notes and their 
beam without changing the beam slant. Select both handles 
of a beam (by pressing the [Shift] key while selecting the 
second handle) and drag one of the handles up or down.

Mixed staff direction

By dragging the beam handles you can put the beam be-
tween the note heads:

Putting the beam between the notes.
! Please note that these settings apply equally to all 

staves.

Option Description

Flat Beams Activate this when you don’t want any slant at all, no matter 
the pitch difference of the notes under the beams.

No Beams Activate this when you don’t want any beams at all.
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About tied notes
Sometimes, notes will be displayed as two or more notes 
tied together. Generally, there are three different occa-
sions when this will happen:

• When a note is of an “uneven” length that cannot be displayed 
without tying together two or more notes of different note val-
ues.

• When a note crosses a bar line.
• When a note crosses a “group line” within a bar.

The last case requires some explanation: Nuendo uses a 
“cutting mechanism” that automatically creates tied notes 
depending on the length and position of the notes. For ex-
ample, a quarter note is cut in two and tied if it crosses a 
half note beat, and an eighth note is cut in two and tied if it 
crosses a quarter note beat:

However, this isn’t always what you want. There are three 
ways to affect the cutting mechanism:

Syncopation
When the Syncopation option is activated on the Main tab 
of the Score Settings–Staff page, Nuendo will be less 
prone to cut and tie notes. For example, the second quar-
ter note in the figure above would not have been cut if syn-
copation had been activated.

The Syncopation setting on the Score Settings–Staff 
page affects the whole track, but you can also make syn-
copation settings for separate sections in the score, by in-
serting display quantize events (see “Inserting display 
quantize changes” on page 78).

Time signature changes
By inserting time signature changes, you can change the 
way notes are cut. This is done in the same way as when 
you specify how beamed notes should be grouped – see 
“Grouping” on page 116.

The Cut Notes tool
By using the Cut Notes tool, you can disable the auto-
matic cutting mechanism in a bar, and insert manual cuts 
at any given position in the score:

1. Select the Cut Notes tool.

2. Set the Quantize pop-up menu to an appropriate value.
As usual, this determines where you will be able to click.

3. Click in the bar containing the note(s) you want to cut 
manually, at the position you want them cut. If you work 
with polyphonic voicing, select the desired voice first.
This inserts a cutflag event in the bar at the position you clicked. If you 
hold down [Alt]/[Option], a cutflag event is inserted for all voices in a 
polyphonic staff.

This quarter note is cut. This eighth note is cut.

With a regular 4/4 time signature.

With a composite time signature (3+2+3 eighth notes).
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The following rules apply to cutflag events:

• If a bar contains a cutflag event, the automatic cutting mecha-
nism is disabled within that bar.

• All notes or rests that start before and end after a cutflag event 
will be cut at the position of the event.

• To display cutflag events, make sure that “Cutflag” is activated 
on the filter bar.

• To remove a cutflag event, either click again with the Cut Notes 
tool at the same position, or select it and press [Backspace] or 
[Delete].

Other options for tied notes

Tie direction

As described in the section “Tie pop-up menu” on page 
115, you can set the direction of the tie manually in the 
Set Note Info dialog.

Flat ties

If you prefer ties to be displayed as flat lines, rather than 
regular “curved” ties, activate the option “Flat Ties” in the 
“H.W. Henze Style” category on the Score Settings–
Project page (Notation Style subpage).

Graphic moving of notes
There might be instances where the “graphical” order of 
the notes isn’t the one you want. In this case you can 
move the note without affecting the score or playback in 
any way. There are two ways to do this:

By using the Layout tool
1. Select the Layout tool.

2. Click on the note and drag it right or left.
Movement is restricted to horizontally only.

Before and after changing the “graphical order” of notes.

By using the computer keyboard
You can assign key commands for moving objects graph-
ically. In the Key Commands dialog on the File menu, the 
commands are found under the Nudge category and 
called Graphical Left, Right, Bottom and Top (only the 
Graphical Left and Right commands apply to notes). 

After assigning key commands, you select the note(s) you 
want to move and press the assigned keys to adjust their 
graphical position.

A half note, placed at 2.1.3. This is by default cut at 2.3.1 (the 
middle of the bar). When you click at the position 2.2.1, a cutflag 
event is inserted.

As a result, the regular cutting mechanism is disabled and the note is 
cut at the position you clicked instead.
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Cue notes
You can create cue notes by using voices or by converting 
individual notes into cue notes.

Setting a voice to display cue notes
1. Open the Score Settings–Staff page and select the 
Polyphonic tab.
This is described in the section “Setting up the voices” on page 97.

2. Click in the “Cue” column for the voice, so that a tick 
mark appears.

3. Decide how to handle rests for the voice.
You might for example leave “Rests–Show” activated and activate “Re-
duce”. If you do, you will get rests in this voice, but not as many as other-
wise. Empty bars, for example, will not have any rests at all.

4. Close the dialog.

5. Move the notes into the cue voice.
Polyphonic voicing is described in detail on “Polyphonic voicing” on 
page 95.

An example of a cue note voice.

A quick example

Let’s say you have a flute part and want some cue notes 
for it.

1. Switch on polyphonic voices and activate voice 1 and 
voice 2.

2. Set voice 2 to “Auto” stem direction and centered 
rests.

3. Set up voice 1 to be a cue voice, with hidden rests 
and stems pointing up.

4. Insert the cue notes into voice 1.

Turning individual notes into cue notes
1. Select one or several notes.

2. Double-click one of the notes.
The Set Note Info dialog appears. You can also click the “i” button on the 
extended toolbar, or right-click on a note head and select “Properties” 
from the context menu to open this dialog.

3. Select Cue from the Type pop-up.

Note type set to Cue.

4. Click Apply.
The settings are applied to the selected note(s).

5. If you like, select other notes and make settings for 
them.
When you are done, close the dialog by clicking its close button.

Grace notes
You can turn any note into a grace note. Grace notes are 
considered to be notes without lengths. This means that 
once a note is turned into a grace note it doesn’t affect the 
rest of the score display in any way.

Before and after converting to grace notes. Note that after the conver-
sion, the grace notes no longer “interfere” with the interpretation of the 
other notes.

Creating grace notes manually
1. Locate the note for which you want a grace note.

2. Insert one or more new notes just before it.
The note value and exact position of the note isn’t important. However, 
the pitch of course is.

“Cue” activated for voice 3.

! Grace notes are always automatically positioned just 
before the next note on the staff. If there is no note 
after a grace note on the staff, the grace note will be 
hidden!
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From here on there are two ways to go:

• Select the note(s) and click the “i” icon on the extended 
toolbar.
The Set Note Info dialog appears and you can select the Grace note type 
and make other settings if needed.

• Right-click on one of the notes and select “Convert to 
Grace Note” from the context menu.
This turns the note into a grace note without opening any dialog.

Grace notes and beaming
• If two grace notes are at exactly the same position (the same 

tick), they will be put onto the same stem, as a chord.
• If multiple grace notes in front of the same note are put on dif-

ferent positions (even if they are only one tick apart), they will 
be grouped under a beam.

• Please note that it is possible to have beamed grace notes 
overlapping a beam of regular notes, as in the example below:

Grace notes in the middle of a group of regular notes.

Editing a grace note
1. Select one or several grace notes and open the Set 
Note Info dialog.

The grace note settings in the Set Note Info dialog.

2. Select a note value for the stem.

3. Activate Crossed, if you wish.
When this is activated, the stem will be crossed by a slanted line, to fur-
ther indicate that the note is a grace note.

4. Click Apply.
The settings are applied to the selected note(s).

5. If you like, select other notes and make settings for 
them.
When you are done, close the dialog by clicking its close button.

Converting grace notes to normal notes
1. Select the notes you want to convert.
If you want to make sure that all notes in the score are normal notes, you 
can select all notes (using the Select All command on the Edit menu).

2. Double-click on one of the selected grace notes.
The Set Note Info dialog appears.

3. Select “Normal” from the “Type” pop-up.

4. Click Apply.

Tuplets
The regular display quantize values do not apply to any 
other divisions than triplets. To create quintuplets, septu-
plets etc., follow the instructions below. 

There are two methods for creating tuplets:

• With permanent alteration to the MIDI data. This is the “draw-
ing” mode to use when you want to build the tuplet from 
scratch. It doesn’t put any demand on the notes’ positions be-
fore the tuplet is created.

• As display quantize. This is the method you use when the tu-
plet is recorded and plays back as you want it, but is not dis-
played correctly.

Actually, in the first case, you make permanent alterations 
and set display quantize settings, all in one go. In the se-
cond case you only make display quantize settings.

With permanent change to MIDI data
1. Insert as many notes as the tuplet consists of.
This would typically be 5, 7 or 9. If the tuplet contains rests, simply leave 
space for those, but make sure the current display quantize value allows 
them to be shown.

Five sixteenth notes, about to be converted to a quintuplet.

2. Select all the notes that make up the tuplet.
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3. Select “Build N-Tuplet” from the Scores menu.
The Tuplets dialog appears.

4. Set the type of tuplet in the Type field.
“5” means a quintuplet, “7” means a septuplet etc.

5. Set the length of the entire tuplet using the “Over” 
field.

6. Activate Change Length, if you need it.
If you do, the program will alter the length of all notes so that they are ex-
actly the note value the tuplet indicates. If you don’t, the lengths of the 
existing notes won’t be affected in any way.

7. If you want any other text than the standard above the 
tuplet, enter it into the “Text” field.
The standard text is simply the number in the type field. If the tuplet is put 
under a beam (see “Tuplet display options” on page 125) the text is put 
just above it. If there is no beam, the text is found in the middle of a 
bracket.

8. Click Build.
The tuplet appears. The notes have now been moved to the tuplet posi-
tions and their length might have changed. 

9. If needed, edit the lengths and pitches of the notes in 
the tuplet.
You can also make various settings for the appearance of the tuplet – 
see below.

Without permanent change to MIDI data
1. Select the notes in the tuplet group.
In this case, the notes play back correctly but aren’t displayed as a tuplet 
(yet).

2. Select “Build N-Tuplet” from the Scores menu to bring 
up the Tuplets dialog.

3. Make settings in the dialog, as described above.

4. Click Quantize.
Now the tuplet is displayed correctly. You can make additional settings 
for how the tuplet should appear, as described below.

5. If necessary, adjust the notes.

Editing tuplet settings

1. Double-click on the text above the Tuplet group to 
bring up the Tuplets dialog.

2. Adjust the Text setting.

3. Click Apply.
The changes are applied to the tuplet, without affecting the tuplet type or 
length.

Grouping

If the Tuplet is a quarter note long or shorter, the notes will 
be automatically grouped under a beam. If it is longer you 
have to perform the grouping manually. See “Grouping” 
on page 116 for details.

Tuplet display options

On the Score Settings–Project page, Notation Style sub-
page (“Tuplets” category), you find the following settings 
for tuplets:

! Lengths and positions in a tuplet group are probably 
best edited using the info line.

Option Description

Tuplet Brackets There are three possible settings for this option:
– None: Tuplets never have brackets.
– Always: Tuplets always have brackets.
– …by the head: Brackets are shown only when the tu-
plets are displayed on the “head side”.

Display Tuplet 
values by the 
Beams

When this is activated, tuplets will be displayed on the 
“beam side” of the notes instead of on the note head 
side.

Suppress 
Recurring 
Tuplets

When this is activated, and you have several tuplets of 
the same type in the same bar, only the first of these is 
displayed as a tuplet.

Show Tuplet 
Brackets as 
“Slurs”

When this is activated, the tuplet brackets will be “slur-
like” (rounded).

Double-click here.
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About this chapter
In this chapter you will learn:

• What the different types of symbols are.
• How to insert and edit symbols.
• Details about special symbols.

Background: The different layers
A score page is always made up of three layers – the note 
layer, the layout layer and the project layer. When you add 
symbols, these will be inserted into one of these layers, de-
pending on the type of symbol. The symbols that have a re-
lation to notes – accents, dynamic markings, slurs, lyrics 
etc. – will be put in the note layer. Other symbols – such as 
repeats, rehearsal marks, some types of text, etc. – can be 
put either in the layout layer (which is individual for each 
layout) or in the project layer (common for all layouts).

Note layer symbols
Let’s look at the note layer symbols first. These come in 
three flavors:

• Note symbols. These are each tied to a single note. Examples 
of note symbols are accents and lyrics. When you move the 
note, the symbol moves with it. The same is true if you cut the 
note and then paste; the symbol is cut and pasted together 
with the note.

• Note-dependent symbols. Only a few symbols belong to this 
category, for example the arpeggio lines. In one way, these be-
have just like grace notes (see “Grace notes” on page 123). 
They always precede a note or chord. If there is no note “after 
them” on a staff, they will disappear.

• All other note layer symbols (tempo, dynamics, chords etc.). 
Their position is related to the bar. (Whichever way you edit 
the notes, these symbols remain unaffected.) However, their 
positions are fixed within a measure. If you for example change 
the spacing of the bars across the page (see “Setting the 
number of bars across the page” on page 178), this will affect 
the symbols positions.

Layout layer symbols
Now let’s examine the layout layer symbols. The layout 
layer is not stored individually for each track, as the other 
symbols are. Instead it is common to a “set of tracks”. Let’s 
illustrate this with an example:

You have four tracks that make up a string quartet. You 
edit them all at the same time and add symbols to the 
score, both note layer symbols and layout layer symbols.

Now let’s say you close the Score Editor and open only 
one of the tracks for editing. All your note layer symbols 
are there just as you left them, but the layout layer symbols 
have disappeared!

Don’t worry, close the editor again, and open all four 
tracks for editing and the symbols are back.

You have probably got a clue as to what is going on by 
now. The layout layer symbols are part of a “bigger entity” 
called “layout”. And a layout is something that is stored 
not per track, but for a group of tracks. Each time you 
open the same combination of tracks for editing, you get 
the same layout.

There are also other things that are part of the layout – 
apart from the symbols in the layout layer, see the chapter 
“Working with layouts” on page 164.

Project layer symbols
Project layer symbols are layout symbols that are present 
in all layouts. The project layer holds the symbols found in 
the Project tab, plus bar line types and bar number offsets.

Using project layer symbols in conjunction with the Ar-
ranger mode, you can have playback in the program follow 
the score – repeats, da Capos and endings will be played 
back properly allowing you to hear your compositions as 
they would be played back by live players.

Layout layer symbols

Note layer symbols
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Why three layers?
There are several reasons for this division into layers:

• Many of the symbols that are in the layout layer can be stretched 
to span over several staves, or for other reasons make more 
sense to think of as belonging to a certain group of tracks.

• The layout layer is only one part of the bigger concept of lay-
outs. Layouts allow you to easily extract parts from a full score 
and perform automatic formatting. This is described in the 
chapter “Working with layouts” on page 164.

• Typically, you want to display some symbols – repeat bar 
lines, endings, score titles etc. – for all layouts in a score. To 
achieve this, insert them on the project layer.

Which symbols are part of which layer is described in the 
section “The available symbols” on page 129 and onwards.

The symbol Inspector
To display the symbol Inspector, click the Show Symbols 
button on the toolbar.

Customizing the symbol Inspector
You can customize the appearance of the symbol Inspec-
tor by showing/hiding tabs and by specifying their order in 
the Inspector.

Showing/Hiding symbol Inspector tabs
If you right-click on any tab in the Inspector, a context menu 
will appear. On this menu, you can directly check (show) or 
uncheck (hide) elements of the Inspector as desired.

You can also select different preset configurations from 
the lower half of the menu. To display all Symbol Inspector 
tabs, select “Show All”.

The symbol Inspector Setup dialog
If you right-click on any closed tab in the symbol Inspector 
and select “Setup…” from the context menu, a dialog ap-
pears. In this dialog you can configure where the separate 
tabs should be placed in the Inspector and save/recall dif-
ferent configurations of the Inspector.

The Setup dialog for the symbol Inspector. 

The dialog is divided into two columns. The left column 
displays the currently visible tabs in the Inspector, and the 
right column displays the currently hidden tabs.

• You can change the current show/hide status by select-
ing items in one column and using the arrow buttons in the 
middle of the dialog to move them to the other column.
The changes are reflected directly in the editor.

• You can change the order of the (visible) tabs in the 
symbol Inspector with the “Move Up” and “Move Down” 
buttons.
The changes are reflected directly in the Score editor. To revert back to 
the default Inspector settings, right-click on one of the tabs and select 
“Default” from the context menu.

A “customized” Inspector
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• If you click the Save button (disk icon) in the Presets 
section, you can name the current configuration and save 
it as a preset.

• To remove a preset, select it and click the trash icon.

• Saved configurations are available for selection from the 
Presets pop-up in the dialog, or directly from the Inspector 
context menu.

Working with symbol palettes
You can open any of the symbol Inspector sections as 
separate symbol palettes.

Opening tabs as palettes 

1. Right-click on one of the symbols of the desired tab in 
the Inspector.
Note that you have to right-click on a symbol. Right-clicking on a tab 
header will open another context menu instead, see above.

2. Select “Open as Palette” from the context menu that 
appears.
The selected tab will be shown as palette.

Moving and handling palettes

Palettes are handled as any window, which means that 
you can:

• Move a palette to another position by dragging its title 
bar. 

• Close a palette by clicking its close box.

In addition, you can select whether the palette should be 
shown horizontally or vertically, by right-clicking and se-
lecting “Toggle” from the context menu that appears.

The available symbols
The illustrations below show all the available symbols. 
These are shown as palettes and the captions contain 
additional information about the symbols.

The “Favourites” palette.

The “Keys” palette.

The “Clefs” palette.

The “Time Sign” palette.
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The “Chord Symbols” palette.

The “Guitar Symbols” palette.

The “Clef etc.” palette.

The “Note Symbols” palette. These symbols are always tied to a note.

The “Dynamics” palette.

Clef change Time signature change

Key change (and/or display transpose change)

Bow up

Pizzicato

Tremolo

Thumb pos.

Closed HihatOpen Hihat

Staccato

Accent

Fermata

Fermata

Glissando Glissando

ArticulationDoit

ArticulationArticulation

Staccato

Staccato

TenutoStaccato

Bow down

Tremolo

Accent

Staccato

Spoken tone

Fall

Accent

Damped

Tremolo

Accent

Fermata

Diamond note

Staccato

Accent

Staccato

Fall

Bezier Slur

DiminuendoCrescendo

“Dynamic” crescendo“Double” cresc./dim.

Slur up

Tie upTie down

Dynamics

Slur down



131

Working with symbols

The “Line/Trill” palette. Note that the arpeggios, hand indication and 
strum symbols are all “note-dependent”!

The “Other” palette.

The “Layout” palette. All these symbols are drawn in their own “layer”.

The “Project” palette. These symbols will be present in all layouts.

The “Words” palette. This is described in the section “The Words tab” 
on page 161.

The “User Symbols” palette. This is described in the section “User 
Symbols” on page 148.

Further details about many of the symbols can be found in 
the section “Symbol details” on page 144.

Setting up the Favourites tab
In the symbol Inspector, you will find a tab called Favou-
rites. Nuendo allows you to fill this tab with a selection of 
symbols from other tabs. This way, you have instant ac-
cess to the symbols you use often:

1. Open the Favourites tab.
If it’s the first time you are using this tab, it will be empty.

2. Open the tab from which you want to copy a symbol.

Not all symbols can be placed on the Favourites tab.

3. Right-click on the symbol you want to add to the 
Favourites tab and select “Add to Favourites” on the con-
text menu that appears.
You can also add a symbol to the Favourites tab by [Alt]/[Option]-click-
ing on it.

4. Repeat this procedures for other symbols you want to 
add to the Favourites tab.

Arpeggio

Arpeggio

Hand indication

Arpeggio

Strum

Hand indication

Segno (sizable)

Strum

Turn

Trill

Trill

Trill

Octave Octave

Trill

Trill

Main voiceAcc. voice

Ending Ending

Line Line

Beam Beam

Beam Beam

Bracket beam Bracket beam

Tuplet bracketTuplet bracket

LyricsRegular text

Guitar chord symbolBlock Text (import)

Pedal downChord

RepeatPedal up

SegnoRepeat

Segno (sizable)Coda

Keyboard symbol

Box symbolSelect Symbol, see “The 
“Other” tab” on page 146.

Text (layout layer)BlockText (layout layer)

Rehearsal markPage Text

Tempo as numberRehearsal mark

D.C. al Fine (text)Tempo as note value

Da Capo al Coda (text)Dal Segno al Fine (text)

Fine (text)Dal Segno al Coda (text)

CodaSegno

EndingEnding

Keyboard symbolBox symbol
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• To remove a symbol from the Favourites tab, select “Re-
move from Favourites” from the context menu or hold 
down [Alt]/[Option] and click on it.

Important! – Symbols, staves and 
voices
Most symbols belong to a staff when inserted. Only note 
symbols, slurs and ties are an exception. They belong to 
notes and therefore to voices. 

It is extremely important that the correct staff is active 
when you insert a symbol (if you are editing multiple 
staves, of course).

If you for example insert a symbol with the wrong staff ac-
tive, the symbol might later “disappear”, simply because you 
edit another configuration of tracks (the track you actually 
inserted the symbol on might not be opened for editing).

The same is true for note symbols and their relation to 
voices. Make sure the correct voice is active when insert-
ing symbols or they might wind up at the wrong position, 
fermatas may be turned upside down etc.

Layout symbols work slightly differently. Instead of belong-
ing to a certain staff or voice, they belong to a layout. 
Since different track combinations use different layouts, 
this means that if you insert a layout symbol in the score 
when you are editing two tracks (for example a trumpet 
and a saxophone part), it will not be there when you view 
each track by itself in the Score Editor. If you want the 
same symbols to appear in other layouts as well, you can 
copy the form of one layout to another. If you want a sym-
bol to appear in all layouts, use the Project tab.

Adding symbols to the score

Making space and handling margins
• If you find there isn’t enough space between staves to add 

symbols (like for example text), see “Dragging staves” on page 
180 for info on how to separate the staves.

• If you find the score looks crammed after adding symbols, 
check out the section “Auto Layout” on page 182.

About the Pencil tool
Unlike in the other MIDI editors, there is no Pencil tool 
among the tools on the Score Editor toolbar. Instead, the 
Pencil tool is “automatically” selected when you insert 
symbols. The following applies:

• Normally, the Pencil tool is automatically selected when 
you click on a symbol in the Inspector.

• However, if the option “Double-click Symbol to get 
Pencil tool” is activated in the Preferences–Scores, you 
need to double-click the symbol to get the Pencil tool.

• On the same page of the Preferences dialog, you will 
find an option called “Display Arrow tool after Inserting 
Symbol”. When this is activated, the Object Selection 
(“Arrow”) tool is automatically selected after you have in-
serted a symbol.
If you want to insert a lot of symbols with the Pencil tool, you may want to 
deactivate this option.

Adding note symbols

Adding a symbol to one note

1. Open the Note Symbols tab in the Inspector.

2. Click (or double-click) on the desired symbol in the 
tab.
As mentioned above, the “Double-click Symbol to get Pencil tool” prefer-
ence determines whether you need to double-click. In either case, the 
Pencil tool is selected.

! Symbols you add outside the margins will not be 
printed!
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3. Either click on the note or above or below it.
If you click on the note, the symbol is put in at a predefined distance from 
the note. If you instead click “above or below” the note, you decide for a 
vertical position yourself. In either case, the symbol is aligned horizontally 
with the note. It can later be moved up/down.

Clicking on a note inserts the note symbol (in this case a tenuto) at a 
predefined distance from the note head.

There are three options in the Accents category of the 
Score Settings dialog (Project page–Notation Style sub-
page) that affect the vertical positioning of note symbols:

• Accents above Stems.
When this is activated, accent note symbols are displayed at the stem 
side of notes instead of the note head.

• Accents above Staves.
When this is activated, accent note symbols are displayed above the 
staff, regardless of the stem direction of the notes. This setting overrides 
the “Accents above Stems” option.

• Center Note-Linked Symbols on Stems.
When this is activated (default setting), accents are centered on stems 
an not on note heads.

Adding a symbol to several notes using the Pencil tool

You might for example want to add a staccato symbol to 
all notes within a few measures. Proceed as follows:

1. Open the Note Symbols tab in the Inspector.

2. Select the notes to which you want to apply the symbol.

3. Click (or double-click) on the desired symbol in the 
Inspector.

4. Click on one of the notes.
The symbol is added to each selected note, at a predefined distance. 
The symbols can be moved later.

Adding a symbol without tying it to a note

Note-dependent symbols can be entered freely, too. This 
allows you to add a fermata to a rest symbol for example.

1. Make sure the correct staff is active.

2. Click (or double-click) the symbol so that the Pencil 
tool is selected, as described above.

3. Hold down [Ctrl]/[Command] and click where you 
want to add the symbol.

Adding other symbols
1. Open the desired symbol tab in the Inspector.

2. Click (or double-click) on the symbol you want to add.
As mentioned above, the “Double-click Symbol to get Pencil tool” prefer-
ence determines whether you need to double-click. In either case, the 
Pencil tool is selected.

3. Click once or click and drag somewhere in the score.
The symbol appears. For many symbols with a length, you can drag to set 
the length of the symbol directly. The symbol appears with its handles 
selected (if it uses handles) so that you can change its size directly if you 
wish. This is all described in detail in the section “Changing length, size 
and shape” on page 142.

Press the mouse button – drag – and release!

• You can change the size of most of the note symbols 
and dynamics in a score by right-click on the correspond-
ing object and selecting the desired option from the Size 
submenu on the context menu.

About note-dependent symbols
Note-dependent symbols like arpeggios and strum direc-
tions must be put in front of a note or they will belong to 
the following note instead (if there is no following note, the 
symbols will not be inserted at all).

Adding text
There are special methods for working with text, described 
in their own chapter, “Working with text” on page 154.
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Adding slurs and ties
Slurs can be drawn in manually or inserted automatically 
for a group of notes. Ties are usually added by the pro-
gram but can also be drawn in as “graphic” symbols.

There are two types of slurs – “regular” slurs and Bez-
ier slurs (with which you have full control over thickness, 
curve shape, etc.).

Slurs, ties and the display quantize value

Since a slur or tie “musically” always spans from one note 
(or chord) to another, the beginning and end of a slur/tie in 
Nuendo is always related to two notes in the score.

When you draw in a tie or slur, the program uses the 
quantize value to find the closest two notes to “attach” the 
symbol to. In other words, if you want to add the slur/tie to 
a note at a sixteenth note position, make sure Quantize is 
set to 1/16th notes or smaller (this is only true for manual 
drawing in of slurs and ties).

Please note that this does not necessarily mean that the 
symbol has to start or end exactly above/below two notes. 
Instead, what it means is that when you use the Layout 
tool to move the note graphically to adjust the look of the 
bar, the slur/tie moves with it (see “Graphic moving of no-
tes” on page 122). The same is true if you adjust the width 
of the measure – the slur/tie is adjusted accordingly.

If you want the end points of the slurs to snap to exact 
note positions, activate the option “Snap Slurs when 
dragging” on the context menu. This option is also avail-
able in the Preferences dialog (Scores-Editing page).

Drawing the slur/tie

1. Set the Quantize value depending on the positions of 
the two notes that the slur/tie should span. 
For example, if one of them is at a quarter note position and the other at 
an eighth note position, set Quantize to 1/8 note or a smaller note value.

2. Click (or double-click) on the correct slur/tie in the 
symbol Inspector, so that the Pencil tool is selected.

3. Position the mouse close to the first note and drag to a 
position close to the second note.
The end points of the slur/tie will snap to their default positions – holding 
down [Ctrl]/[Command] allows you to move the end points freely.

There are two special functions for inserting a slur or tie 
that automatically spans from one note to another.

Adding a slur/tie between two notes

1. Select two notes.

2. Click (or double-click) the correct slur/tie symbol in 
the Inspector, so that the Pencil tool is selected.

3. Hold down [Ctrl]/[Command] and [Shift] and click on 
one of the two notes.
The slur/tie is added between the two selected notes.

Inserting a slur over a selection of notes

1. Select a span of notes.

2. Pull down the Scores menu and select “Insert Slur”.
A slur is created, starting at the first selected note and ending at the last.

The Bezier slur

The Bezier slur is a special slur symbol, found in the Dy-
namics symbol tab. Unlike the regular slur, this symbol is 
made up of a bezier curve, allowing you to create more ad-
vanced curve shapes.

To add a Bezier slur, click (or double-click) on the symbol 
in the Inspector so that the Pencil tool is selected, and 
click or drag in the score. Clicking creates a Bezier slur of 
the default length and shape, while dragging creates a 
straight line.

You will find that the default Bezier slur has four curve 
points – one at each end and two along the curve.

• To move the slur, click on it (but not on a curve point) 
and drag.

• To resize the slur, click and drag the end points.

• To change the shape of the slur, click on one of the mid-
dle curve points and drag in any direction.
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Right-clicking on a curve point brings up a context menu 
with the following options:

Creating trills
If you have recorded or entered a trill, Nuendo can help 
you display this properly:

1. Select the notes that make up the trill.

2. Right-click on one of the notes and select “Build 
Trill…” from the context menu.

3. Select an option from the dialog that appears.
The radio buttons determine how the trill should look. Activate the “Help 
Note” option if you want an extra note to indicate between which notes 
the trill should be played.

4. Click OK.

Now the following happens:

• All notes except the first one (and possibly the second) are 
hidden.

• The first note automatically gets a display length matching the 
length of the whole trill.

• If you chose to include a help note, the second note is con-
verted to a “Graphic” note, with brackets but without stem. 
Otherwise, the second note is hidden, too.

• The trill symbols you selected in the dialog are inserted.

Inserting symbols across staves
If you hold down [Alt]/[Option] while adding a symbol to 
one staff in a grand staff, this symbol will be put in at cor-
responding positions on all staves. This allows you for ex-
ample to insert rehearsal marks, repeats, etc. for all instru-
ments at the same time.

Adding a keyboard symbol

The “Other” tab contains a piano keyboard symbol, useful 
for example in educational scores. The symbol has the fol-
lowing properties:

• To insert the keyboard symbol, select it from the Inspec-
tor, click with the Pencil tool at the desired position and 
drag a box to specify the approximate size of the keyboard.

• After you have inserted the keyboard symbol, you can 
drag its edges to resize it vertically or horizontally.

• If you right-click on an inserted keyboard symbol and 
select “Properties” from the context menu, a dialog opens 
allowing you to specify further properties for the symbol.
You can also double-click on an inserted keyboard symbol to open this 
dialog.

Option Description

Add Points/
Reduce Points

Adds another pair of curve points to the Bezier slur. This 
allows you to create very complex slur shapes. After add-
ing points, there will be an additional menu item “Reduce 
Points” – selecting it removes the additional curve points.

Add Thickness Makes the Bezier slur thicker.

Reduce 
Thickness

Makes the Bezier slur thinner.

Hide This hides the slur symbol, see “Hiding/showing objects” 
on page 174.

Option Description

Size Governs the width of the keys.

Start Note This is the leftmost note in the keyboard symbol.

Show Note 
Names

When this is activated, each C key is displayed with note 
name and octave (C1, C2, etc.).

White/Black 
Keys transparent

Activate these if you want the white and/or black keys to 
be transparent.
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Adding guitar chord symbols
A fretboard symbol of a guitar chord can be inserted any-
where in the score. 

Guitar symbols are found on the “Guitar Symbols” tab and 
the “Other” tab in the symbol Inspector.

• The Guitar Symbols tab contains all Guitar symbols of 
the current guitar library, see “Using the guitar library” on 
page 136. If the symbol you want to insert is among these, 
select it and insert it as you would any other symbol, see 
above.

To insert a guitar symbol not present in the guitar library, 
proceed as follows:

1. Open the “Other” tab.

2. Click (or double-click) on the guitar chord symbol, so 
that the Pencil tool is selected.

3. Click in the score, at the position where you want the 
symbol to appear.
The Guitar Symbol dialog appears.

• To put a black dot on any fret and string, click on it. 
To remove it, click again.

• To input a symbol just above the string, outside the fret-
board, click there.
Consecutive clicks allow you to select between a ring (open string), a 
cross (don’t play this string) and no symbol.

• To add a capodaster number, click to the left of the 
symbol.
Consecutive clicks allow you to step through the possibilities.

• You can also add a capodaster symbol (a line over the 
strings), by setting the “Capo String” parameter to a value 
higher than 0.
By adjusting the Capo End and Start values, you can create capodaster 
symbols that span fewer strings.

• Use the “Size” value field to adjust the size of the chord 
symbol.

• If you want the symbol to be horizontal, activate the 
“Horizontal” checkbox.

• If you want to display more or fewer frets than the de-
fault six, change the “Frets” value.

4. Click Apply.
The guitar symbol appears in the score. 

• Clicking the Insert Notes button will insert the actual 
notes in the chord into the score.
You can also right-click and select “Insert Notes” from the context menu 
that appears.

You can edit the symbol at any time by double-clicking it, 
changing the settings in the dialog and clicking Apply. 
Note that you can also access the symbols you have de-
fined in the guitar library by right-clicking a guitar symbol – 
see below.

If you select “Make Chord Symbol” from the context 
menu, the corresponding chord symbol will be displayed 
above the guitar symbol. This function is very useful when 
writing lead sheets, for example.

Using the guitar library
The above method is fine if you only want to add a few 
chord symbols to your score. If you need a lot of chord 
symbols, or if you are using chord symbols in a lot of dif-
ferent scores, you can gather all your chord symbols in a 
“guitar library” instead. This way you don’t need to recre-
ate the same chord symbol over and over again.
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Defining chord symbols

1. Double-click on one of the symbols in the Guitar Sym-
bols tab in the Inspector to open the guitar library.
Alternatively, you can open the Score Settings–Project page and select 
the “Guitar Library” subpage.

2. To add a guitar chord symbol to the library, click the 
New button.
A chord symbol appears in the list to the left.

3. To edit the chord symbol, double-click it in the list.
This opens the Guitar Symbol dialog, as when editing a chord symbol in 
the score. 

• The symbol you create will also be “interpreted” and its 
name will be displayed to the right of the fretboard symbol.
This can also be edited by double-clicking if you like.

• To sort the available symbols in the library according to 
their root notes, click the Sort button.

• To remove a symbol from the library, select it in the list 
and click Remove.

• To save the current library as a separate file, select 
“Save…” from the Functions pop-up menu.
A file dialog appears, allowing you to specify a name and location for the 
file.

• To load a guitar library file, select “Load current Pane…” 
from the Functions pop-up menu.
In the file dialog that appears, locate and open the desired guitar library 
file. 

There are also two additional checkboxes in the Guitar 
Library dialog:

Inserting symbols from the library

Apart from the “Use for ’Make Chords’” option above, 
there are two ways to insert symbols from the guitar library 
into the score:

• Use the Functions pop-up menu in the Guitar Library 
subpage of the Score settings–Project page when creat-
ing or editing guitar symbols.

• Right-click on a guitar symbol in the score and select a 
chord symbol from the Presets submenu on the context 
menu.

Using layout symbols
Symbols inserted from the “Layout” tab belong to the lay-
out layer. When you are editing a layout containing several 
tracks, you can have inserted layout symbols automatically 
copied to any combination of tracks in the layout. You de-
cide which staves should display layout symbols by ticking 
their “L” column in the Score Settings–Layout page 
(opened by selecting “Settings…” on the Scores menu).

Here, layout symbols will be displayed for the first two tracks.

! Loading a guitar library file replaces the current 
library!

Option Description

Use for ’Make 
Chords’

When this is activated, and you use the “Make Chord 
Symbol” function (see “Using Make Chord Symbol” on 
page 152), the program will insert guitar symbols as well 
as regular chords (if any fitting guitar symbols can be 
found). If there are several guitar symbols for a certain 
chord in the Guitar Library, the first one will be used.

Small Display If this is activated, the chord symbols in the list will be 
displayed in the size they will have in the score. If it is de-
activated, the symbols will be displayed in a larger size, 
for easier editing.
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• Any editing you perform to layout symbols is automatically du-
plicated in the other tracks.

• The display of layout symbols for different tracks can be deac-
tivated at any time.

• Layout symbols can be copied between layouts, by using the 
Get Form function on the Score Settings–Layout page.

One example of how to use layout symbols: 

Let’s say you are editing a full orchestra score, and want 
rehearsal marks inserted for more than one staff (typically, 
above each instrument group – brass, strings, percussion, 
etc.). Now all you need to do is insert the rehearsal marks 
from the Layout tab for one of the tracks. To do so, open 
the Score Settings–Layout page, tick the “L” column for 
the desired tracks/staves and click Apply.

Using Project symbols
Project symbols are part of the project layer and will there-
fore appear in all layouts. The project layer also contains 
changes to bar lines (e.g. repeats and double bar lines) 
and bar number offsets. Typically you use Project symbols 
when you know you want these shown for all combina-
tions of tracks.

You can also use Project symbols in combination with 
the Arranger mode to have the program play back accord-
ing to the score – including repeats, Da Capos, endings 
etc.
See “Scores and the Arranger mode” on page 194.

Selecting symbols
Almost all symbols can be selected by clicking on them. 
For symbols that have a length or size, one or more han-
dles appear.

A selected crescendo.

An exception to this are the slurs and ties which can be 
selected by clicking on the end points or by drawing a se-
lection rectangle.

Using the lock layers
Sometimes it can be very hard to click on a symbol or 
other object in the score without accidentally selecting 
other symbols nearby. To remedy this, you can assign dif-
ferent types of objects to different “lock layers” (up to 
three) and instruct Nuendo to “lock” one or two of these 
layers, making them “unmovable”. Furthermore, you can 
lock the layout and project layers separately if needed. 
Proceed as follows:

Setting up the lock layers

1. Open the Preferences dialog from the File menu, and 
select the Scores–Event Layers page.

2. Assign each event type to a layer (1, 2 or 3).
It is a good idea to assign event types that might “conflict graphically” to 
different layers. For example, you might want to assign bar numbers and 
note symbols to different layers, if you find that you accidentally move bar 
numbers when editing note symbols and vice versa.

3. Click OK to close the dialog.
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• Alternatively, you can right-click on one of the Layer but-
tons (1-2-3) on the extended toolbar to bring up a pop-up 
menu, showing which object types are associated with 
that layer.
A checkmark for an object type means it belongs to that layer. If no 
checkmark is shown, you can select the object type from the pop-up 
menu and move it to that layer.

Locking a layer

To “lock” a layer, click on its lock layer button.

In this figure, layer 2 is locked. Event types assigned to layer 2 cannot 
be selected, moved or deleted.

Visual indication of the layers

Objects belonging to locked event layers will be “greyed 
out” in the score. This makes it very easy to find out which 
object belongs to which layer – perhaps especially useful 
for the layout and project layers. For example, to quickly 
spot all objects in the layout layer, lock all other layers by 
clicking their buttons. Now, only layout layer objects will 
be shown normally; all other objects will be greyed out.

Moving and duplicating symbols
There are four ways to move and duplicate symbols: 

• By dragging them with the mouse (see below).
• By using the computer keyboard (moving only – see “Moving 

by using the computer keyboard” on page 141).
• By using the bar handles (see “Moving and duplicating with 

the bar handles” on page 141).
• By using the Paste Note Attributes function (duplicating note 

symbols only – see “Copying settings between notes” on 
page 116).

Moving and duplicating by using the mouse
This is done much as with other objects in Nuendo. The 
following rules apply:

• Note symbols and note-dependent symbols move with the 
notes/chords they belong to. In other words, if you move the 
note/chord, the symbols move with it/them.

• Note symbols (like accents and lyrics) can only be moved ver-
tically. Other symbols (like braces and brackets) can only be 
moved horizontally.

• All other symbols without handles can be moved freely. If you 
hold down [Ctrl]/[Command], movement is restricted to one 
direction only.

• If the symbol has one or more handles when it is selected, 
don’t drag it by the handles, or you will change its shape in-
stead of moving it.

• Slurs and ties are an exception, as they can only be moved by 
first dragging one handle and then the other. However, if you 
use the Layout tool (see “Graphic moving of notes” on page 
122) to move the notes they belong to, or if you change the 
measure width, they will be adjusted automatically.

• Duplicating is done by moving with [Alt]/[Option] pressed, as 
always in Nuendo. Slurs, ties and bar lines cannot be dupli-
cated with this method.

There are two features to help you position symbols (and 
other score objects) correctly: the rulers and the Position 
Info window.
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The rulers 

Unlike other editors, the Score Editor does not have a 
meter/time position-based ruler. Instead, its rulers are 
“graphical”, i.e. they indicate the actual x-y position of ob-
jects (with “zero” at the upper left corner).

• The current pointer position is indicated by thin lines in 
the rulers.

• To hide the rulers, pull down the pop-up menu above 
the scroll bar to the right and select “Off”.
This pop-up menu can also be shown by right-clicking in the ruler.

• To display the ruler again, pull down the same pop-up 
menu and select one of the units (inches, centimeters or 
points).
This setting will also affect the units used in the Position Info window 
(see below).

The Position Info window

If you need to fine-tune the graphical positions of symbols 
and other objects, you should use the Position Info win-
dow. This makes positioning easier in two ways:

• You get a numerical indication of the exact position of the 
mouse pointer (and any object you are dragging).

• You can move objects or staves by typing in position values.

You display the Position Info window by clicking in the 
ruler.

The window contains the following settings and values:

Dragging symbols across staves

If you drag a symbol across the staves, you will note how 
the “active staff” indicator to the left follows the mouse 
pointer. Use this as an indication, to make sure that sym-
bols end up in the correct staff.

• If you are editing several tracks at the same time, and 
want to make sure that a symbol isn’t accidentally moved 
to another track when you drag it vertically, click on the “L” 
button on the extended toolbar.
When this is activated, you cannot move symbols across staves by drag-
ging.

Option Description

Measure in 
Inch/cm/mm/pt

Click this label to change units for the Position Info win-
dow. This choice will also affect the units used in the rulers.

Abs/Rel. Pos Click this label to select whether X-Y position values 
should be “absolute” (referring to the upper left corner of 
the current page) or “relative” (referring to the upper left 
corner of the active staff).

X, Y When a single object is selected, these values show the 
horizontal and vertical position of this object.
When no objects or several objects are selected, these 
values show the current horizontal and vertical position of 
the pointer.
When a single object is selected, you can click on these 
values and type in a new position for the object.

dX, dY When you are moving an object, these values indicate 
the horizontal and vertical distance you have moved it.
You can click and type in values to move the object(s) by 
the specified distances.

Sel. Staff If “Abs. Pos” is selected (see above), this value shows 
the distance from the top of the score page to the top of 
the active staff. 
You can click and type in a value to move the active staff.
If “Rel. Pos” is selected, this value will always be 0, since 
vertical positions are related to the top of the active staff!

To Prev Staff The distance between the active staff and the staff above 
it. Clicking and typing in a value will move the active staff.

To Next Staff The distance between the active staff and the staff below 
it. Clicking and typing in a value will move the staves be-
low the active staff.
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Moving by using the computer keyboard
You can assign key commands for moving symbols, notes 
or rests graphically in the Key Commands dialog on the 
File menu. The commands are found under the “Nudge” 
category and are called “Graphical Left”, “Graphical 
Right”, “Graphical Top” and “Graphical Bottom”.

Selecting an object and using one of these commands is 
the same as dragging them with the Layout tool, but this 
method offers higher precision.

Moving and duplicating with the bar handles
This function allows you to move or copy the contents of a 
whole bar to one or several other bars. You can select 
which elements in the bar should be included in the oper-
ation. Proceed as follows:

1. Bring up the display filter bar by clicking the “Show Fil-
ter View” button on the toolbar.

2. On the filter bar, make sure the “Bar Handles” option 
is activated.
Now, each bar in the score is shown with a handle in the upper left corner.

3. Double-click on the handle of the bar from which you 
want to copy or move symbols.
The Bar Copy dialog appears.

4. Make sure that only the symbol types you want to 
move/copy are checked.

5. If you have several subsequent bars to which you want 
to copy symbols, set the “Repeats” value to this number of 
bars.
If you only want to copy symbols from one bar to another, make sure “Re-
peats” is set to 1. This option is only available for copying, not for moving.

6. If you want this dialog to appear every time you per-
form the move/copy operation (see below), activate 
“Show Dialog”.

7. Click OK to close the dialog.

8. To copy the specified event types to another bar, hold 
down [Alt]/[Option], click on the bar handle of the first bar 
and drag it to the “target” bar.
To move the event types instead of copying them, drag the bar handle 
without holding down [Alt]/[Option].

• If you activated “Show Dialog” in step 6 above, the Bar 
Copy dialog appears, allowing you to confirm your settings.
Click OK to close the dialog and perform the operation.

Now, the following happens:

• If you activated “Note Symbols” in step 4 above, the 
note symbols are copied from the “source” bar and pasted 
onto notes at the same positions in the “target” bar. If 
there is a note symbol for a certain note in the “source” 
bar, but no note at the corresponding position in the “tar-
get” bar, the symbol will be ignored.
The actual positions of notes are used as a basis for this operation – not 
the displayed positions.

• If you activated other types of symbols in step 4 above, these 
will simply be moved to the same graphical position in the “tar-
get” bar.

• If you set “Repeats” to a number larger than 1 in step 5 above, 
the same symbols will be pasted into that number of bars 
(starting from the one you drag the bar handle to).

Bar handles

If you copy the note symbols from the first bar to the second bar…

…only symbols that find corresponding note positions in the 
second bar will be copied.
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• If you didn’t hold down [Alt]/[Option] when dragging the bar 
handle, the symbols (and other event types specified in the di-
alog) are removed from the “source” bar.

About moving note symbols
Note symbols, slurs and ties all have “default positions”. 
This determines the vertical distance between the note 
head(s) and the symbol. 

• You can manually adjust the vertical positions of individ-
ual symbols, but if you move or transpose their notes, the 
symbols are automatically reset to their default positions. 
This also ensures that note symbols and slurs are positioned sensibly 
when you change the display transpose settings.

• To reset the vertical positions of note symbols and slurs 
in a score, right-click on the corresponding object and se-
lect “Default position” from the context menu that appears.

Changing length, size and shape
You can change the shape of any symbol that has a 
length. Proceed as follows:

Changing the length of a symbol
1. Select the symbol.
The handles appear.

Symbols with a length have two handles when selected.

2. Drag one of the handles.
You may be restricted to vertically or horizontally only, depending on the 
type of symbol.

Resizing note symbols and dynamics
1. Right-click on a dynamic or note symbol.

2. Select the desired option from the Size submenu.
The size of the symbol will change accordingly.

Changing the symbol size.

Altering the shape and direction of slurs and 
ties

This section describes how to alter the “regular” slur 
and tie symbols. How to add and edit Bezier slur symbols 
is described in the section “The Bezier slur” on page 134.

There are two types of slurs and ties in the symbol Inspec-
tor. The up/down variation of each actually represent the 
same symbol but with different initial direction. You can 
perform the following editing to slurs and ties:

• By dragging the middle handle up/down you can 
change the shape of the curve. 

Dragging the middle handle of a slur changes its shape.

• By selecting a slur or a tie and clicking the “Flip” symbol 
on the extended toolbar or by selecting “Flip Position” in 
the context menu, you can change the direction and posi-
tioning of the slur or tie.
Actually, there are three “modes” for a slur or tie. You step through these 
three modes by clicking the button:

! If there already are symbols (or other objects) of the 
specified types in the “target” bars, these will be re-
moved!

! In the Preferences dialog (Scores-Editing page), 
there is a preference called “Keep Crescendo Sym-
bols Horizontal”. When this is activated, crescendo 
and diminuendo symbols will never be slanted.
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• By dragging the end points of a slur or tie, you can 
change its shape without affecting its “relation” to the 
notes it belongs to.
In other words, the end point of the slur/tie will then keep its relative dis-
tance to that note when the note is moved with the Layout tool or when 
the measure width is adjusted.

• By holding down [Ctrl]/[Command] and dragging the 
end points of a slur or tie, it can be detached from the 
notes it belonged to.

• To change the default shape and spacing of slurs and 
ties, open the Score Settings–Project page and edit the 
settings “Slur’s Start & End Distance from Note Head” 
and “Slur’s Middle Distance from Note Head” in the Spac-
ings subpage.
These settings will be used for all new slurs and ties you create, as well as 
for all existing slurs for which you haven’t manually changed the shape.

Deleting symbols
This is done as with all other objects in Nuendo, either 
with the Erase tool or by selecting it and pressing [Delete] 
or [Backspace].

Copy and paste
All symbols except those in the Layout and Project tabs 
can be copied and pasted just as any other object in Nu-
endo. The following applies:

• Symbols that were tied to notes (e.g. accents) will be-
come “free-floating” objects when pasted. 
That is, they are not tied to any note any more. If this is not what you 
want, consider copying with the bar handles, as described in the section 
“Moving and duplicating with the bar handles” on page 141.

Alignment
Symbols can be aligned as in drawing programs. Proceed 
as follows:

1. Select all objects you want to align.

2. On the Scores menu, Align Elements submenu, select 
the desired option.

The “Dynamics” option is a special function for aligning 
dynamic symbols, as described in the section “Aligning 
dynamics” on page 145.

! To restore the default shape of a symbol, right-click 
on it and select “Default position” from the context 
menu that appears. See “About moving note sym-
bols” on page 142.

Option Result

Left

Right

Top

Bottom

Center Vertical

Center 
Horizontal

! Note symbols like staccato and accents can only be 
aligned horizontally.
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Symbol details
This section further describes some of the symbol tabs.

The “Clefs etc.” tab

Clefs

You can insert a clef symbol anywhere in the score. This 
will have an effect on the notes, just as the first clef on the 
staff has. And just as with the first clef, the type is selected 
from a dialog that appears as soon as you click. See “In-
serting and editing clefs, keys or time signatures” on page 
93 and “Setting key, clef and time signature” on page 65.

When you double-click on an existing clef, the same dia-
log appears allowing you to change the type.

When you right-click on a clef, you can change the type 
from the context menu that appears. 

Time signatures

You can insert a time signature symbol at the beginning of 
any bar. Inserting a new time signature will insert a change 
into the tempo track, as described in the section “Inserting 
and editing clefs, keys or time signatures” on page 93.

When you click with the Pencil tool, a dialog appears al-
lowing you to specify the time signature. When you dou-
ble-click on an existing time signature symbol, the same 
dialog appears allowing you to change the type. This dia-
log is described in detail in the section “Editing the time 
signature” on page 66. When you right-click on a time sig-
nature, you can change the type on the context menu that 
appears.

• You can select a font and size for time signatures in the 
“Text Settings” subpage of the Score Settings dialog 
(Project page).
The default font for this is the included “Steinberg Notation” font.

Keys

Inserting a key change is similar to inserting a new clef 
(see above). For further information, see “Editing the key” 
on page 68.

• In the dialog that appears when you insert a key change, 
you can also insert display transpose changes.

The “Dynamics” tab

Dynamics

There are dynamic symbols ranging from ffff to pppp, plus 
“special” dynamic symbols such as sforzando, fortepiano, 
etc. 

• By selecting a dynamic symbol and clicking the “+” and 
“–” buttons on the extended toolbar, you can quickly edit 
dynamics in the score.
You can use this feature to step between pppp, pp, p, mp, mf, f, ff, fff and 
ffff. 

• You can also right-click on the desired symbol and se-
lect “One up” or “One down” on the context menu.
As above, these commands can be used to step between pppp, pp, p, 
mp, mf, f, ff, fff and ffff. 

• To change the size of a dynamic symbol, right-click on it 
and in the context menu that appears, select the desired 
option from the Size submenu.

• In the Line/Trill tab you will find a line symbol which allows 
you to create the following type of change in dynamics:

Crescendo and diminuendo (decrescendo)

In the Dynamics tab, there are three kinds of crescendo 
symbols: regular crescendo, regular diminuendo and a 
“double” crescendo (diminuendo–crescendo).

• To insert a crescendo (<) or diminuendo (>), select the corre-
sponding symbol from the tab and drag from left to right.

• If you draw a crescendo symbol from right to left, the result will 
be a diminuendo symbol, and vice versa.
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• To insert a crescendo-diminuendo (<>) symbol, select the 
double crescendo symbol from the tab and drag from left to 
right.

• To insert a diminuendo-crescendo (><) symbol, select the dou-
ble crescendo symbol from the tab and drag from right to left.

• When you have inserted a crescendo or diminuendo 
symbol, you can move it and resize it by dragging its 
handles.

• The “dynamic crescendo/diminuendo” symbol (p < f) is 
special in that it actually affects the velocity of the notes as 
they are played back. 
This is described in the section “Dynamic crescendo symbols” on page 
195.

• If the option “Keep Crescendo Symbols ‘Horizontal’” is 
activated in the Preferences dialog (Scores-Editing page), 
crescendo/diminuendo symbols will never be slanted 
when you draw them, but stay horizontal.
Also, this option prevents you from accidentally dragging an endpoint up 
or down when moving the symbol.

• It’s also possible to “flip” crescendo symbols, by select-
ing the option in the context menu or by clicking the Flip 
button on the extended toolbar.

Aligning dynamics

There is a special command for aligning dynamic symbols 
(including crescendos) horizontally. Unlike the regular align 
function (see “Alignment” on page 143), aligning dynamics 
takes the “baseline” of the dynamic letters into account, 
aligning them as text rather than as graphic symbols.

1. Select the dynamic symbols you want to align, e.g. pp 
and a crescendo.

2. Right-click on a selected symbol and select the 
“Align” function in the context menu that appears.
This aligns all selected dynamics (except slurs and beziers) horizontally.

You can also align the dynamic objects by pulling down 
the Scores menu and selecting “Dynamics” from the Align 
Elements submenu. 

The “Line/Trill” tab

Octave symbols

The octave symbols (8va and 15va) act as a “local display 
transpose” (see “Transposing instruments” on page 69) – 
they shift the display of the score one/two octaves down.

• By dragging the end of the dotted line, you can specify 
exactly which notes should be affected by the octave sym-
bol.
Only notes beneath the dotted line are display transposed.

Tuplet group symbols

These are “graphical” tuplet group symbols, as opposed 
to the “real” tuplets.

• After inserting a tuplet group symbol, you can double-
click on its number and enter any number from 2 to 32.

• You can specify globally how tuplets should be dis-
played in the “Notation Style” subpage of the Score Set-
tings–Project page.
You can also select a font and size for the tuplet numbers in the Text Set-
tings subpage. 

Vertical symbols

The vertical symbols in the Line/Trill tab are “note-depen-
dent”. This means that they must be inserted in front of a 
note. For more information see “Note layer symbols” on 
page 127 and the text about grace notes (which behave 
similarly) in the section “Grace notes” on page 123.
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The “Other” tab
Lyrics and text symbols are described in the chapter “Wor-
king with text” on page 154. Chord symbols are described 
in the section “Inserting Chord symbols” on page 151.

Pedal down and up symbols

When you insert a Pedal down or up symbol, you will also 
insert an actual MIDI event (damper pedal, control change 
64) at that position. Similarly, inserting or recording a 
damper pedal event in another editor will display a pedal 
down/up symbol in the score.

• If the option “Hide Pedal Markers” is activated in the 
Miscellaneous category of “Notation Style” subpage of 
the Score Settings–Project page, all pedal markers are 
hidden.
Use this if you have recorded a lot of damper pedal messages, but don’t 
want these to show in the score (for example if you are writing for an in-
strument other than piano).

A pedal down/up symbol combination can be displayed as 
“Two Symbols”, ““Ped.” + Bracket” or as “Bracket only”. 
Just right-click on the pedal symbol and chose an option 
from the context menu. You can also set this on the Score 
Settings–Project page, on the Notation Style subpage 
(Miscellaneous).

Repeats

Repeat signs (one and two bars) have a special feature: if 
you hold down [Shift]+[Ctrl]/[Command] when entering 
them, notes in the bars they relate to are automatically hid-
den (for more info on hiding symbols, see “Hiding/sho-
wing objects” on page 174).

Box (rectangle) symbol

This is a “generic” box symbol, which may be useful for 
different purposes. If you double-click on a box, a dialog 
opens in which you can specify whether the box should be 
transparent or not, and whether the border should be visi-
ble. This dialog can also be opened by selecting “Proper-
ties” from the context menu.

The box symbol is available in the “Other” and “Layout” 
tabs.

The keyboard symbol

This is described in the section “Adding a keyboard sym-
bol” on page 135.

Additional symbols

If you click on the “Select Symbol” button and then into 
the score, the “Select Symbol” dialog opens. Here you 
can chose note heads, accidentals and rests that work 
only as drawing elements, i.e. they do not insert any note 
data into the track. They do not affect MIDI playback! You 
can set the desired symbol font size directly in the Font 
Size field.
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The “Layout” tab

Rehearsal marks

These come in two flavors, as numbers and as letters.

When you place the first of these in the score, it will be la-
belled 1 or A (depending which you choose in the tab), 
the second will then automatically be labelled 2 or B, the 
next 3 or C etc. If you delete one, the labelling of the oth-
ers will be shifted so that they always make up a complete 
series of numbers/letters.

• You can select a font and size for rehearsal marks in the 
“Text Settings” subpage of the Score Settings–Project 
page.
This dialog also allows you to add a box or an oval around the rehearsal 
mark.

• Rehearsal marks can be added automatically, at the 
start position of each Marker in the project.
This is done using the “Marker track to Form” function.

Da Capo and Dal Segno symbols

The “D.C.”, “D.S.” and “Fine” symbols provide a quick way 
to insert some common play directions into the score. The 
symbols are text symbols – you can adjust which font 
should be used in the “Text Settings” subpage of the 
Score Settings–Project page, see “Settings for other fixed 
text elements” on page 163.

• To have these symbols actually affect playback, insert 
them from the Project tab and use the Arranger mode.
See “Scores and the Arranger mode” on page 194.

Endings

There are two types of endings, closed (“1”) and open 
(“2”). Both can be stretched to any length or height by 
dragging the handles. You can also double-click or right-
click on the existing number and enter any text you like. 

Endings are available both in the Layout tab (for the layout 
layer), the Project tab (for the project layer) and the Line/
Trill tab (for the note layer). Which one to choose depends 
on the score; while it’s handy to insert endings once and 
for all as Project symbols, this won’t allow you to make in-
dividual adjustments for the different parts.

Tempo

This always shows the current tempo according to the 
tempo track. In other words, to make this symbol display a 
certain tempo, insert the value into the tempo track.

Normally this symbol shows the number of beats (quarter 
notes) per minute, but if you double-click or right-click on 
it, a menu appears that allows you to select any note value. 
The number then changes accordingly.

Tempo change as note symbol

This symbol allows you to specify a tempo change as a 
change from one note value to another. The example 
above would mean “lower the tempo by a third”.

To change the note value for either symbol, double-click 
or right-click on it and select the desired note value from 
the context menu that appears.
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User Symbols
The User Symbols tab lets you create your own graphic 
symbols and use these in the score. 

Creating a user symbol

Initially, the User Symbols tab is empty. To create symbols 
you use the User Symbols editor:

1. Double-click on the empty symbol field in the tab.
The User Symbols editor opens. You can also right-click on an empty 
symbol field and select “Edit…” to open the same dialog.

2. Pull down the Functions pop-up menu and select the 
desired zoom factor from the View submenu.
Often you want to work at a reasonably high zoom factor when drawing 
and editing symbols.

3. Use the tools and functions to draw the symbol you 
want.
The available tools are listed in the table below.

When you are finished, you can close the editor and insert 
the symbol into the score, or you can create more symbols:

4. Select “New Symbol” from the Functions pop-up 
menu.
An empty symbol field appears in the section to the left of the drawing 
area – this section corresponds to the actual User Symbols tab, showing 
all symbols you have created.

5. Click the new empty symbol field to the left to make 
sure it’s selected.
The drawing area is cleared.

6. Continue creating new symbols this way.

• You can edit existing symbols at any time by selecting 
them to the left and using the tools and functions.
Any changes you make are automatically stored in the User Symbols tab 
for the project. You can also export symbols, for use in other projects, 
see below.

• To insert a user symbol into the score, click (or double-
click) it in the tab to select the Pencil tool and then click at 
the desired position in the score.

The User Symbols editor – tools and functions

The toolbar contains the following tools and settings, from 
left to right:

Tool Description

Arrow Use this to select objects – press [Shift] to select more 
than one. Click and drag to move objects – press [Ctrl]/
[Command] to drag vertically or horizontally only or press 
[Alt]/[Option] to copy. 
To delete an object, select it and press [Backspace] or 
[Delete].

Line Draws a straight line.

Rectangle Creates a rectangle. You can fill this with the Fill button if 
needed.

Polygon Creates a polygon – click where each corner of the poly-
gon should be and close the figure by clicking outside 
the drawing area.

Circle Creates a circle. You can fill this with the Fill button if 
needed. 

Ellipse Creates an ellipse. You can fill this with the Fill button if 
needed.

Arc Creates an arc.

Text Allows you to insert text objects. Clicking with this tool in 
the drawing area opens a dialog where you enter the text, 
specify font, style, etc. You can double-click on a text ob-
ject you have inserted to change its text or settings.

Symbol Clicking with this tool brings up a dialog where you can 
select any of the existing score symbols and incorporate 
this (at the desired font size) into your own symbol.

Frame Color When this is selected, the Color pop-up menu selects 
the color for the object frame.

Fill Color When this is selected, the Color pop-up menu selects 
the fill color for objects (if Fill is selected)

Fill Click this if you want the object to be filled – you can then 
select a Fill Color for it from the Color pop-up menu.

No Fill Click this if you don’t want the object to be filled.

Color pop-up Selects Frame or Fill Color for objects. The “Select Col-
ors…” menu item brings up a standard color dialog.

Line Width Allows you to change the line width used for the selected 
object.
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The Note Linked pop-up lets you create symbols linked to 
note positions. This affects the whole symbol, not a se-
lected graphic object.

The Functions pop-up menu contains the following items 
(some of these can also be accessed on the context menu 
for the User Symbols tab):

Menu item Description

Not Linked The symbol will not be linked to notes.

Linked/Left The symbol will be linked to a note, appearing to the left 
of the note.

Linked/Center The symbol will be linked and centered to a note.

Linked/Behind The symbol will be linked to a note, appearing to the right 
of the note.

Menu item Description

New Symbol Adds a new empty symbol to the tab (and to the symbol 
list to the left in the editor).

Delete Symbol Deletes the current symbol from the tab.

Export User 
Symbols…

Allows you to save the current tab as a separate file on 
disk.

Import User 
Symbols…

Loads settings for a complete tab from disk. Note that 
this replaces the current settings.

Export/Import 
Symbol…

Lets you save or load individual symbols to/from disk. Im-
porting a symbol replaces the current symbol in the tab.

Delete Deletes the selected object(s).

Select All Selects all objects in the current symbol.

Transform – 
Scale Symbol

Lets you scale (resize) the selected object by specifying 
a percentage.

Transform – 
Mirror horizon-
tal/vertical

Mirrors the selected object along the horizontal or vertical 
axis.

Transform – 
Flip ± 90

Rotates the selected object by + or – 90 degrees.

Draw – 
Group

Groups the selected objects so that they are treated as 
one.

Draw – 
Ungroup

Ungroups the selected group.

Draw – 
Bring To Front/
Send To Back

These items let you arrange the objects by moving them 
to the front or the back.

Align Aligns the selected objects to each other.

View Sets the zoom factor for the drawing area.
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About this chapter
In this chapter you will learn:

• How to enter chord symbols manually and automatically using 
the “Make Chord Symbol” feature.

• Which settings can be made for chord symbols.

Inserting Chord symbols

Manually
• On the Chord Symbols tab, you will find a set of pre-
defined chord symbols, see “Using presets” on page 152. 
If the symbol you want to add is among these, simply se-
lect it and click in the score to insert the chord symbol.

To specify and enter any other chord symbol, proceed as 
follows:

1. Open the “Other” tab and select the chord symbol but-
ton. 

2. Click in the score at the position where you want to in-
sert the chord symbol.
The Edit Chord Symbol dialog opens.

The Edit Chord Symbol dialog.

3. Enter the key (root) note in the Key Note field.
You can either type in a chord letter or step through the chord letters us-
ing the up/down arrows to the right.

4. Specify a chord type in the “Chord Type” field.
You can either enter it directly (for example, by typing a “7”) or select an 
option from the pop-up menu (click the arrow button to open it).

5. If you wish, specify a tension in the “Tension” field.
Again, this can be done by typing or by using the pop-up menu. How-
ever, there are some special display options which you can only get by 
typing (see the table below). You might also want to add some text here 
(such as “no third”, etc.). You can also select the basic tensions from the 
pop-up menu, and then add special options by typing.

6. If you want to have a special bass note (e.g. a C major 
with a D bass note), set the Bass Note pop-up menu to 
this note (this cannot be the same as the key note).
The program will “remember” the relation between key and bass note, so 
that if you change the key note, the bass note will follow.

7. If you want the key note to be displayed in lower case, 
activate the “Key Note in Lower Case” checkbox.

8. If needed, activate the “Enharmonic Shift” option.

9. Click Apply.
The chord symbol appears in the score.

Character Description Example Result

( ) The tensions will 
be enclosed in 
brackets.

/ The tensions will 
be separated by a 
slash sign.

| The tensions will 
be placed above 
one another.

You can also combine several 
options. This is a combination of 
two options, along with a space 
to put the “9” above the “5”. Note 
that only one “(“ sign is needed 
when the “|” option is used.
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• To open the Edit Chord Symbol dialog for an existing 
chord, double-click on the symbol.
You can also right-click on the symbol and select “Properties” on the 
context menu to open the dialog.

Using presets

As with many other functions in Nuendo, you can create 
chord symbol presets for instant use. Each preset con-
tains all settings in the dialog – i.e. the preset list is a 
“library” of chords. You will find the presets in the Chord 
Symbols tab in the Inspector and in the corresponding 
context menu. The preset handling is the usual:

• Click Store to store the current settings as a preset.
A dialog will appear, allowing you to enter a name for the preset.

• To load a stored preset, select it from the Presets pop-
up menu or select it from the Presets submenu of the con-
text menu.
Note that this only loads the settings into the dialog – you need to click 
Apply to apply the settings to a selected chord symbol.

• To remove a preset, select it on the pop-up menu and 
click Remove.

Using Make Chord Symbol
If you already have recorded the chords for a project, 
Nuendo can analyze them and create chord symbols:

1. Open the recording in the Score Editor.
If you want the chords to be inserted on another track, you can create an 
empty part on that track and open it along with the recording.

2. If you like, make settings for how the chords should be 
displayed on the Score Settings–Project page, on the 
Chord Symbols and the Notation Fonts subpages.
You can change all these settings after you inserted the chords as well.

3. Select the notes for which you want chord symbols to 
be created.
If chord symbols should be created for all chords on the track, use the 
Select All function on the Edit menu.

4. Use the arrow keys to make the desired staff active.
This should be the staff on which you want the chord symbols to end up.

5. Select “Make Chord Symbol” from the Scores menu.
The chords appear. They can be moved, duplicated and deleted as any 
other symbol. You can also double-click on a chord symbol to edit it in 
the Edit Chord Symbol dialog (in the same way as when creating chords 
manually – see above).

A staff after using Make Chord Symbol.

• Instead of using the “Make Chord Symbol” menu item, 
you can click on the Make Chord Symbol button on the 
extended toolbar.

• If the option “Use for ‘Make Chord Symbol’” is activated 
in the Guitar Library subpage of the Score Settings–Project 
page (see “Adding guitar chord symbols” on page 136), 
guitar chord symbols will be added as well (if the guitar li-
brary contains any guitar symbols that match the chords).

About the analysis

• The MIDI chords are expected to be played in their most basic 
inversion. If not, an extra bass note is added. For example, the 
notes CEG are interpreted as C major, but GCE is interpreted 
as C major with a G bass note. If you don’t want any interpre-
tation of the inversion (i.e. no added bass notes) hold down 
[Ctrl]/[Command] while selecting Make Chord Symbol.

• All selected notes on all staves are taken into consideration. 
Whenever there is any change on any staff, the notes are rein-
terpreted and a new chord symbol is added. This means you 
should probably avoid having the melody track in the Score 
Editor when you use Make Chord Symbol, or you will get a lot 
more chords than you expect, possibly with strange tensions.

• In addition to the above, the quantize value is used. At the 
most, there will be a new chord at each quantize position.

• There must be at least three notes at a certain position for the 
program to interpret it as a chord. Also some combinations of 
notes simply don’t make any sense to the program and won’t 
produce any chords.

• The analysis method isn’t perfect since the same set of notes 
can be interpreted differently depending on context. Some 
editing may be required. If you record the track solely to create 
chords automatically, play the chord as simple as possible, in 
the correct inversion, without added octaves, etc.
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Global chord settings
On the Score Settings–Project page (Chord Symbols and 
Notation Fonts subpages), there are several global set-
tings that affect how chords are displayed. These settings 
affect all chords in the project.

Chord Symbols

Use the four sections of radio buttons to specify how the 
four most common chord types should be displayed:

• If you want the root (key) note to be aligned with the 
bass note, so that they are both displayed at the same ver-
tical position, activate “Align Root Note”.

• If you want the tensions to be displayed at the same ver-
tical position as the root note (rather than a bit above the 
root note), activate “Tension Bottom”.

• Activate “Scale Chords” to scale a staff (using the Size 
setting on the Options tab on the Score Settings–Staff 
page), and want the chords to be scaled accordingly.

• Activate “Use Display Transpose” if you want the chord 
symbols to be affected by the Display Transpose setting 
on the Score Settings–Staff page.

• To apply the settings to your score, click “Apply to 
Chords”.

Notation Fonts

• Use the Score Font pop-up to select a font for the dis-
play of note heads, clefs etc.
Available are Legacy, Classical and Jazz.

• Use the Chord Symbols Font pop-up to select a font for 
the chords.
Nuendo comes with its own font for this (Steinberg Chord Symbols), but 
you can also pick any other available font from the pop-up menu.

• Use the four size value fields to select sizes for the four 
different chord “elements”.
You can type in values or use the pop-up menus. Normally, you would 
want the “Root” size to be the largest and the “Tension” size the smallest.

• Use the radio buttons at the bottom to select a chord 
display mode.
This affects how the key and bass notes are displayed:

Option Description

English Regular notation.

DoReMi “Do-Re-Mi-…” are used instead of “C-D-E-…”

German As English notation, but “B” is displayed as “H”, and “Bb” 
or “A#” are displayed as “B”.
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About this chapter
In this chapter you will learn:

• Which different types of text are available.
• How to enter and edit text.
• How to set font, size and style.
• How to enter lyrics.

Adding and editing text symbols
This section describes the general procedure for adding 
and editing text symbols. As described in the section 
“Different types of text” on page 157, there are several dif-
ferent types of text symbols, but the basic procedures are 
the same (except for block text symbols, see “Block Text” 
on page 159, and page text symbols, see “Page text” on 
page 159).

Inserting a text symbol
1. If you wish, select a font, size and style for the text (or 
select a text attribute), as described in the section “Selec-
ting font, size and style for the text” on page 156.
The text you insert will use the text settings made when no text is se-
lected, but you can change all settings after you inserted the text.

2. Open the desired symbol tab in the Inspector.
The different text symbols are found on the Other, Layout and Project 
symbol tabs. For information on how to show Inspector tabs, see “Sho-
wing/Hiding symbol Inspector tabs” on page 128.

3. Click on the text symbol in the tab to select the Pencil 
tool.

4. Make sure the correct staff is active, and click in the 
score at the position where you want the text to appear.
If you are adding lyrics, you should click above or below a note (lyrics are 
centered around each note and positioned vertically to where you 
clicked). See “Lyrics” on page 157.

5. Enter the text in the text box that appears.
You can use [Backspace] to delete letters, and move the cursor with the 
arrow keys. 

6. When you are done, press [Return].
The text appears. You can move, duplicate or delete it as with any symbol.

About the melisma lines
When you add a text symbol, you will find a handle at the 
right edge of the text. By dragging this handle to the right, 
you can extend a “melisma line” from the text. This has 
several uses:

• If you are adding lyrics and want to indicate that a syllable 
should be sung over several notes:

• If the text is an advice about articulation or playing style, and 
you want it to apply to a certain musical phrase only:

• If the text is an advice about articulation or playing style, and 
you want it to apply from that point on in the score:

On the Score Settings–Project page, Text Settings sub-
page, you will find two settings that determine the appear-
ance of the melisma lines:

• The Melisma Style pop-up is where you specify whether the 
line should be solid or dotted.

• The Melisma End pop-up allows you to choose whether the 
end of the line should be plain, have an arrow, or form a 
“bracket” up or down.

Making space
• If you find there isn’t enough space between staves, e.g. to 

add lyrics, please see “Dragging staves” on page 180 for info 
on how to separate the staves.

• If you find the score looks crammed after adding text, see 
“Auto Layout” on page 182.
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Editing the text
If you made a mistake when typing or for some other rea-
son wish to change text, double-click on a text block with 
the Object Selection tool, edit the text and press [Return] 
to close it.

• It is also possible to replace all occurrences of a certain 
word in the score, without having to edit the texts manually, 
see “Find and replace” on page 161.

Selecting font, size and style for the text
1. Select the text symbol(s) you want to make settings for.
If nothing is selected, the settings you make will be the “default settings”. 
The next time you insert text, these settings will be used.

2. Open the Score Settings–Text page.

3. Select a font from the Font pop-up menu.
How many and which fonts appear depends on what typefaces you have 
installed on your computer. 

4. Select a text size from the Size pop-up menu (or enter 
one manually in the text field). 

5. If you wish, add one or several text style options using 
the checkboxes and pop-up menus.
Most of the options are common text style variations such as bold, italic, 
underline, etc. But there are also a few special style options:

6. Click Apply to apply the settings to the selected text.
Note that you can select other text blocks while the dialog remains open – 
the dialog will be updated to reflect the settings of the currently selected 
text.

7. When you are done, close the Score Settings dialog.

Text attribute sets
A text attribute set can be seen as a “preset” containing all 
font, size and style settings. By creating text attribute sets 
for the settings you use most often, you can save a lot of 
time.

Creating a text attribute set

1. Open the Score Settings–Project page and select the 
Text Settings subpage.

2. Open the Attribute Sets tab.

3. Pull down the Set pop-up menu and select the “Empty” 
set.

4. Select a font, specify a size and add style options us-
ing the checkboxes.
The options are the same as when you make text settings on the Score 
Settings–Text page (see above).

5. Click in the Set field and enter a name for the new text 
attribute set.

6. Click Store to store the new text attribute set.

Using text attribute sets

To apply the settings in the text attribute set to one or sev-
eral text blocks, select them, select the set from the Set 
pop-up menu on the Score Settings–Text page and click 
Apply. You can also apply a text attribute set to a text 
block directly in the score by right-clicking it and selecting 
the set from the context menu that appears.

• If you select a text attribute set on the Text page when 
no text is selected in the score, the settings will be used 
the next time you insert some text.

After you’ve selected a set for a text block, there will 
be a “link” between the text and the attribute set. Any 
changes to the attribute set will affect all texts that use it 
(see below). 
You can still edit any text settings manually (on the Project–Text Settings 
subpage) but then the “link” to the attribute set will be removed.

! For regular text you should probably avoid the “Stein-
berg” fonts. These are the fonts Nuendo uses for all 
scoring symbols, etc.

Option Description

Frame Allows you to put the text in a rectangular (“Box”) or oval 
frame.

Melisma 
options

These determine the appearance of the “melisma line”, as 
described in the section “About the melisma lines” on 
page 155.

Positioning Allows you to select which side of the text block (left or 
right) should be used for calculating its position.This has 
an effect in situations where that text block is moved au-
tomatically (as a result of an Auto Layout function, when 
you move bar lines manually, etc.). If, for example, the text 
block appears just in front of a note (to the left of it), it will 
appear in a more sensible position after the adjustment, if 
the “Right” option is selected.

Alignment:
Left/Center/
Right

Allows you to specify the alignment of the text. These op-
tions are only valid for texts with more than one line.
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Editing text attribute sets

If you edit the settings in a text attribute set, all texts using 
this particular set will be affected. This is very practical, 
since it allows you to use the same number of “generic” 
sets for all your projects (for titles, comments, lyrics, etc.), 
and simply change the fonts, sizes, etc. for a different 
project if necessary. This will also make it easier to move 
projects between computers (which may not have the 
same fonts installed).

1. Select the Attribute Sets tab on the Text Settings sub-
page of the Score Settings–Project page.

2. Select the attribute set you want to edit from the Set 
pop-up menu.

3. Change the settings as desired.
This includes the name of the set.

4. Click Apply.

Different types of text

Regular text

The regular Text option selected.

This type of text is inserted by selecting Text in the Other 
or the Layout symbol tabs.

The text is tied to the bar and staff position. If you move 
the bar or the entire staff, it moves with it.

Pasting text

You can paste text (e.g. from another program) into a text 
symbol in the score. To do this, select the text symbol and 
right-click it. Then, select “Text from Clipboard” from the 
context menu. This option is also available on the Func-
tions submenu of the Scores menu.

Similarly, you can copy selected text by using the “Text to 
Clipboard” option from the context menu.

Lyrics

The Lyrics option selected.

This type of text is inserted by selecting Lyrics on the 
Other symbol tab.

When you insert lyrics, you should click below or above 
the note the syllable belongs to. The text will then appear 
horizontally centered around the note and vertically posi-
tioned to where you clicked. You can later move it up or 
down, as with any symbol.

Lyrics are tied to the note position. If you move the note, 
the text moves with it. The spacing between notes is also 
adjusted to make the lyrics fit.

Inserting lyrics for a number of notes

1. With lyrics selected, click below or above the first note 
with the Pencil tool.

2. A text input field is opened. Enter the text (the word or 
syllable) for that note.

3. Hit [Tab].
The program moves on to the next note.

4. Input text for this note and hit [Tab] again.

5. Proceed until the last note and then press [Return] or 
click outside the text box.

When you insert lyrics this way, the positions of the notes 
will automatically be adjusted so that no lyric “block” over-
laps another. If this is not what you want, you can activate 
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the option “Don’t Sync Lyrics” in the Lyrics category on the 
Score Settings–Project page (Notation Style subpage). If 
this is activated, the note positions will not be affected, 
which may be preferable.

• When entering words with several syllables you nor-
mally separate the syllables with a dash (-). By default, the 
dash signs are automatically centered between the sylla-
bles – if this is not what you want, activate the option 
“Don’t Center Hyphens” in the Lyrics category on the 
Score Settings–Project page (Notation Style subpage).

Lyrics and measure widths

When you first enter lyrics, the result may look crammed, 
since the words take up more space than the notes (the lyr-
ics are also selected just after entering the last word, which 
will make them look a bit odd when overlapping). To rem-
edy this, use the auto layout function to automatically adjust 
the measure widths (see “Auto Layout” on page 182).

Before and after using the auto layout function.

Adding a second verse

To insert a second line of lyrics, proceed as follows:

1. Enter the new lyrics above or below the existing verse.

2. Select all the words that should be in the new verse.

3. Right-click the selected words to open a context 
menu.

4. Select the appropriate verse from the Move To Verse 
submenu (Verse 1–6).
This assigns the selected lyrics to the selected verse.

To indicate that the words belong to another verse, they 
are automatically displayed in another color. However, all 
verses will print in black as usual.

• To select all words in one verse only, press [Shift] and 
double-click on the first word in that verse.
This selects all following words in the verse.

Inserting lyrics into voices

Each voice can have its own lyrics. If for example you have 
a vocal arrangement with several voices, you can add ly-
rics to them, one by one.

1. Click on the Lyrics symbol in the Other symbol tab, so 
that the Pencil tool is selected.

2. Make sure the correct voice is selected (on the ex-
tended toolbar). See “Entering notes into voices” on page 
99.

3. Click on the first note in the selected voice.

4. Enter the lyrics for this voice, using the [Tab] key to 
move from note to note, as described above.

5. Start over, by activating the next voice, clicking on the 
first note in that voice and proceeding as with the first voice.

6. If needed, adjust the position of the lyrics for each 
voice (see below).

Moving lyrics

If you want to move the lyrics up or down, for example to 
make room for a second verse, proceed as follows:

1. Hold down [Shift] and double-click on the first word in 
the lyrics.
All lyric “blocks” are selected.

2. Drag one of the lyric blocks up or down.
All selected lyric blocks are moved accordingly.

Adding lyrics from the clipboard

If you want to prepare your lyrics in another program, you 
can import them into Nuendo the following way:

1. Create the lyrics in another program.
Separate words with space as usual, syllables within words with dash 
signs (-).

2. Copy the text.

3. In Nuendo, select the first note to which the lyrics 
should be added.

4. Pull down the Scores menu and select “Lyrics from 
Clipboard” from the Functions submenu.
The lyrics are added, starting at the selected note.
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Layout text
The text symbols in the Layout symbol tab are part of the 
layout layer, and can thus be hidden or shown for different 
tracks in the layout, by activating the “L” column on the 
Score Settings–Layout page. The text will appear in all 
staves, for which you have activated the “L” column. This 
means it is tied to the bar and staff position. If you move 
the bar or the entire staff, it moves with it.

Block Text
Block Text allows you to import text from a file on disk or 
from the clipboard. Proceed as follows:

1. Click on the Block Text symbol in the desired tab to 
bring up the Pencil tool.
You can choose between project layer block text (from the Project tab –
useful for text that should appear on all pages, e.g. the score title), layout 
layer block text (from the Layout tab – if you want to print a title only for a 
particular track layout, e.g. for a particular instrument), or block text used 
for individual parts (from the Other tab – this text will only appear in the 
score for a particular part).

2. Click in the score where you want to insert the text.
A regular file dialog appears.

3. Select a text file or rtf file to import.

4. Click Open.
The text in the file is inserted into the score.

• Right-clicking on inserted Block Text brings up a pop-
up menu with the following options:

The RTF Settings dialog

Selecting “Properties” from the context menu (or double-
clicking the Block Text) brings up a dialog with settings for 
the Block Text. These are:

Page text
The page text symbols are found on the Layout and 
Project tabs. They work the same way, but Project Page 
Text is part of the project layout, and will therefore appear 
in all layouts. 

The position of page text isn’t tied to a note, bar or staff 
position. In other words, it doesn’t matter if you move 
other objects on the page, the page text stays where you 
put it. Typically, it’s used for score titles, page numbers, 
copyright information and other text elements that you 
want displayed with all parts (on all pages if you like).

Proceed as follows to enter Page text:

1. Open the Layout or the Project tab of the symbols 
Inspector.

2. Click on the Page Text symbol to bring up the Pencil 
tool.

3. Click in the score.
It doesn’t matter where you click – the positioning is specified in the dia-
log that appears.

4. Enter the text you want displayed in the field at the top 
of the dialog.
You can use special characters to add “variables” such as page numbers 
– see below.

Menu item Description

Import Text… Imports text from a text file or rtf file. The imported text will 
replace any text currently inserted at the position of the 
Block Text.

Update Text Reloads the text from the file.

Text From 
Clipboard

Pastes the text from the clipboard into the Block Text.

Text To
Clipboard

Copies the Block Text to the clipboard.

Hide Hides the inserted block text. To make the text visible 
again, activate the Hide checkbox in the display filter bar, 
right-click on the text “Hidden” which is displayed for the 
hidden text and select “Show” on the context menu.

Properties Brings up the RTF Settings dialog. You can also open 
this by double-clicking the Block Text.

Setting Description

Font Lets you select the font to use for the Block Text. If “No 
Change” is selected, the font in the original file (if appli-
cable) is used.

Size The text size, as a percentage.

Draw Frame When this is activated, a frame is shown around the 
Block Text.

Word wrap When this is activated, line breaks are used to fit the text 
in the Block Text symbol.

Replace mode In this mode, the Block Text box will be opaque, covering 
what’s under it.

Trans mode In this mode, the Block Text box will be transparent.
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5. Adjust the settings for how the text should be posi-
tioned:

6. Select a text attribute set for the text, or make manual 
settings for font, size and style.

7. Click OK.
The text is inserted. You can adjust the positioning manually by dragging 
the text block.

Inserting variables

When you enter the text, you can also insert special char-
acters or “place holders” for different attributes. When the 
text is displayed, these characters will be replaced by their 
actual values (e.g. page numbers). The following variables 
are available:

For example, if you enter the text “%l, %r, Page %p”, these 
variables might be shown as “1st Violin, Quartet No.2, 
Page 12” in the score.

Using the Score Settings (Text page)
In the Score Settings (Text page) you can find a number of 
text-related settings. The symbol buttons correspond with 
the symbols found on the Other tab, the Layout tab, and 
the Project tab of the symbols Inspector, see “Symbol de-
tails” on page 144. You can use the Layer pop-up menu 
to switch between the display of the corresponding layers. 

• Select the layer you wish to use from the Layer pop-up 
menu.
The text symbols available for this layer will be displayed to the left of the 
pop-up menu.

• You can use the text symbols in the same way as you 
would use symbols from the Inspector or a symbol palette.
When you select a text symbol from the Score Settings–Text page, and 
move the mouse pointer over the score, the pointer will change to a pen-
cil, and you can enter text at the position you click on.

The Notepad tab and the Selection tab

Below the text symbols and the Layer pop-up you can find 
two tabs with large text entry fields.

• Use the Notepad tab to enter longer text passages. 
When you are happy with the text in terms of wording and 
length, select all or part of the text, and select a note in the 
score. Now, the Insert Lyrics button below the Notepad 
tab becomes available. 
When you click Insert Lyrics, the selected text will be entered into the 
score, starting from the note you selected.

• When you select text in the score and open the Selec-
tion tab, the selected word(s) are shown in the text field. 
You can now change the wording of the text, and use the 
text format options to the left to change the appearance of 
the selected text. When you are happy with the text and its 
formatting, click Apply in the Score Settings dialog to ap-
ply your changes to the selected text in the score.

Option Description

Show on all 
pages

When this is activated, the text will be shown on all 
pages. The “Except First” checkbox allows you to exclude 
the very first page.

Show on first 
page

When this is selected, the text will only be shown on the 
first page.

Line This determines how the text should be aligned. For ex-
ample, if you place several texts on “Top/Left”, you can 
sort them by entering the desired number of lines.

Toggle 
Position

When the Left or Right position option is selected to the 
right, activating this checkbox will make the text alternate 
between left and right alignment on even/odd pages.

Position 
buttons

Determines where on the page you want the text, verti-
cally (Top/Bottom) and horizontally (Left, Center, Right). 

Text to enter Text that will be displayed

%p The current page number.

%l 
(lower case L)

The long staff name.

%s The short staff name.

%r The name of the project.
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Text functions

The Words tab
If you have certain words that you use a lot, you can 
“store” these as dedicated symbols on the Words tab. 
This will save time, since you don’t have to type the same 
word over and over again.

Storing a word

1. Open the Words symbol tab.
This tab is hidden by default. See “Showing/Hiding symbol Inspector 
tabs” on page 128 for information on how to display hidden Inspector 
tabs.

2. Double-click on an “empty” symbol.
The Custom Text Editor dialog appears.

3. Type in the desired word(s) in the text field at the top 
of the dialog.

4. Specify the text type (regular text or lyrics) with the 
Type pop-up.

5. Make settings for font, size and style.
You can also use a text attribute set if you like.

6. Click Exit to close the dialog.
The word(s) you entered appear in the selected symbol field on the 
Words tab.

• Right-clicking one of the fields opens a context menu 
with a number of options:

• Select “Edit…” to open the Custom Text Editor dialog.
• Select “New” to add a new empty symbol to the Words tab.
• Select “Remove” to delete any unwanted symbols from the 

Words tab.
• Select “Open As Palette” to open the Words symbol palette.

Inserting a word

You insert words from the Words tab as you would insert 
any regular symbol, by selecting the appropriate word and 
clicking in the score. However, you can edit the word after 
inserting it, just as with text inserted by typing.

Find and replace
This function allows you to replace all occurrences of a 
certain word or group of words, with another word or 
group of words. The replacement is done once and for all, 
for all text symbol types, regardless of font, size and style 
settings. Proceed as follows:

1. Pull down the Scores menu and select “Find and Re-
place” from the Functions submenu.
A dialog appears.

2. Enter the word(s) to replace in the Find value field.
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3. If you want all instances of the word(s) to be replaced, 
regardless of upper/lower case, deactivate the “Case 
Sensitive” option.

4. If you don’t want to replace the word(s) if they are a 
part of another word, activate the “Entire Word” option.
For example, if you want to replace the word “string” but not the word 
“stringendo”, you should activate “Entire Word”.

5. Enter the word(s) that should be used as replacement 
in the “Replace” field.

6. Click OK.
Now all occurrences of the “Find” word(s) will be replaced with the 
“Replace” word(s).

Staff names
You can make settings for staff names in several places:

• On the Score Settings–Layout page, you specify wheth-
er the staff names should be shown at all, and whether to 
use the names of the actual edited tracks in the score.
In a multi-track layout, you can choose for which tracks the staff names 
should be shown, by clicking in the “N” column for each track.

• You specify a long and short staff name on the Score 
Settings–Staff page (Main tab).
These will be used if you don’t use the “From Tracks” option on the Score 
Settings–Layout page. The long name will be displayed for the first system 
only, and the short name for the following systems. If you want a name at 
the top of the page only, leave the “Short” name field empty.

You can select a font for staff names on the Text Settings 
subpage of the Score Settings–Project page. Proceed as 
follows:

1. Open the Score Settings–Project page and select the 
Text Settings subpage.

2. Select the Project Text tab.

3. Use the “Font for” pop-up menu to select “Staff 
Names”.

4. Select font, size and styles for the staff names (or use 
a text attribute set).

5. Click Apply and close the Score Settings dialog.

Additional staff name settings

• If you activate the option “Show Track Names to Left of staff” 
on the Notation Style subpage (Staff Names category) of the 
Score Settings–Project page, the staff names will be shown 
to the left of the staves, instead of above them.

• You can define separate subnames for the upper and the 
lower staff in a polyphonic or split system, see “Staff names” 
on page 107.

• You can fine-tune the vertical and horizontal position of staff 
names with some of the options on the Spacing subpage of 
the Score Settings–Project page.

Bar Numbers
Bar Number settings can be made in several places as 
well:

General settings

1. Open the Notation Style subpage of the Score Set-
tings–Project page.

2. Scroll down the list to the “Bar Numbers” category.

3. Use the “Show every” setting to specify how often bar 
numbers should be shown.
The options are “First Bar” (bar numbers shown for the first bar on each 
staff), “Off” (no bar numbers shown) and any number. Click in the Status 
column and use the mouse wheel to select the desired option.

4. If you like, activate the “Show Range with Multi-Rests” 
option.
When this is activated, and you have a multi-rest, the bar number at the 
beginning of the multi-rest will show a range, indicating the length of the 
multi-rest.

5. If you want the bar numbers to be displayed below the 
bar lines, activate the “Below Bar Lines” option.

6. Click Apply and close the Score Settings dialog.

Text settings

As with many of the other fixed text elements, you can se-
lect a font, size and style for bar numbers on the Text Set-
tings subpage of the Score Settings–Project page.

! If the option “Show Long Track Names on new 
Pages” is activated on the Notation Style subpage 
(Staff Names category) of the Score Settings–Project 
page, the long name will be displayed for the first sys-
tem on every page.
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Spacing

On the Spacings subpage of the Score Settings–Project 
page you will find four settings that relate to bar numbers:

Offsetting bar numbers

If you double-click on a bar number, a dialog appears, al-
lowing you to skip a number of bars in the otherwise con-
tinuous bar numbering.

This is used for example when a section repeats. Say, you 
have a repeat of bar 7 and 8, and want the first bar after 
the repeat to have the number 11, not 9. To achieve this, 
you double-click on the “9” and insert an offset of “2”.

It is also useful if the score starts with an upbeat, and you 
want the first “real” bar to be numbered 1. In that case you 
would specify an offset of “-1” for the second bar, and 
make sure the bar number for the upbeat bar is hidden.

• Bar number offsets belong to the Project layer and are 
shown for all tracks and layouts.

Settings for other fixed text elements
You can make text settings for virtually all text and num-
bers that appear in the score. Proceed as follows:

1. Open the Text Settings subpage of the Score Set-
tings–Project page.

2. Select the Project Text tab.

3. Use the “Font For” pop-up menu to select a text type 
to make settings for.

4. Use the options in the dialog to change the settings.

5. Click Apply to apply the settings to all elements of the 
selected type.
To close the dialog, click the close button at the top right of the dialog 
window.

Bar Numbers before and after changing their text settings.

• You can also define text attribute sets on the Text Set-
tings subpage, as a means to quickly change text.
Note that you can select a defined attribute set from the context menu 
opened when right-clicking on a text element (see “Text attribute sets” 
on page 156).

Option Description

First Bar Number – 
Horizontal Offset

Sets the horizontal distance between the bar number 
and the bar line for the first bar on each staff.

First Bar Number – 
Vertical Offset

Sets the vertical distance between the bar number 
and the bar line for the first bar on each staff.

Other Bar Numbers – 
Horizontal Offset

Sets the horizontal distance between the bar number 
and the bar line for all other bars.

Other Bar Numbers – 
Vertical Offset

Sets the vertical distance between the bar number 
and the bar line for all other bars.
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About this chapter
In this chapter you will learn:

• What layouts are and what they contain.
• How to create layouts.
• How to use layouts for opening combinations of tracks.
• How to apply, load, save and delete layouts.
• How to import and export layouts.
• An example of how layouts can be used.

Background: Layouts
Layouts can be viewed as “presets” containing settings for 
the layout layer: staff spacing, bar lines, layout symbols etc.

When to use layouts
• You will need to format the score differently when you print the 

entire score and when you extract parts for single instruments 
(or groups of instruments). Layouts allow you to keep different 
sets of “looks” for the same track or set of tracks. You might 
for example have one layout for each single instrument and 
one for the entire score.

• By selecting another layout on the Score Settings–Layout 
page, you can switch to another combination of tracks without 
having to leave the Score Editor.

What makes up a layout?
A layout contains the following items and properties:

• The inserted Layout symbols (see “The available symbols” on 
page 129).

• All settings on the Layout page of the Score Settings dialog.
• The vertical spacing of the staves.
• Bar line spacing.
• Broken bar lines.

Note that Project symbols (see “The available symbols” 
on page 129), bar line types and bar number offsets are 
part of the Project layer, and will appear in all layouts.

How layouts are stored
Layouts are created automatically when you edit a single 
track or a combination of tracks. They are an integral part 
of the specific track combination, which means you do not 
have to store them separately.

Creating a layout
Layouts are created automatically when you open a new 
combination of tracks for editing.

Each track may have been edited before, individually or to-
gether with other tracks, it doesn’t matter. What matters is 
that you open precisely these tracks. For example, to cre-
ate a layout for a string quartet, select parts on the corre-
sponding tracks and press [Ctrl]/[Command]-[R].

Opening a layout
The “Open Layout” command on the Scores menu opens 
a dialog listing all available layouts for the Project. 

• Select the desired layout in the list and click OK to open 
the tracks contained in the layout in the Score editor.
This is a quick way for opening several tracks in the Score editor directly 
from the Project window.

Layout operations
The Score Settings dialog contains a Layout page, where 
you can make settings for the different layouts. To the left 
of the dialog, all existing layouts in the project are listed 
(this is the same list as in the Open Layout dialog, see 
above). The layout currently used is highlighted in the list.

The Score Settings–Layout page.

! The order of the tracks does not matter – you can re-
order them in the Project window without removing 
the layout. However, the spacing of the staves in the 
layout is related to the order of the tracks.
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Here you can perform a number of operations:

Opening the tracks in a layout
To select another combination of tracks for editing, select 
the corresponding layout in the list.

• You can keep the dialog open while you are editing, and 
use this function for selecting which tracks to edit.

Importing layout symbols
By selecting another layout and selecting “Get Form” from 
the Functions pop-up menu below the list, you import all 
Layout symbols (inserted from the Layout symbol Inspector 
section) from the selected layout into the current layout.

Managing layouts
• To rename a layout, select it in the list and enter the de-
sired name in the Name field to the right in the dialog.
Initially, a layout gets the name of one of the edited tracks – it may be a 
good idea to give each layout a more informative name.

• To remove a layout you no longer need, select it in the 
list and select “Remove” in the Functions pop-up menu.

• To remove all layouts for which there no longer are track 
combinations, select “Clean Up” from the Functions pop-
up menu.

Importing and exporting layouts
By selecting a layout and selecting “Export…” or “Im-
port…” from the Functions pop-up menu below the list, 
you can export or import a Layout. Note, that all Staff set-
tings will be taken into account, when exporting or import-
ing a layout.

Working with Display Transpose
You can specify for each staff in a layout whether it should 
use display transpose. Just click in the D column in the 
Score Settings–Layout page to activate or deactivate the 
option. Note that this setting affects this layout only!

Using layouts – an example
The following text outlines the basic steps for extracting a 
musical part from a full score.

1. Prepare the entire score, including all formatting.
This might include inserting Project layer Block Text for the Score title, 
setting the bar line type, etc.

2. Open the Score Settings–Layout page and enter the 
desired name in the Name field (for example “Full Score”).

3. Close the Score Editor.

4. Open a single track, for example a woodwind part.
The Project layer settings will automatically appear in the new single 
track layout.

5. Prepare a layout for the woodwind part.
You might for example move bar lines, add endings, activate multiple 
rests, etc.
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• You can also import all layout symbols from the “Full 
Score” layout, by opening the Score Settings–Layout 
page, selecting the “Full Score” layout in the list to the left 
and selecting “Get Form” from the Functions pop-up 
menu (see “Importing layout symbols” on page 166).

6. Enter the desired name for the new layout in the Name 
field on the Score Settings–Layout page and click “Apply”.

Marker Track to Form
If you have created markers in the Project window which 
denote the start of each new “section” in your music 
(verse, bridge, chorus, etc.), you can automatically transfer 
these markers into the current layout:

1. Pull down the Scores menu and open the Advanced 
Layout submenu.

2. Select “Marker Track to Form”.
Now, rehearsal markers and double bar lines are inserted in the score, at 
the position of each marker.

3. If you want the names of the markers shown as well, 
open the Advanced Layout submenu again and select 
“Display Markers”.

! Be careful not to change any of the properties which 
are not part of the layout (or you will modify the “Full 
Score”, too!).
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Introduction
MusicXML is a music notation format developed by Recor-
dare LLC in 2000 based primarily on two academic music 
formats. It allows the representation of scores in the cur-
rent symbolic representation of western music notation, 
used since the 17th century. With Nuendo you can now 
import and export MusicXML files created with version 
1.1. This makes it possible to share and exchange sheet 
music with people who are using score writing programs 
such as Finale and Sibelius.

As MusicXML is supported to various degrees by dif-
ferent programs, you will always have to do manual adjust-
ments.

What is MusicXML used for?
The MusicXML file format can be used for the following 
purposes:

• Representation and printing of sheet music
• Exchange of sheet music between various score writing 

programs 
• Electronic distribution of musical scores 
• Storage and archival of scores in an electronic format 

Notational representation vs. musical performance

MusicXML is a music notation file format, that means it 
deals especially with the layout of music notation and the 
correct graphical representation, i.e. how a piece of music 
should look. 

However, MusicXML music data also contains elements 
that define how a piece of music should sound. These are 
used e.g. when creating a MIDI file from MusicXML. This 
means that MusicXML has things in common with MIDI. 

MIDI is a music interchange format for performance appli-
cations like Nuendo or other sequencers. The MIDI file for-
mat is designed for playback, i.e. the main focus of the MIDI 
file format lies in the performance, not in the notation. 

Is MusicXML better than MIDI?

Advantages of MusicXML

MIDI tracks hold MIDI notes and other MIDI data. A MIDI 
note in Nuendo is only defined by its position, length, pitch 
and velocity. This is not enough to decide how the note 
should be displayed in a score. For a correct representa-
tion, Nuendo also needs the following information:

• Stem direction, beaming.
• Expression marks (staccato, accent, ties and slurs). 
• Information about the instrument in the score.
• Key and basic rhythm of the piece.
• Grouping of notes, etc.

MusicXML can store great part of this information. How-
ever, you will have to adjust the scores with the tools avail-
able in the Score Editor.

Advantages of MIDI

MusicXML was designed for online sheet music while 
MIDI was created for electronic musical instruments. Al-
though MusicXML has obvious advantages in the repre-
sentation of musical scores, there are also restrictions in 
sound. This is due to the fact that MusicXML as a music 
notation format has a graphical background and is de-
signed for exchanging representation, not sound. 

When playing back MusicXML files in Nuendo, the follow-
ing parameters, among others, will not be considered:

• On and Off velocities
• Dynamics 
• Controller data
• SysEx
• Standard MIDI file meta events
• Audio
• All Nuendo-specific data like automation, MIDI effects, Input 

Transformer, etc.
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Importing and exporting MusicXML 
files
Nuendo can import and export MusicXML Files, which 
makes it possible to transfer musical scores to and from 
applications that support this file format. However, there 
are some restrictions concerning the parameters sup-
ported by Nuendo:

Importing MusicXML files
1. Pull down the File menu and open the Import submenu.

2. On the submenu, select “MusicXML…”.

3. In the file dialog that opens, locate and select the Mu-
sicXML file and click “Open”.

4. Another file dialog opens in which you can select the 
project folder for the new project.
Select an existing project folder or create a new one by clicking on “Cre-
ate” and entering a name in the dialog.

5. A new project is created with the name of the of the 
MusicXML file.

Export Import

Notes

Pitch Yes Yes

Length Yes Yes

Staves Yes Up to two per part

Voices Yes Up to four per staff

Accidentals Yes Yes

Ties Yes No

Dots Yes No

Stem Yes Yes

Beams Yes No

Grace Notes Yes Yes

Rests Yes Yes

Layout

Page Size Yes No

Page margins Yes Yes

Page scaling Yes Yes

Page breaks Yes No

System breaks Yes Yes

Distance between 
staves and systems

Yes Yes

Left/right Inset Yes No

Distance between 
measures

Yes No

Hidden staves Yes Yes

x and y positions of 
symbols

Yes Yes

Symbols

Keys Yes Yes

Clefs Yes Yes

Time Signature Yes Yes

Dynamics Yes Yes

Ornaments Yes / incomplete Yes / incomplete

Articulations Yes / incomplete Yes / incomplete

Technicals Yes / incomplete Yes / incomplete

Lyrics Yes Yes

Chord Symbols Yes Yes

Damper Pedal Yes Yes

Dynamics Yes Yes

Rehearsals Yes Yes

Text Yes Yes

Layout Text Yes N.A.

Global Text Yes “Credits”

Dashes Yes Yes

Endings Yes Yes

Octave Shift Yes Yes

Bar line types Yes Yes

Slurs Yes Yes

Hammer-on/pull-off No No

Formatting

Display transpose Yes Yes

Drum notation Yes Yes

Short / long staff names Yes Yes

Program changes Yes N.A.

Music font Yes (if Jazz font) Yes

Tablature (including 
String tunings)

Yes Yes

Drum notation Yes Yes

Export Import
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Exporting MusicXML files
1. Set up the score the way you want it in the Score editor 
of Nuendo.

2. Open the File menu and open the Export submenu.

3. On the submenu, select “MusicXML…”.
Note that this option is only available when the Score editor is opened.

4. A file dialog opens in which you can choose an exist-
ing empty folder or create a new folder for saving the Mu-
sicXML file (as *.xml file).
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About this chapter
In this chapter you will learn:

• How to change the staff size.
• How to create multi-rests.
• How to add and edit bar lines.
• How to create upbeats.
• How to set measure spacing and the number of bars across 

the page.
• How to control staff and grand staff spacing.
• How to use the Auto Layout dialog.
• How to use the Reset Layout function.
• How to break bar lines.

Layout settings

The Score Settings–Layout page contains a number of 
settings that affect the display of the current layout.

The track list
The track list lists the tracks included in the layout and al-
lows you to make the following settings:

Equal Spacing
• Activate this option when you want a note to take up 
space according to its note value. When Equal Spacing is 
activated, two sixteenth notes will take up as much space 
as one eighth note, for example.
When this is deactivated, the note spacing will be spaced automatically.

Size
Changes the size of all staves. See “Staff size” on page 
174.

Multi-Rests
Whenever more than one-bar rests occur, the program can 
replace these with a multi-rest symbol. This parameter al-
lows you to set how many empty bars should be “allowed” 
before Nuendo should collect them into a multi-rest. “Off” 
means “never”. See “Multiple rests” on page 176 for more 
information on multi-rests.

Real Book
When this option is activated, clef symbols are not set out 
at the beginning of each staff, only on the first staff on 
each page.

! Before you start designing the score page layout, 
you should open the Page Setup dialog on the File 
menu, and make settings for paper size, print scale 
and margins!

Option Description

Brackets These two columns allow you to add braces or brackets, 
encompassing any number of staves in the layout. See 
“Adding brackets and braces” on page 181.

T This is relevant if the Modern Time Signature option is ac-
tivated to the right. In that case, you use this column to 
specify for which tracks the time signature should be 
shown – see below.

N Determines whether the staff name should be shown for 
each staff in the layout.

L If this is activated, any layout symbols will be shown; oth-
erwise they will be hidden. This allows you to e.g. have re-
hearsal markers shown for the top staff only in a multi-staff 
layout.

D This option lets you specify for each staff in a layout 
whether it should use display transpose.
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Staff Separators
When this option is activated, separator symbols are in-
serted at the beginning of each grand staff.

A staff separator between two systems.

Modern Time Signature
When this is activated, time signatures are shown above 
the staves rather than in them. You can set the size of the 
modern time signature in the Time Sign section on the 
Score Settings–Project page (Notation Style subpage). 
Also note that when modern time signature is selected, 
you use the “T” column in the track list in the Layout page 
to specify for which tracks time signatures should be dis-
played.

• If you prefer to display the score in a more modern way, 
check out the other options on the Notation Style subpage!
For descriptions of the options use the Help button in the dialog.

Staff size

For one staff
You can set the staff size as a percentage value of the 
normal size.

1. Open the Score Settings–Staff page for the staff you 
are interested in.

2. Select the Options tab.

3. Adjust the Size parameter in the System Sizes section.
The values range from 25% up to 250% of the normal size.

4. Click Apply.

For all tracks in a layout
1. Open the Score Settings–Layout page.

2. Change the Size parameter.
The values range from 25% up to 250% of the normal size.

3. Click Apply.

All staves will now get the desired size. Staves that have 
individual size settings (see above) will still be proportion-
ally smaller/larger. 

This setting is part of the layout and can for example be 
used when printing a full score slightly smaller than the 
parts for each instrument.

Hiding/showing objects
“Any” object on a page can be hidden, including notes, 
rests, symbols, clefs, bar lines, even entire staves. You can 
make a page totally blank this way (well, actually, one staff 
has to remain shown). Applications can be found below.

Hiding
To hide items proceed as follows:

1. Select all the items you want to hide.

2. Select “Hide/Show” from the Score menu or click on 
the “H” (Hide) button on the extended toolbar.

• Notes can also be hidden by selecting them, clicking 
the “i” button on the extended toolbar and ticking the Hide 
Note check box in the Set Note Info dialog (see “Other 
note details” on page 114).

! If the Hide option in the display filter bar is activated, 
hidden objects are shown in grey so that they are still 
visible and you can select them.
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Hiding in this layout only
If you want the hiding to be “local” to the current layout, 
hold down [Ctrl]/[Command] when selecting “Hide/Show” 
as described above.

You can also move hidden objects to the layout by 
right-clicking the “Hide” marker and selecting “Move to 
Layout”.

Viewing hidden objects
The display filter bar (shown by clicking the “Show Filter 
View” button on the toolbar) contains two options related 
to hidden objects:

• If you activate the “Hidden Notes” option, all hidden 
notes in the score are shown.
Deactivating “Hidden Notes” will hide the notes again.

• If you activate the “Hide” option, all hidden objects 
(except notes) will be indicated by a “Hide” text marker.

Showing one object
1. Make sure “Hide” is activated on the display filter bar.

2. Click on the “Hide” text marker below the object you 
want to display.
The text is selected.

3. Press [Backspace] or [Delete].
The object appears. Undo is available if you change your mind.

Showing all objects
If you select “Hide/Show” from the Scores menu again, all 
hidden objects are displayed.

• You can also use the Reset Layout function to perma-
nently display hidden notes and objects, as described in 
the section “Reset Layout” on page 183.

Showing a hidden note
While all hidden notes can be made visible by ticking the 
Hidden Notes checkbox on the display filter bar, you may 
want to make some of them “permanently” visible again:

1. Activate the Hidden Notes checkbox on the display fil-
ter bar.

2. Select the notes that you want to “un-hide”.
In the Preferences dialog (Scores–Use Colors for Additional Meanings) 
you can set the color for hidden notes.

3. Double-click one of the notes.

4. Deactivate the Hide Note option in the Set Note Info 
dialog and click Apply.

Applications of hiding

Printing scales

If you want to create scale examples, enter the notes and 
hide time signatures, bar lines and other unnecessary ob-
jects.

A scale created with hidden bar lines, time signatures etc.

Graphic notation

By hiding bar lines, you can produce graphic notation.

Hiding notes meant for playback only

If you have recorded your music, you may have added glis-
sandos, falls, etc. that sound fine but result in a lot of un-
necessary notes. You probably want to hide those notes 
and insert the suitable symbols instead.

Coloring notes
You can use the color pop-up menu on the toolbar to col-
orize selected notes, e.g. for educational purposes. This is 
described in detail in the section “Coloring notes” on 
page 115.

! This is not possible when hiding notes, only other 
symbols.
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Multiple rests
Multiple consecutive rests can be automatically displayed 
as multi-rests. Proceed as follows:

1. Open the Score Settings–Layout page.

2. Set the Multi-Rests option to the number of empty 
bars that should be “allowed” before Nuendo will display 
them as a multi-rest.
For example, a value of 2 means that three or more consecutive empty 
bars will be displayed as a multi-rest. If you set this to “Off”, multi-rests 
will not be used.

3. Click Apply and close the dialog.
The multi-rests now appear in the score.

A multi-rest over three bars.

Splitting multi-rests
To divide one long multiple rest into several shorter ones, 
proceed as follows:

1. Double-click on the multi-rest symbol.
The Split Multi-Rest dialog appears:

2. In the dialog, enter the bar number where you want the 
first split.

3. Click OK.
If you need more splits, double-click on any multi-rest symbol and pro-
ceed as above.

Multi-rest appearance
The Score Settings–Project page contains several sub-
pages, on which you can make settings for multi-rests:

• The subpage “Notation Style” contains the following 
settings concerning multi-rests:

• On the Spacings subpage of the dialog, you can adjust 
the height and width of multi-rest symbols.

• On the Text Settings subpage, you can select a font for 
the multi-rest numbers (select “Multi-Rests” in the “Font 
For” pop-up menu and make the desired settings).

Editing bar lines

Editing existing bar lines
For each bar line, you can choose whether you want a reg-
ular, single bar line, a double bar line, a repeat sign, etc.

1. Double-click on the bar line for which you want to edit 
the settings.
A dialog appears with a number of bar line types.

! The program automatically splits multi-rests at time 
signature changes, double bar lines, repeat signs 
and rehearsal marks.

Option Description

Multi-Rests – 
Church Style

When this is activated, multi-rests are shown in “church 
style” (vertical bars), rather than with the regular, horizon-
tal symbols.

Multi-Rests – 
Numbers above 
Symbol

When this is activated, the numbers are shown above the 
multi-rest symbol, instead of below it.

Multi-Rests – 
Snap Rests 
moved with the 
Layout tool

When this is activated, rests will automatically snap to 
“intelligent” positions in the score (i.e. positions used in 
regular notation) when moved with the layout tool. If this 
is deactivated, rests can be positioned freely.

Barnumbers – 
Show Range 
with Multi-Rests

When this is activated, and barnumbers are displayed, 
the bar numbers of a multi-rest will be shown as a range.



177

Designing your score: additional techniques

2. If you wish the bar line to be shown with “brackets”, 
activate the Brackets checkbox.
This is only relevant for repeat signs.

3. Click on the desired bar line type.
The dialog closes and the bar line type is changed.

4. If you do not want to display bar lines at the beginning 
of the parts, open the Score Settings–Project page, on 
the Notation Style subpage (Bar Lines category) and acti-
vate the option “Hide First Bar line in Parts”.

The bar line types are part of the Project layer – any 
changes you make will be reflected in all layouts.

Creating upbeats

By using the Pickup Bar feature
With this method, the upbeat actually contains exactly the 
number of beats displayed. That is, if you have an upbeat 
of one beat, your project starts with one bar in 1/4 time.

1. Change the time signature of the first bar to the length 
of the upbeat.

2. Insert a time signature of the correct kind (the time sig-
nature used throughout the project) in the second bar.
To insert a time signature, select it in the “Time Sign” section in the sym-
bol inspector and click in the Score with the Pencil tool.

3. Enter the notes in the upbeat into the first bar.

The first bar before any adjustments.

4. Double-click the time signature for the upbeat bar.
The Edit Time Signature dialog appears.

5. Activate the option “Pickup Bar” and click OK.

Now, the time signature of the first bar takes on the look of 
the second bar’s signature, while the time signature in the 
second bar is hidden:

6. If you use bar numbers, double-click on the first bar 
number and enter an offset of -1. 

7. Adjust the display of bar numbers and hide the “0” in 
the first measure.

By hiding rests
With this method, the first bar will actually have the same 
time signature as the following bars – it will only look like 
an upbeat bar:

1. Enter the notes in the upbeat into the first bar.

The first bar before any adjustments.

2. Hide the rests that precede the notes.

3. Drag the bar line between measure one and two to ad-
just the width of the bar.

After hiding the rest and dragging the bar line.

4. If you like, move the notes in the upbeat measure, us-
ing the Layout tool.
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5. If you use bar numbers, adjust them as described in 
the previous example.

The final upbeat.

Setting the number of bars across 
the page

Automatically
• When you open a new combination of tracks for editing, the 

number of bars across the page is determined by the setting 
“Default Number of Bars per Staff” in the Preferences dialog 
(Scores-Editing page).

• In the Auto Layout dialog (see “Auto Layout” on page 182), 
you can set the maximum number of bars across the staff.

Manually
In Page Mode you have full control of how many bars ap-
pear across the page, by using the Number of Bars dialog 
or the tools. 

If you want to use the “Max. number of Bars” option in 
the Auto Layout dialog (see “Auto Layout” on page 182), 
you should do this before you adjust the number of bars 
manually.

Using the Number of Bars dialog

1. Make a staff active in the system where you want to 
make changes.
This means that if everything looks fine until for example the fifth system, 
activate one of the staves in this system.

2. Pull down the Scores menu and select “Number Of 
Bars” from the Advanced Layout submenu.
The Number of Bars dialog is displayed.

3. Set the desired number of bars across the page.

• To change the number of bars for the active staff only, 
click “This Staff”.

• To change the number of bars for the active staff and all 
following staves, click “All Staves”.
In other words, to set all systems on all pages to the same number of 
bars, make the very first staff active and use the All Staves option.

Using the tools

• To make a bar “fall down” on a new staff, use the Split 
tool to click on its bar line.

Before and after moving the third bar one staff down.

• To bring the bar back up to the previous staff, use the 
Glue tool to click on the last bar line on the upper of the 
two staves.
This will in fact move all measures in the lower staff up to the upper.
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Moving bar lines
The following operations can be made using the regular 
Object Selection tool or the Layout tool, it doesn’t matter.

Moving a bar line
If you drag a bar line to the left or right, the surrounding 
bars are adjusted proportionally.

Moving bar lines on all staves
If you hold down [Alt]/[Option] when dragging a bar line, 
all bar lines below the one you drag will be moved accord-
ingly.

Moving a single bar line separately
If you hold down [Ctrl]/[Command] while dragging a bar 
line, the widths of the surrounding bars are not affected.

Making an indent on one line
• To create an indent, simply drag the first or last bar line 
on a staff.
The sizes of all measures are adjusted proportionally.

Before and after dragging the first bar line on the first staff.

Making indents on several lines
If you hold down [Alt]/[Option] and drag the first or last bar 
line in a system, all following systems will get the same in-
dent. If you want all lines on all pages to be indented in the 
same way, hold down [Alt]/[Option] and drag the appro-
priate bar line on the first system of the score.

The last bar line in the score
Nuendo attempts to move the last bar line and space the 
bars on the last line in a sensible way. But you can change 
this manually by dragging the last bar line, if you like. To 
change the type of the last bar line, double-click it and se-
lect the desired type.

Resetting bar spacing
To reset the bar spacing to standard values for several 
lines, proceed as follows:

1. Locate the first line for which you want to reset the bar 
spacing, and make one staff in that system active.

2. Select “Number of Bars” from the Advanced Layout 
submenu on the Scores menu.

3. Specify the number of bars that you already have on 
the line.

4. Click on “This Staff”.
Clicking “All Staves” will reset the lines of all staves in the score, see 
“Using the Number of Bars dialog” on page 178.

5. Close the dialog.
The bar spacing is reset for the currently selected staff and all following 
staves.
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Dragging staves
For the following operations, you can use the Object Se-
lection tool or the Layout tool.

Note that dragging staves can only be done in Page 
Mode.

Adding space between two grand staves
1. Locate the first staff in the lower of the two systems 
you wish to spread apart.

2. Click just to the left of the first bar line and keep the 
mouse button pressed. 
The entire staff is selected.

3. Drag downwards until you have reached the desired 
distance between the staves and release the mouse but-
ton.

Before…

…and after dragging the upper system.

Setting the same distance between all grand 
staves
1. Hold down [Alt]/[Option] and drag the first staff of the 
second system, until you have reached the desired dis-
tance between this and the first system.

2. Release the mouse button and the [Alt]/[Option] key.
The distances between all the systems will be adjusted accordingly.

Setting the distance between staves within a 
grand staff
1. Locate the lower staff in the grand staff you wish to 
spread apart.

2. Click just to the left of its first bar line and keep the 
mouse button pressed. 
The entire staff gets selected.

3. Drag downwards or upwards and release the mouse 
button.
The new distance is set for the two staves.

Setting the same distance between staves in 
several systems
1. Hold down [Alt]/[Option] and drag the desired staff as 
described above.

2. Release the mouse button and the [Alt]/[Option] key.
The corresponding staves in all following systems are moved accord-
ingly.

! This operation affects the system you drag and all 
following systems.

Dragging the staves in a piano system apart.
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Moving one staff only
You may wish to move one staff without affecting any 
other staff in any way:

1. Hold down [Ctrl]/[Command].

2. Drag any staff as described above.

Moving staves between pages
By using the “Move to Next/Previous Page” commands on 
the Staff context menu, you can quickly edit the page 
breaks:

Moving staves to the next page

1. Locate the staff you want to move to the top of the next 
page, and make it the active staff.
This can be any staff except the first staff on the page.

2. Right-click on the blue rectangle to the left of the staff, 
and select “Move to Next Page” from the Staff context 
menu.
The active staff (and any following staves on the page) are moved to the 
next page.

Moving staves to the previous page

1. Make the staff at the top of the page the active staff.
If any other staff is active, the option “Move to Previous Page” cannot be 
used. Also, the function will not work for the first staff on the first page.

2. Right-click on the blue rectangle to the left of the staff, 
and select “Move to Previous Page” from the Staff context 
menu.
The active staff, and as many of the following staves as there are room 
for, are moved to the previous page. If the previous page is “full” already, 
nothing will happen.

Adding brackets and braces
Brackets and braces (curly brackets) are added on the 
Score Settings–Layout page. The settings you make are 
specific for the current layout, i.e. you can have different 
brackets or braces set up for different track configurations.

1. On the Scores menu, select “Settings...” and in the di-
alog that appears, open the Layout page.
In the track list, you will find columns for braces ( { ) and brackets ( [ ).

2. Click in one of the columns and drag downwards in 
the list to encompass the desired staves.
The column indicates graphically which staves will be encompassed by 
the brace or bracket.

3. Close the dialog.
The score is displayed with brackets or braces according to the settings 
you made.

• You can edit brackets and braces in the dialog by drag-
ging the ends of the indicator in the list.

• To remove a bracket or brace, click on its indicator in 
the list.

You can automatically get broken bar lines based on 
the brackets you have added – see “Breaking bar lines” 
on page 184.

If the option “Show Braces in Edit Mode” is activated 
in the Preferences dialog (Scores-Editing page), brackets 
and braces are shown in Edit Mode as well.

Click at the first staff for which 
you want a bracket or brace…

…and drag downwards in the 
list to enclose the desired 
staves.
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Auto Layout
This item on the Scores menu brings up a dialog with sev-
eral options. Activating one of these makes the program 
“walk through” the score and make adjustments to mea-
sure widths, staff distances etc. automatically. Exactly 
which parts and properties of the score are affected de-
pends on which option you activate/deactivate.

You can also open the Auto Layout dialog by clicking 
the Auto Layout button on the extended toolbar.

Move bars
This option looks at the currently active grand staff, and 
attempts to adjust the measure widths, so that all notes 
and symbols get as much room as possible. The number 
of bars on the staff is not affected.

• You can perform this function for several staves in one 
go, by dragging a selection rectangle over their left edges, 
and then selecting Move Bars.

Move Staves
This changes the measure width (as with Move Bars) but 
also the vertical staff distance, of the active staff and all 
following staves.

Spread Page
This corrects the vertical layout of the staves on the cur-
rent page, so that they “fit onto the page”. In other words, 
this removes white space at the bottom of the page.

Hide Empty Staves
This hides all empty staves, from the active staff to the end 
of the score. Note that polyphonic/split staves are in this 
case treated as one entity, if the clef in the upper system 
differs from that in the lower system. That is, a piano staff 
is considered “empty” only if there are no notes on either 
staff.

• If you have activated the “Hidden” option on the Filter 
Bar, hidden staves are indicated by a marker with the text 
“Hide:Name” (where “Name” is the staff name).
To display hidden staves, delete their “Hide” markers.

• If you activate the option “Auto Layout: Don’t hide first 
staff” in the Preferences dialog (Scores-Editing page), 
staves in the very first grand staff will not be hidden, even 
if they are empty.
This is useful for example if you are creating an orchestra score, and want 
to show the complete “layout” of the orchestra on the first page of the 
score, without hiding anything.

All Pages
Activate this if you want to apply the options above to all 
pages. Please note that this setting will be applied to the 
active staff and onwards. If you want all pages in the score 
to be affected, you have to make the very first staff (the 
first staff on the first page) the active staff.

Move Bars and Staves
This is a combination of “Move Bars”, “Move Staves”, and 
“All Pages”, plus automatic calculation of the number of 
bars across the page – the function tries to optimize the 
number of bars across the page for each staff (with the 
maximum number of bars as set in the dialog).

! The automatic layout adjustments are done just as if 
you yourself had made them manually. This means 
that if there’s something you don’t like, you can al-
ways change it manually, as described above.
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Optimize All
All of the above in one fell swoop. This procedure might 
take some time but usually yields great results.

Other functions
In the lower part of the dialog, the following options are 
available:

The functions “Move Bars” and “Move All Bars” 
(“Move Bars” + “All Pages”) can also be accessed via the 
Staff context menu (opened by right-clicking on the blue 
rectangle to the left of the active staff).

Reset Layout
This function allows you to delete invisible layout elements, 
which in effect restores the score to default settings.

1. Select “Reset Layout…” from the Scores menu.
The Reset Layout dialog appears.

The following options are available:

2. Activate the items you want to delete or reset to stan-
dard settings.

3. Click on “This Staff” to clean up the active staff only, or 
on “All Staves” to clean up all staves in the score.

Setting Description

Auto Space/
Page Mode

The higher the value the more space is allowed for 
each element in the score (and thus, the fewer the 
bars across the page).

Minimum Distance 
between Staves

When you use an Auto Layout function that moves 
staves (changes the vertical staff distance), this set-
ting determines the minimum allowed distance be-
tween the staves.

Minimum Distance 
between Grand 
Staves

This sets the minimum allowed distance between 
Grand Staves in the same way.

Add to Auto Layout 
Distance

This number adds to the distance between staves that 
will be added when you use any of the Auto Layout 
functions. The higher the number, the larger the dis-
tance between staves.

‘Spread Page’ 
Bottom Distance

This adds to the white space that will appear on the 
bottom of a page when using the Spread Page func-
tions. 

Max. Number 
of Bars

This allows you to specify the maximum number of 
bars per staff when using the “Bars and Staves” or 
“Optimize All” functions.

Option Description

Hidden Notes Makes all hidden notes permanently visible again.

Hidden Makes all other hidden objects permanently visible again.

Quantize Deletes all display quantize elements.

Layout tool Resets all positions of notes, clefs, slurs and ties altered 
using the Layout tool.

Grouping Resets the grouping under beams to standard values.

Cutflag Deletes all cutflag events.

Stems/Beams Resets the length of all stems and reset the slant of 
beams that have been manually adjusted.

Coordinates Removes all manual spacing of note symbols and slurs.
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Breaking bar lines
Sometimes you may not want a bar line to stretch all the 
way across a grand staff. If this is the case, you have the 
possibility to “break it”.

Manually

Breaking bar lines in one grand staff

1. Select the Erase tool.

2. Click on a bar line connecting the two staves.
All bar lines between these two staves (except the first and last) are bro-
ken. To break the first or last bar line in a grand staff, you need to click di-
rectly on these.

Before and after splitting the bar lines between two staves.

Breaking bar lines in several grand staves

If you hold down [Alt]/[Option] and click on a bar line as 
described above, the corresponding bar lines are broken 
in all following grand staves.

Re-connecting broken bar lines 

If you have broken the bar lines, you can use the Glue tool 
to connect them again.

1. Select the Glue tool.

2. Click on one of the bar lines in the staff above the bro-
ken bar lines.
All bar lines between these staves in this grand staff are connected.

• To re-connect bar lines in several grand staves, hold 
down [Alt]/[Option] and click with the Glue tool.
The bar lines between the corresponding staves are connected in all fol-
lowing grand staves.

Automatically
If you have added brackets for some staves on the Score 
Settings–Layout page (see “Adding brackets and braces” 
on page 181), you can have bar lines broken between 
each bracketed “section”, giving a clearer indication of 
which staves belong together:

1. Open the Score Settings dialog from the Score menu 
and, on the Project page, select the “Notation Style” sub-
page.

2. In the Bar Lines section, locate and activate the option 
“Break Bar Lines with Brackets”.

• The option Break Last Brackets determines whether the 
breaking of bar lines should also apply to the bar line at 
the end of each row.
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About this chapter
In this chapter you will learn:

• How to set up the drum map.
• How to set up a staff for drum notes.
• How to enter and edit drum notes.
• How to use a single line drum staff.

Background: Drum maps in the 
Score Editor
When scoring for drums, you can assign a unique note 
head to each pitch. There is even the possibility to set up 
different note heads for different note values!

However, to be able to fully use this function, you need to 
understand a bit about drum maps, and the use of these in 
the Score Editor.

About drum maps
Nuendo handles drum editing by means of drum maps 
(see the chapter “Editing drums” on page 45). In the 
Score Editor, the drum map displays different note heads 
for different pitches.

You access the drum map by selecting “Drum Map Setup” 
from the MIDI menu.

The Drum Map Setup dialog.

Pitch vs. Display Note
In the Drum Map Setup dialog you will find a column Pitch 
and a column Display Note.

• The Pitch corresponds to the I-note for the drum sound and 
cannot be edited here.

• The Display Note value is used to set where the note should 
be displayed vertically. It can be thought of as a display trans-
pose setting that is unique for each note. This only affects how 
the note is displayed, not how it is recorded etc.

Use Score Drum Map on/off
For the drum map settings to be used in the score, you 
need to activate “Use Score Drum Map” in the Score Set-
tings–Staff page (Options tab).

Edit in Scores
This option is described in the section “Editing the drum 
map in the score” on page 187.

Setting up the drum map

Basic settings
1. Open the Score Editor for the drums track.
This should be a MIDI track to which you have assigned a drum map.

2. On the Score Settings–Staff page (Options tab), acti-
vate the option “Use Score Drum Map”.

3. On the MIDI menu, select “Drum Map Setup”.
The Drum Map Setup dialog appears.

4. Make settings for the sounds/MIDI notes you need.
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The dialog contains the following options:

Initializing the display pitches
If you select “Init. Disp. Notes” from the Functions pop-up 
menu in the dialog, all display pitch values are reset, so 
that actual pitch and display pitch is the same for each 
sound/note.

Using note head pairs
Not only can you have different drum sounds displayed 
with different note heads, you can also display different 
note heads for different note values:

1. Activate the “Use Head pairs” checkbox.
The “Head Symbol” column now shows two head symbols for each drum 
sound. 

All head symbols are arranged in pairs – by default an “empty” head and 
a “filled” head. Just as with regular notes, the “empty” note heads are 
used with half notes and larger note values, and the “filled” heads are 
used with quarter notes and smaller note values.

2. To select a head pair for a drum sound/note, click in 
the Head symbol column to open the pop-up menu and 
choose the new head pair.

Customizing note head pairs

If you don’t like the default pairs of note heads, you can 
edit these:

1. Select Edit Head pairs from the Functions pop-up 
menu.

2. To change a symbol in a pair, click on it and select a 
new symbol from the pop-up menu that appears.

3. When you’re done, click Exit to close the dialog.

Editing the drum map in the score
If you activate the checkbox “Edit in Scores” in the Drum 
Map Setup dialog, you can change the settings for the 
score drum map directly in the score:

• Transposing a note will change the display pitch of its 
drum sound – the actual note will not be transposed.

• Double-clicking a note allows you to make note head 
settings for that drum sound.

• Using the “Move to Voice” function will change the 
voice assignment of the drum sound.

This requires that you leave the Drum Map Setup dia-
log open – closing the dialog will automatically deactivate 
this option, allowing you to perform normal editing.

Option Description

Pitch This corresponds to the I-note of the sound in the drum 
map, and cannot be edited here.

Instrument The name of the drum sound in the map.

Display Note The display pitch, i.e. the pitch at which the note will be 
shown in the score. For example, you typically want all 
three hi-hat sounds to be shown on the same system line 
in the score (but with different symbols). Therefore, you 
set these to the same display pitch.

Head Symbol Clicking in this column opens a window in which you can 
select a note head symbol for the sound. If “Use Head 
Pairs” is activated in the dialog, you can select a note 
head pair instead.

Voice This allows you to make all notes with this pitch belong to 
a certain voice, so that they get e.g. a common rest han-
dling and stem direction.

! Please note that many different drum maps can be 
created for a project. Which one you get depends on 
which drum map is assigned to the edited track. 
These drum maps are totally independent of one an-
other, i.e. each pitch can have different settings in 
different drum maps.
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Setting up a staff for drum scoring
1. Open the Score Settings–Staff page and select the 
Options tab.

2. Make sure “Use Score Drum Map” is activated.

3. If you want a single line drum staff, activate the corre-
sponding option (see “Using “Single Line Drum Staff”” on 
page 188).

4. If you want flat beams, activate the corresponding op-
tion (see “Handling beaming” on page 116).

5. If you want all stems to end at the same position, acti-
vate Fixed Stems and set a length for up/down stems.

An example of drum staff settings.

• You may also want to use polyphonic voices to handle 
rest and stem separately. 
However, you can still activate the “Fixed Stems” option if you like. See 
the chapter “Polyphonic voicing” on page 95 for more information about 
polyphonic voices.

Entering and editing notes
This is like entering notes on a normal note system. How-
ever, please note:

• Notes are edited using their display pitch when the 
drum map is used. This means that when you move a note 
vertically, you move it to another display pitch. What actual 
pitch it gets depends on which pitch uses the display 
pitch you now “dropped it on”.

If the drum map contains two notes with the same 
pitch (for example Open and Closed HiHat), you can get 
the second note by holding [Ctrl]/[Command].

Using “Single Line Drum Staff”
When this option is activated on the Options tab on the 
Score Settings–Staff page, there is only one line in the 
system. Furthermore, notes can only appear below the 
line, on the line and above the line.

To decide which notes go where, proceed as follows:

1. Open the Score Settings–Staff page and select the 
Options tab.

2. Activate “Use Score Drum Map” and “Single Line 
Drum Staff”.

3. Set up the two pitch values to decide which pitches 
go on the line.
Notes below this range automatically wind up below the line and notes 
above wind up above the line.

! When you enter and edit the pitch of notes on a sin-
gle line drum staff, the best way is to drag the note 
up or down while watching the mouse position box 
on the toolbar.
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About this chapter
In this chapter you will learn:

• How to create tablature, automatically and manually.
• How to control the appearance of the tablature notes.
• How to edit tablature.

Nuendo is able to produce score in tablature format. This 
can be done automatically, by “converting” recorded MIDI 
information. You can also create a tablature staff from 
scratch and enter the notes “by hand”.

Creating tablature automatically
This assumes you have a regular score on screen already. 
We also suggest you perform basic editing like quantizing 
to make the score as legible as possible as regular notes 
before converting into tablature.

1. Make sure the notes in the score are inside the range 
of the instrument.
Notes with a pitch lower than the open tuning of the lowest string cannot 
be converted.

2. Open the Score Settings–Staff page and select the 
Tablature tab.

3. Select one of the predefined instruments from the 
pop-up menu.

4. Activate “Tablature Mode”.

5. If you are not using one of the predefined instruments, 
set the open tuning of each string using the value fields.
You can create tablature for up to 12 strings. To disable a string, set it to 
Off, the lowest value.

6. If you want to use a capodaster, e.g. on the forth fret, 
enter the corresponding value in the Capo field.
The tablature changes accordingly.

7. Make the desired settings for “No Stems/Rests” and 
“MIDI Channel 1–6”.
No Stems/Rests will give you a score where the notes have no stems 
and where all the rests are hidden. The “MIDI Channel 1–6” feature is 
described below.

8. Click Apply.
The tablature appears. You will get as many note lines as you have acti-
vated strings. All the notes will now have a fret number instead of their 
regular note heads. 

Before and after activating tablature mode.

9. Edit the score, if needed.
You can make display quantize settings, add symbols etc. as usual. How-
ever, editing the actual notes is a bit different from regular note editing. 
See below.

Using “MIDI Channel 1–6”
This feature will make notes automatically appear on the 
correct string according to their MIDI channel value.

Normally, the program automatically decides on which 
string to display a note, by looking at the pitch and then 
putting the note at the lowest possible string. You can 
then either manually move a note to the correct string, or 
use the “MIDI Channel 1–6” option to let the program 
move the notes automatically.

! Even though we use the term “converting” in this 
chapter, please note that tablature is a mode. You 
can switch between regular notation and tablature at 
any time.
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1. Many guitar synthesizers are able to transmit each string 
on a different MIDI channel. If you have such an instrument, 
set it up so that the high E string transmits on MIDI channel 
1, the B string transmits on MIDI channel 2 etc.
This feature can be used for MIDI string instruments with up to six strings.

2. Record the project. Quantize and edit it as desired.

3. Make sure the option “MIDI Channel 1–6” is activated 
and convert the notes into tablature, as described above.

4. The notes will automatically be placed on the right 
strings. 
For example if you played a “B” on the low E-string, it will appear as a “7” 
on that string, not as a “2” on the A-string.

Creating tablature manually
To set up an empty system for inputting tablature, proceed 
as follows:

1. Change the clef to the tablature symbol.

The tablature clef.

2. Open the Score Settings–Staff page and select the 
Options tab.

3. Set the “System Lines” to as many strings as the in-
strument you are scoring for has.

4. Raise the Add Space value to 1 or 2.
You will need a little extra space between note lines to make room for the 
numbered note heads.

Suggested system line settings for guitar tablature.

5. On the Tablature tab, activate “Tablature Mode”.

Tablature Mode activated.

6. Set up whatever other parameters you need in the 
dialog, and click Apply.

7. Select the Insert Note tool and move the pointer over 
the score.

8. Press the mouse button (without releasing it) and drag 
up and down until the note appears on the desired string 
with the correct fret number (you can also verify the actual 
pitch on the toolbar, as usual).
When you drag up and down, the program automatically selects the low-
est possible string. If you want a fret number higher than 4 on a guitar ta-
blature, for example, you have to use “Move To String”, see below.

Setting the correct pitch. Use the mouse position box on the toolbar as 
an additional guide.

9. Release the mouse button.
The note is displayed.

Tablature number appearance
On the Score Settings–Project page (Text Settings sub-
page), you will find text settings for the tablature numbers. 
Select “Tablature” in the “Font For” pop-up menu and se-
lect the desired font, size and style for the number note 
heads.
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Editing
Tablature can be edited like any other score. You can 
move notes, handle beaming, stem direction, etc.

Moving notes to another string
If you want for example a “C” to appear as a “8” on the low 
E-string rather than a “3” on the A-string on a guitar, pro-
ceed as follows:

1. Select one note or a number of notes that you want to 
move to a new string.

2. Right-click on one of the selected notes and, from the 
“Move to String” submenu, select the desired string.
The Fret number is automatically adjusted according to the tuning of the 
instrument (as set up on the Tablature tab on the Score Settings–Staff 
page).

Moving notes
Moving notes in pitch in a tablature score is working the 
same way as entering notes manually, see above.

Editing on the info line
Using the info line you can change the pitch of notes as 
usual. The string and fret number will be updated automat-
ically in the score.

Note head shape
If you only want to enter a fret number for your notes (Tab-
lature mode off), you can use the Set Note Info dialog on 
regular notes.

1. Double-click on the head of a note.
The Set Note Info dialog appears.

2. Activate the Tablature option and set a fret number in 
the value field to the right.

The tablature settings in the Set Note Info dialog.

3. Click Apply.
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About this chapter
In this chapter you will learn:

• How you can have the playback follow the structure of the 
score.

• How you can make the score affect how the MIDI notes play 
back.

• How to use the MIDI Meaning function.
• How to use crescendo/diminuendo symbols with integrated 

dynamics.

Scores and the Arranger mode
Repeats (bar lines) will appear in all layouts, as will Project 
symbols like Segnos, Codas, Da Capo, endings, etc. To 
have the playback in Nuendo follow these directions, pro-
ceed as follows:

1. Add the desired repeats and Project symbols to the 
score.

2. Right-click the toolbar in the Score editor and make 
sure “Arranger” is ticked.
This adds the Arranger buttons to the toolbar.

3. Click the “Activate Arranger Mode” button on the tool-
bar and start playback.
Playback will follow the repeats and Project symbols in the score – sec-
tions within repeat symbols will be repeated, the playback position will 
jump to the beginning when encountering a Da Capo symbol, and so on.

The MIDI Meaning function
The MIDI Meaning function interprets note symbols and 
dynamics, affecting the length and velocity of notes during 
playback. This means you can play back your score and 
hear all accents and dynamics you have added.

This is done in real time during playback – the actual 
notes are not affected!

Setting up
1. On the Score Settings–Project page, open the MIDI 
Meaning subpage.

As you can see, the dialog lists all note symbols and static 
dynamic symbols to the left. To the right are two columns, 
allowing you to specify in which way each symbol should 
affect the length and velocity of the notes as they are 
played back.

2. Set up the note symbols (at the top of the list) to your 
liking.
The Length and Velocity settings are expressed as percentages, with 
100% meaning no change from the actual note lengths and velocities on 
playback. For example, if you set up a short accent symbol (^) to mean 
Length=50%, Velocity=130%, notes with this accent would be played 
back with half their actual length and 1.3 times their actual velocity.

3. Set up the dynamic symbols (at the bottom of the list).
These can only affect note velocity. If you set the fortissimo symbol (ff) to 
mean Velocity=150% and insert a fortissimo symbol in the score, all 
notes will be played back with 1.5 their actual velocity, from that point in 
the score until the next dynamic symbol.

4. To activate MIDI Meaning, click the Active checkbox.

5. Click Apply and close the dialog.
Now, note symbols and dynamics will affect the notes on playback.

For dynamic changes to take effect, the MIDI sound 
source must respond to velocity.
Also, note that the maximum note velocity is always 127. If all notes were 
recorded or entered with maximum velocity, Velocity settings over 100 % 
will not have any effect.
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Dynamic crescendo symbols
In the Symbol inspector – Dynamics tab, you will find a 
special crescendo symbol:

This allows you to enter a crescendo or diminuendo in the 
score and have the note velocity adjusted accordingly dur-
ing playback. The same rules apply as for MIDI Meaning:

• The actual notes are not affected – the settings affect play-
back only.

• For the crescendo/diminuendo to be heard, the MIDI sound 
source must respond to velocity.

• The maximum note velocity is always 127. If the notes are re-
corded or entered with high velocity values, you may not hear 
any difference between e.g. forte and fortissimo.

Proceed as follows:

1. Select the dynamic crescendo symbol and make sure 
the Pencil tool is selected (see “Adding symbols to the 
score” on page 132).

2. Click where you want the crescendo or diminuendo to 
start, drag to its end position and release the mouse button.
By default this inserts a crescendo from piano (p) to forte (f).

3. To adjust the dynamics at either end of the crescendo, 
right-click to bring up a palette from which to select the 
desired dynamic symbol.
If you select a dynamic symbol at the start that is “louder” than the one at 
the end, the crescendo symbol is automatically changed to a diminuendo 
symbol.

• In the palette for the start symbol you will find three ad-
ditional options: “cresc”, “dim” and “None” (no symbol is 
shown).
If any of these is selected, the crescendo or diminuendo will start from 
the “current dynamic”, i.e. with the level according to the previous dy-
namics symbol in the staff.

4. On the Score Settings–Project page, select the MIDI 
Meaning subpage and make sure the Active checkbox is 
ticked.
The dynamic crescendo/diminuendo makes use of the MIDI Meaning 
function and uses the velocity scaling you have set up for the dynamics 
symbols in this dialog.

5. Start playback.
You should now hear the crescendo or diminuendo affect the note veloc-
ities.
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Printing and exporting pages

Printing

Printing from the Score Editor
1. On the Scores menu, activate “Page Mode”.
Printing is only possible from within Page Mode.

2. Select Page Setup from the File menu and make sure 
all your printer settings are correct. Close the dialog.

3. Select Print from the File menu.

4. The standard Print dialog appears. Fill out the options 
as desired.

5. Click Print.

Exporting pages as image files
You can export a section of a page or a complete page in 
various file formats. This allows you to import your scores 
into desktop publishing and drawing applications.

Selecting a section of a page for exporting
If you only want to export a part of a certain page, proceed 
as follows:

1. Make sure you are in Page Mode.

2. Select the Export tool (“Select Export Range”).
The pointer turns into a crosshair.

3. Drag over the section of the score you want to include.
The area is indicated by a black rectangle.

• You can adjust the size of the rectangle by clicking and drag-
ging its handles with the Object Selection tool.

• You can move the rectangle to another position in the score 
by clicking and dragging.

To export the selected range, you have two possibilities:

• Double-click inside the rectangle while it is selected.
This opens the Export Scores dialog, where you can make settings for 
the file to be created (see below).

• Use the Export Scores function, see below.

Exporting
To export the score, proceed as follows:

1. Make sure you are in Page Mode.

2. If your score contains several pages, select the de-
sired page.

3. Pull down the File menu and on the Export submenu, 
select “Export Scores…”.
The Export Scores dialog appears.

4. Select a picture format.

5. Specify a resolution for the file.
This determines the accuracy with which the image will be created. 
300dpi, for example, is the resolution many laser printers use for printing. 
If the image file will only be displayed on screen in other programs, select 
72 or 96 (depending on screen resolution) and it will have the same size 
as it had in Nuendo.

6. Specify a name and a location for the file and click 
“Save”.
The page of the score is exported and saved as a file. It can now be im-
ported into any program supporting the selected file format.

! If you change your setting for paper size, scale and 
margins now, the score may change its look. 
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How to use this chapter
This chapter answers to a number of questions that might 
arise when you use the Score Editor. For more information 
about the functions referred to below, please check the 
previous chapters. If you don’t know where to look, use 
the index.

Adding and editing notes
I enter a note with one value and it is shown as a note 
with another value.

Change the Rests display quantize to a smaller note value. 
Try deactivating Auto Quantize, especially if you don’t 
have any triplets or triplets only.

Notes are not displayed at the correct positions.

Try changing the Notes display quantize value.

There are a number of short rests after my notes.

Your Rests display quantize value might be set to too 
small a note value. Raise it. Also check the “Clean 
Lengths” setting.

When I change the length of a note, nothing happens.

This is because the display quantize value puts a restric-
tion on what note values can be displayed. Check that dis-
play quantize is set to the smallest note value you have in 
your project.

I have adjusted display quantize and the other staff 
settings best I can. The notes are still shown with the 
wrong values.

You might need to use one of these three features: insert-
ing display quantize events, using polyphonic voicing, or 
applying “Scores Notes To MIDI”.

I change the display quantize settings on the Score 
Settings–Staff page (Main subpage) and nothing 
happens.

Did you remember to click Apply? Maybe you have already 
inserted display quantize events in the score? These over-
ride the staff settings.

Suddenly many display quantize events appear in the 
score.

This is not a malfunction. If you had Auto Quantize on and 
start inserting display quantize events, the auto quantizing 
is automatically transformed into display quantize events.

One long note is shown as many tied notes.

Do other notes occur at the same positions but with differ-
ent lengths? Then you need to use polyphonic voicing. 
Are the note(s) syncopated? Then you should try the syn-
copation feature.

Even though I’ve tried the above, notes are not tied as I 
want them.

The way notes are tied in Nuendo follows basic notation 
rules. You may need to make exceptions to these rules, by 
using the Cut Notes tool.

I have an unnecessarily large amount of rests.

Especially with polyphonic voicing, superfluous rests may 
be created. Try deactivating rests for one or more voices. 
You might also leave the rests activated on the Score Set-
tings–Staff page (Polyphonic tab) and then hide the rests 
you don’t need, one by one.

When using polyphonic voices, a number of rests are 
drawn on top of each other.

As above, you should try hiding rests on the Score Set-
tings–Staff page (Polyphonic tab), center rests and possi-
bly manually moving or hiding rests.

In polyphonic voices, notes that are on the same musical 
position are not displayed exactly vertically above each 
other.

This is not a malfunction. Nuendo has built-in automatic al-
gorithms for making the score as legible as possible. Some-
times this will include adjustments of the “graphic” position 
of notes, especially with small intervals like seconds. You 
can always move the notes using the Layout tool.

When using polyphonic voices, notes with small intervals 
“collide”.

As described above, Nuendo tries to avoid this, but only 
for voices 1 and 2 in the upper staff and voices 5 and 6 in 
the lower. For other voices, please use the Layout tool to 
manually move the notes.
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When I select a note, nothing is shown on the info line.

The note is probably tied to another note. This means that 
the second note doesn’t really exist, it is just a graphic in-
dication that the main note is long. Try selecting the main 
note instead.

Symbols and layout
Symbols from the Layout Symbols tab are sometimes 
invisible when I open the score.

This is not a malfunction. Those symbols are part of a lay-
out. If you open the score with another layout, for example 
because you open another combination of tracks, you will 
see another layout which might not contain any Symbols at 
all. See the chapter “Working with layouts” on page 164.

I can’t select an object on the screen, or I can’t select an 
object without selecting another object.

Use the selection rectangle to drag up (or down) and 
around the objects. Then hold down [Shift] and deselect 
all the objects you don’t want included, by clicking on 
them. You should also check out the lock layer function.

Symbols have disappeared.

Are they layout symbols? Then maybe they belong to an-
other layout than the one you are editing now.

If that is not the reason, maybe you have inserted the sym-
bol into the wrong staff, see “Important! – Symbols, staves 
and voices” on page 132.

A symbol doesn’t move with its staff. Auto Layout 
produces far too wide spacing.

Maybe you have inserted the symbol into the wrong staff. 
Please observe the warning in the section “Important! – 
Symbols, staves and voices” on page 132.

A note symbol appears too far from the note I wanted it 
inserted on.

Do you have activated the correct voice? Note symbols 
are inserted into voices, just like notes.
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Useful editing techniques

Moving a note without transposing it
If you hold down [Ctrl]/[Command] while moving a note 
(or a number of notes) sideways, moving is restricted to 
horizontally only, i.e. you don’t have to worry about the 
notes being transposed. You can also set up a key com-
mand for this. This is done in the Key Commands dialog 
(Nudge category).

Moving and spacing several staves
If you have a number of staves that you want displayed 
with an equal distance (for example, all strings of a grand 
staff in a full orchestra score), this can be done using the 
Position Info window: 

1. Open the Preferences–Scores dialog and deactivate 
the option “Global staff Spacing with [Alt Gr]/[Option]-
[Command]”.

2. In the score, select the staves you want to set to an 
equal distance.

3. Open the Position Info window by clicking on the ruler.

4. Use the To Previous Staff or To Next Staff settings to 
specify the desired distance between the staves.
All selected staves are spaced according to your settings.

• If you do this with the “Global staff Spacing with [Alt 
Gr]/[Option]-[Command]” option activated, all staves in 
the score are affected.

Polyphonic voicing
If you are working on a full score with more than one in-
strument in one staff (2 flutes, 2 trumpets etc.), you should 
use polyphonic voices. And even if both instruments play 
the same notes, you should insert notes for both instru-
ments (you can mute the notes of the second voice, if 
playback is an issue). If you do this, it will be much easier 
to extract single parts later by using the “Extract Voices” 
command.

Using the bar handles
Double-clicking a bar handle opens the Bar Copy dialog. 
This function is great for copying accents, but you can 
also use it for copying drum phrases, etc. For more infor-
mation, see “Moving and duplicating with the bar handles” 
on page 141.

• If you hold down [Shift] and double-click on a bar han-
dle, this and the next bar are selected. 
This is handy when copying phrases of two or more bars in one go.

Copying a section with “invisibles”
If you want to copy and paste a section which contains 
hidden elements, adjusted beams and stems etc., there 
are two ways to proceed:

• Use the filter bar to make indicators appear in the score. 
Then select these indicators together with the notes be-
fore you copy.
This ensures the notes are copied with their formatting etc.

• Double-click the bar handle of one of the bars, and 
make sure all relevant event types are activated in the dia-
log. Then select the bars you want to copy by clicking their 
bar handles, and copy them by [Alt]/[Option]-dragging the 
bar handles.
For more information, see “Moving and duplicating with the bar handles” 
on page 141.

Using “Scores Notes To MIDI”
This function converts the score data, as displayed, into 
MIDI data. Let’s say for example that you have set up the 
score so that it is displayed to 99% the way you want it to 
be. Yet, that last 1% forces you to deactivate some of the 
Staff Settings (like Clean Lengths, No Overlap or Auto 
Quantize), which makes other parts of the score illegible. 
In this case, try using the function “Scores Notes To 
MIDI”. Note that you should work on a copy of the track! 
For more information, see “Using “Scores Notes To MIDI”” 
on page 80.

Optimizing rests
If you have a number of consecutive empty bars, you can 
replace them with one multiple rest. See “Multiple rests” 
on page 176.
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Tips and Tricks

Zero system lines
Having no system lines at all might seem like a stupid idea 
to start with. But this option allows you to create chord 
sheets really quickly, see “Using Make Chord Symbol” on 
page 152.

A lead sheet created by specifying “0” system lines.

Examples and scales
If you are creating scale examples and similar, you can use 
the Real Book option and manually hide all symbols at the 
beginning of the first staff to make the score appear like 
separate unconnected “lines”.

Remember you can also hide the bar lines.

An example scale without bar lines.

Controlling the order and appearance of grace 
notes
Normally, grace notes are beamed. Their order under the 
beam is controlled by their order in the track. It is enough 
to put a grace note one tick before the next grace note to 
make them appear in the desired order under the beam.

Initially the grace notes are put in with a 32nd note beam. 
By double-clicking the note and changing the “flag” type 
in the Set Note Info dialog, you can change this.

Complex grace notes.

Speeding up inserting key changes
If you have a grand staff with many instruments, inserting 
key changes one by one can take an awful lot of time.

In this case, activate “Key changes for the entire Project” 
on the Key context menu or on the Score Settings–
Project page (Notation Style subpage, Keys category). 
This way, all changes made to the key will always affect 
the entire project.

Speeding up inserting staccato and accents
Symbols linked to notes can also be put in for a number of 
notes at the same time, even on different staves. See 
“Adding a symbol to several notes using the Pencil tool” 
on page 133.

Setting the distance between staves in a piano 
score
Drag the first bass staff on the first page. This will copy the 
spacing to all staves. Please note that this can only be 
done in Page Mode.

If you wish you had a faster computer
Here are some tips for those who find some operations 
slower than they would like:

• Work on a smaller section of the score at a time. Break the 
project up into parts and work on those parts individually until 
the final layout stage.

• Switch on multi-rests as late as possible.
• When working in Edit Mode, set Default Bars Across The 

Staff to a small value, for example 2.
• In Edit Mode, resize the window so that only one grand staff at 

a time is visible.
• Consider upgrading your computer hardware.
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D
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Default Edit Action 46
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Delete

MIDI drum notes 49
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Dialogs 65
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Affecting MIDI playback 195
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Keeping Horizontal 145

Disable Display transpose 70
Display Arrow after Inserting

Symbol 132
Display filter bar 63, 64
Display Length 91, 114
Display Markers 167
Display Quantize

About 56
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Inserting changes 78
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Setting 74
Tool 58, 78
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Display Transpose 69, 76
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Creating and editing notes 48
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Drum maps
About 50
Making settings 50
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Drum Notes

About 186
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E
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Manual 113
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Files 197
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Find and Replace 161
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Force Update 70

G
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Grace Notes
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Settings 124
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All Pages 182
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Drum Editor 47
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Editing 93
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Layout

Export 166
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Layout Settings
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Page
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